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1 Background

ITAM

The Integrated Training Area Management (ITAM) Program is the Army’s formal strategy focusing on sustained use of training and testing lands.  ATTACC is part of the ITAM Program, under proponency responsibility of the Office of the Deputy Chief of Staff for 

ATTACC

ATTACC is the standard ITAM methodology for estimating training land carrying capacity by relating training load, land condition, and land maintenance practices.  Various decision support tools have been developed to simplify and automate the ATTACC methodology.  These decision support tools include the Workplan Analysis Module (WAM), ATTACC Integration Module (AIM), ATTACC functions of the Range Facility Management Support System (RFMSS). and Land Condition Module (LCM). 

The ATTACC method consists of three main components: training load characterization, environmental characterization, and cost analysis.  Training load is characterized in terms of Maneuver Impact Miles (MIMs), which are based on vehicle mileage projections. Each vehicle in each training event has a different impact on the land.  To account for these differences, all training events are normalized to a standard unit in a standard event (M1A2 in an armor battalion in a field training exercise). Training impact factors represent the difference in impact between vehicles and events as compared to the standard. The cost component of ATTACC characterizes land maintenance and repair practices in terms of type of practice, costs, area affected, and effectiveness. The environmental component of ATTACC currently characterizes land condition in terms of erosion status.  Erosion status is the ratio of predicted soil loss to tolerable soil loss rates.  

ATTACC LCM

The Land Condition Module (LCM) is an ArcView
 geographical information system (GIS)-based software application that estimates changes in land condition associated with mission activity.  LCM automates the ATTACC Methodology for generating land condition curves.  Land Condition Trend Analysis (LCTA)/GIS coordinators use the LCM.  LCM uses installation natural resources GIS data layers to generate land condition curves, which are an important input to AIM.  The POC for the LCM is Mr. George Teachman, U.S. Army Environmental Center (USAEC), ATTN:  SFIM-AEC-EQN, 5179 Hoadley Rd, Aberdeen Proving Ground, MD  21010-5401; 410-436-1593.

ATTACC LCM Version 2.00 uses a number of basic input map layers that are derived from LCTA, ITAM GIS, and related installation data. The number of input map layers required depends on the measures of land condition selected.  Erosion is currently estimated using a modification of the Revised Universal Soil Loss Equation (RUSLE), a modification of the Wind Erosion Equation (WEQ), and a modification of a vehicle dust emission model. Currently the user may select any combination of water, wind, and/or vehicular dust erosion. Basic input layers required for any analysis include Distribution, Restricted Areas, Boundary, and Training Area maps. Input layers required for the Revised Universal Soil Loss Equation include climatic, erodibility, topography, vegetative cover, impact, and recovery factors. Input layers required for the Wind Erosion Equation include vegetative cover, vegetation structure and composition, impact, recovery, climatic, and soil erodibility factors. Input layers required for the vehicular dust equation include vegetative cover, impact factor, recovery factor, climatic factor, and soil erodibility factor.  Some data layers are used by multiple erosion equations.

2 Introduction

This document contains the standard operating procedures (SOP) necessary for the development of Land Condition Module (LCM) input grids required for ATTACC LCM curve implementation.  For implementation to be successful, as well as time efficient, all parties involved should follow the procedures outlined in this document.  This document is intended to be used in conjunction with the Army Training and Testing Area Carrying Capacity (ATTACC )Land Condition Module (LCM) Version 2.00, Data Dictionary (DD).  The data dictionary defines the data required to implement the ATTACC LCM while the standard operating procedures define the data operations required to develop ATTACC LCM input files. 

This document is a living document and is updated as the ATTACC LCM is updated.  The document will also be updated by users of the document as they feel a need to document data and methods in more detail to support of the objectives of the ITAM program.  At this time, not all sections have been completely documented.  Data development options that are infrequently used have not been fully documented.  Additional standard operating procedures may be required if the data used in these options become more readily available.  An example of this is the incorporation of remote sensing imagery in conjunction with spatial interpolation and regression analysis.  To define the procedures completely, more input is required from CERL and others involved in ATTACC model development.      

3 Data Acquisition, Assessment and Transfer Procedures

Data inconsistencies and difficulties with transfer of data to the RSC can be problematic.  Guidelines were developed for obtaining and transferring data to the RSC’s from installations or second parties for LCM input grid processing.  The information provided below was written specifically for the current WRSC contract but directly applies to the Eastern Regional Support Center (ERSC) or any other entity involved with the acquisition, assessment and transfer of spatial data from installations to the RSC’s.

Data Acquisition Requirements

All data required for LCM input grid generation should be outlined in a document and sent to the installation with a brief description of the LCM project background (See Appendix E).  The document should also define the installation GIS POCs role in data transfer.  It is important to emphasize the importance of the installation POC to include data layers required for the development of LCM input grids as outlined in the Data Requirements Tree document (See Appendix C).  This will minimize the transfer of extraneous data and ensure that the LCM data requirements are met.  In addition, metadata and any additional documentation required for data processing should be included in the transaction by the installation POC.  If metadata is not available for a data set, the installation POC should include the following documentation as a minimum requirement:

1. Data layer name and description 

2. Projection information

3. Any additional information (i.e. currentness, alterations in table values, applicability to LCM if the data set is not a standard required LCM data layer, etc.)

4. Processed LCM input grid description (if applicable)

If completed, LCM input grids are supplied by the installation, brief descriptions should be provided as to the year developed, the input data used during creation and basic processing procedures.   This information will provide documentation regarding the input grid development procedures if modifications or improvements need to be performed.  

Data Assessment / Quality Assurance – Quality Control

Once the data is transferred to the RSC or other acting entity, all files should be reviewed in a GIS software package.  Once the data layer is opened, zoom into the data, check for any inconsistencies and begin recording assessment information.  The following is a list of assessment information required for each data layer that will be recorded in a tabular format:

1. Layer name.

2. Layer description.

3. Feature type (point, line, polygon, raster, image, etc).

4. File type (shapefile, coverage, grid, image, etc).

5. Projection information.

6. Attributes ( Check to see if the attributes required for LCM input grid development are complete.  See “ATTACC LCM Data Dictionary” document for required data layer attributes.  If required attributes are not complete, contact the installation and acquire necessary information.)

7.  Metadata / documentation (make sure metadata has information, not just empty .xml file).

8. Layer inconsistencies (does layer align with installation boundary, are sliver polygons present, node errors, etc).  If any of these exist, please note for WRSC editing purposes.

9. Any data layers not received from the installation, but required by the LCM must be noted.   Refer to the Data Requirement Tree (Appendix C) for required data layers.  If required data is not found in the transfer, contact the installation and check availability.

10. If data layer is a completed LCM input grid developed by the installation or contract entity, provide date, developer and additional processing documentation if available.

11. Installation POC information

 Data Transfer Requirements

Once data has been assessed, transfer all data and documentation to the WRSC.  The following list outlines the LCM data transfer requirements:

1. Send all ArcInfo coverages in EXPORT (.e00) format only.

2. Include .prj files for all shapefiles and coverages.  For ArcInfo coverages use “projectdefine” if the projection is not defined.  For shapefiles, use ArcCatalog or the ArcView Projection Utility.  Do not reproject any files from the installations original projection.

3. Include data assessment/QAQC document developed by reviewing entity.

4. Include all metadata and or documentation provided by the installation.

5. Group data into distinct file type directories (i.e. shapes, export, image, grid, table, other).

6. Zip all directories from Step 5 into one file.

7. Post zip file on CEMML ftp site (ftp.cemml.colostate.edu). 

8. Send email to Todd Kennaway WRSC (tkennaway@cemml.colostate.edu) notifying that FTP transaction is complete.

Data Acquired Directly from Installation

In some cases, data required for the LCM is sent directly from the installation to the WRSC.  In this situation, data transfer requirements are slightly different.  A narrative was developed (Appendix E) to request data directly from an installation POC. The narrative can be used by the ERSC or any other entity when contacting installations to acquire data for assessment and transfer.

4 LCM Input Grid Development Procedures

Data preparation procedures such as converting between data formats, defining projection files, spatial arc editing, and topology management are all performed in ArcInfo.  Refer to the WRSC Data Development Standard Operating Procedures document and Appendix B of this document for additional information.  The procedures outlined below can be performed in either ArcInfo or ArcView using Spatial Analyst.   All commonly used ArcView procedures are indicated in bold, italicized and quoted text (e.g. “Join”).  These commonly used procedures are described in Chapter 5 of this document.

This section is ordered in the same manner as the ATTACC LCM Data Tree (Appendix C) and the ATTACC LCM v2.0 Users Manual.  Data for each class of data (Basic, Water, Wind, Dust) are described together.  

Many ATTACC LCM data input layers have several data development options.  Data development options are listed from easiest (first) to most complex (last).  Generally the easiest methods use data that is available from most installations and utilize less complex data processing techniques, although this may not be adequate for characterizing all installations.   

Basic Input Layers

Boundary

A boundary map is a map delineating the land areas considered part of the installation. This data layer is required when estimating land condition for the installation as a whole.  Installation lands can be any lands that are used by the installation for training and may include leased and withdrawn lands.  The boundary map should include all lands that are applicable to the ITAM program.

1. Acquire installation boundary layer in ArcInfo or ArcView format.

2. If necessary, convert data into ArcInfo format.

3. Convert coverage to grid format.

4. Verify that the boundary has a cell value of “1” and the area surrounding the boundary has a cell value of “no data”.  “Reclassify” the values if necessary.

5. Verify with installation personnel that the boundary map represents the lands that the ITAM program is responsible for managing.  This may include owned lands, leased lands, BLM lands, USFS lands, etc.

Training Areas

A training area map is a map delineating land units used for scheduling and conducting military training.  The ATTACC LCM will generate a land condition curve for each training area identified in the training areas map. To generate a land condition curve for all training areas at an installation for use with the RFMSS system, provide a training area map that is consistent with the training area map used for scheduling training in the RFMSS program.  

1. Acquire training area boundary layer in ArcInfo or ArcView format.

2. If necessary, convert data into ArcInfo format.

3. Convert coverage to grid format.

4. Verify that the training area names in the GIS map are the same as those used in RFMSS.  Get list of RFMSS training area names by contacting scheduling office (through ITAM POC) to have them print out a list.  Pay close attention to spelling and shortened names.  This is only required when creating local land condition curves.  HQ land condition curves only needs the boundary map.

Restricted Areas 

The restricted areas map is a map delineating all areas available for training and those areas that are restricted to training activity.  Available training lands include lands available for training, under installation control, and that are the responsibility of the installation to maintain as part of the ITAM Program.  Typically, there are also lands within an installation that are restricted to training.  These lands not available for training are identified through discussions with the installation range control office.  A restricted areas map has “1” values for lands that are available for training and “0” or “no data” values for land not available for training.

Option 1

Use Option 1 when there is no information on what lands are available for training.  This should not occur often.

1. Save boundary grid as a restricted area grid.  Verify that lands available for training have grid values classified as “1” and lands not available for training are classified as “0” or “no data”. 

Option 2

Before collecting the individual data layers to create a restricted areas layer, ask the installation if they already have a layer created.  In some cases, installations have already created a layer depicting restricted areas.  If they have a restricted areas layer, verify that lands available for training have grid values classified as “1” and lands not available for training are classified as “0” or “no data”.  If not, “Reclassify” the grid values accordingly.

1. Collect spatial data layers for appropriate restricted areas.  These layers include, but are not limited to: secure/classified/off-limits sites, lakes/ponds, endangered species sites, archaeological/cultural sites, cemeteries, recreation areas, airfields/assault strips, impact areas dudded with buffer zones, impact areas non-dudded with buffer zones, cantonment areas/camps, and special interest natural/recreation areas.

2. “Merge” all layers into one restricted file. Edit the attribute table by dropping all items except Area and Perimeter, adding an item in attribute table named “restrict”, and coding all records to “Y”. 

3. Perform a “Union” between the restricted layer and installation boundary layer.

4. “Convert” the map layer resulting from the above “Union” to grid format.

5. “Reclassify” resulting grid switching “no data” and “1” values using the following steps.  If using ArcView with Spatial Analyst, perform the following:

a. Activate the categorical grid theme to “Reclassify”.

b. From the Analysis menu, choose “Reclassify”.

c. Choose the “restrict” field in the grid theme to classify in the Classification Field dropdown list.

d. For all no data values (in Old Values column), type 1 in the New Value column.  For all 1 values (in the Old Value column), type no data in the New Value column 

6. The result should be the Restricted Areas grid representing “no data” areas.  This map layer acts as a mask delineating all areas that will not be included in the grid analysis.

7. Clip Restricted Areas grid to installation boundary if necessary.  See “Applying a Mask for Analysis” section in Chapter 5 for additional information on clipping grids.

Distribution

An important aspect to adequately modeling the impacts of training and testing activities is the spatial distribution of land use activities.  Land use activities  are not distributed uniformly across the installation.  The training distribution map reflects the effects of topography, vegetation, and other environmental influences on the distribution of land uses such as training and testing.  It should also reflect the doctrinal requirements of training and historic land use patterns.  The methodology to create this data layer is flexible but the land use patterns estimated should reflect actual land use. 

Option 1 

This option assumes an even training and testing distribution where all areas have an equal opportunity to receive training impacts during an LCM analysis.  Use this option when no distribution data exists.

1. Save the boundary grid layer as a distribution grid layer.  Leave the values of “1” for where training can occur (all across installation) and “0” or “no data” for areas where no training occurs. 

Option 2 

This option is the Subject Matter Expert (SME) option. It is used where the installation has a generalized map or spatial data layer of high, medium and low military use areas.  This information is often the result of an installation reallocating LCTA plots. 

1. If possible, acquire the spatial data layer that delineates level of use areas.  Some installations have produced maps of high and low use areas.  Some installations have maps of general management areas (these are usually groups of training areas that are commonly used together).  Some installations have delineated historically disturbed areas based on LRAM types of surveys.  Other applicable spatial data layers may include training areas, vegetation, and land use delineations.

2. If only a hard copy map exists, digitize the data into a spatial layer.

3. If the installation does not have LCTA data, ask a subject matter expert (SME) for an idea of relative level of use for the areas (number of use days, number of person days, or just a relative guess of one area getting X% more use than another area).

4. Save data layer from steps 1 or 2 as a grid file.  “Reclassify” the levels of use values from high, medium, low use codes into the SME values provided (ie High-> 50, Medium->35, and Low->10).

Option 3 

Use this option if the installation has LCTA data.
1. If installation has LCTA data, extract DMCE, DMCN, Plotid, %disturbance from plotmast, plotsurv, pcsdplotsum tables contained within the LCTA MS Access database. (Can use most recent year or average of all years data.  Average is usually best. Most recent year is easiest.)  Commonly used MSAccess SQL Query Statements are provided in Appendix G. 

2. Create a point spatial file from data contained in LCTA MS Access database. If using ArcView with Spatial Analyst, perform the following steps:

a. “Create a new dbaseIV table” with DMCE, DMCN, Plotid, %disturbance from database.

b. Use the “Add an XY event theme” method to create a spatial points layer from coordinate information contained in the dbaseIV table. 

c. “Convert to grid theme” using %disturbance as the attribute to classify. Add a theme to the view that best represents the features of the landscape that correlate best to training use (i.e. landcover, soils) and make the layer active.  Select summarize zones (off of the Analysis menu).  This will generate a table with the average %disturbance values assigned to each category of the extrapolation map.

d. Open the table for the layer used for extrapolation (i.e., landcover, soil).  “Join” the two tables so that the extrapolation layer includes fields for mean %disturbance.  

e. Get the average disturbance for all points in each map category (high, med., low)

f. “Reclassify” the map values (high, med, low) with the average disturbance values for each category (ie 50, 44, 12).

Option 4 

Use when you only have LCTA data.  Not a good method to use unless the installation has many LCTA plots that are well distributed.  Most installation LCTA programs do not meet this requirement.  

1. If installation has LCTA data, extract DMCE, DMCN, Plotid, %disturbance from plotmast, plotsurv, pcsdplotsum tables contained in the MS Access database. Can use most recent year or average of all years data.  Average is usually best. Most recent year is easiest. 

2. “Create a spatial point layer” from coordinate information contained database.  

3. Use spatial statistics to spatially interpolate values to all grid cells. 

Option 5

For use when an installation has LCTA and remotely sensed data.  Works best in grassland areas.  Areas heavily forested or deserts with too little vegetation often do not work well.  At this time, methodology has not been fully documented.

1. Query LCTA data from database; extract DMCE, DMCN, Plotid, %disturbance from plotmast, plotsurv, pcsdplotsum tables. Can use most recent year or average of all years data.  Average is usually best. Most recent year is easiest.

2. “Create a spatial point layer” from coordinate information contained in the database.

3. Open remotely sensed (RS) data in a GIS software package. 

4. “Merge” points data with RS data. 

5. “Export to dbaseIV format” the merged table.

6. Import DBaseIV file into stats package or excel.  

7. Use stats functions to define relationship between dependent variable (disturbance) and independent variables (RS layer values, could be one or more). Stats package will identify the best equation that fits data.  Look at R2 values to see how good data fits (do not expect values to be too large.  They can vary from 0.2 to 0.9). 

8. Use “Map calculator” to use an equation that will calculate distribution map.  

9. Usual remotely sensed data that is available is TM and SPOT.  For best results, attempt to acquire imagery from the same years as the LCTA data.

Options 5 and 6 are more complex and require additional processing time.  Create one of the other options first (1 through 4), then attempt options 5 and 6 once other input grids are completed and additional time is available.

Option 6

For use when installations have LCTA, remotely sensed data, and GIS data.  Works best in grassland areas.  Areas heavily forested or deserts with too little vegetation do not work well.

1. Same methods as Option 4 above except you can use other GIS data layers.  Data often used is distance from roads, slope, and vegetation type.  

Options 5 and 6 are more complex and require additional processing time.  Create one of the other options first (1 through 4), then attempt options 5 and 6 once other input grids are completed and additional time is available.

Option 7 

Distributions maps can be derived from vehicle tracking data.  Do not use this option until more comprehensive vehicle tracking data becomes available. Very few installations have the necessary data and it is very time consuming.  

Water Erosion Input Layers

K Factor 

The K factor indicates the susceptibility of a soil to sheet and rill erosion by water.   K factor is one of six factors used in USLE/RUSLE to estimate average annual soil loss.  Estimates of K factor are based on the percentage of silt, sand, and organic matter.  K factor values also depend on soil structure and permeability.  K factor values range from 0.05 to 0.69.  The higher the K value, the more susceptible the soil is to soil loss by sheet and rill erosion.

Option 1 

Option 1 uses the installations digitized soil survey map.

1. Obtain the soils coverage for the installation.  Use NRCS SSURGO soils coverage and NASIS database if available. Information in NASIS is basically the same information that can be obtained from a typical NRCS soil survey report.  The figure below shows an example NRCS soil survey manual physical and chemical properties table that contains K factor values by soil type.  For information regarding NRCS/NASIS data and availability, contact George Teachman at: George.Teachman@daapgea050.apgea.army.mil.  

a.  If necessary, convert NASIS database from Access 2000 to alternate Access software version if required for Access software/database compatibility.   On 2000 platform conversion is accomplished by:

i. Open database.  

ii. Choose tools 

iii. database utilities

iv. convert database.
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Example NRCS soil survey manual of physical and chemical properties table that contains K factor values by soil type.
12. Query NASIS database for K factor (Note that this database also contains T factor values, see section below on T factor map layer development.  For more efficient use of the NASIS data, the user may opt to extract T factor data at the same time K factor data) based on the soils data used for analysis.  If NASIS data is not available, the National Map Unit Interpretation Records (MUIR) database can be used.  For information on MUIR database, see appendix F.

a. Open query in design view.

b. Add “mapunit”, “component”, and “chorizon” tables.

c. Add the following fields: (1) mapunit_symbol (mapunit table); (2) mapunit_name (mapunit table); (3) soil_eordibility_factor_whole (chorizon table); (4) component_name (component table); (5) component_percent_r (component table); (6) horizon_depth_to_top (chorizon table).

d. Show all fields.

e. Sort by “mapunit_symbol”.
f. Enter the value of  “0” for the field criteria “horizon_depth_to_top”. 

g. Run the query that will result in a new table.  

h. View table.  

i. Save table and query.

j. The resulting table from step 3 provides K factor values for all soils type and component series at a soil depth of 0 (the soil surface).  At this time several K factor values may exist for duplicate soil symbols.  This occurs due to multiple soils component types for a single soil symbol.  It may be necessary to manually edit the table to delete multiple K factor values. The criteria for table edits can be based on the “percent_component” field that provides the representative percent of the soil component.  Choose the larger mapunit_symbol soils component percent for a representative K factor value.  In the case where the “percent_component” values are the same use the limiting K factor values that represent the most erosivity (i.e. the higher the K factor value, the greater the erosivity).  Alternatively, an average value can be used for duplicative K values for multiple soils component types.  It is necessary to manually edit each duplicate mapunit_symbol value based on these criteria.  The table editing process should only take a few minutes, due to the relatively small number of duplicate mapunit_symbol values.  

k. Once the table has been edited, save the table and close.  At this time the user can create a new Make Table query based on the previous table.  This will remove any extraneous data fields and allow the user to rename fields if necessary.  Export as dbfIV file for table joins to SSURGO coverage. 
13. “Join” the results of the previous query (query.dbf) to the soils coverage based on common item name.  For example SSURGO data utilizes the item muid for join relationships. 

a. If using ArcView with Spatial Analyst, do the following:

i. Open the query.dbf and the soils tables to join.

ii. Make the source table active (soils).

iii. Click the name of the common item for the “Join”.
iv. Make the destination table (query.dbf) active.

v. Click the name of the common item for the “Join”.
vi. From the Table menu choose “Join”, or click the “Join” button.

vii. “Convert to grid theme” based on K factor items in soils table join.

b. If using ArcView with Spatial Analyst, do the following:

i. Click on the theme (soils with query.dbf) to “Convert to grid theme” theme.

ii. From the Theme menu, choose “Convert to grid theme”.
iii. In the Conversion Field dialog, choose an item in the feature theme that will be used to give values to the cells in the output grid theme.

Option 2 

This option uses field data to estimate K factor values.  This method should not be used unless published values from a soil survey are not available. 

1. Use the Access LCTA User Interface Version 1.0.4 software and installation MS Access LCTA database to create an erosion summary.  Refer to the document entitled Access LCTA - A Microsoft Access Land Condition Trend Analysis User Interface Users Guide for additional information.  Get the most recent years data and save to a DBbaseIV file with plotid, dmce, dmcn, calcKfactor.

2. Acquire a generalized soil type layer created from more detailed soils layer.  Generally there is not enough field data to estimate K factor values for each soil series, so you need to aggregate soil series into similar soil groupings.

3. “Create a point layer” depicting LCTA plot locations from coordinate information contained in the database.

4. “Merge” the LCTA layer with the soil layer.  If using ArcView with Spatial Analyst, “Join” attributes tables based on the “Shape” item. 

5. Save the edited table to a new file.  If using ArcView with Spatial Analyst, use the following steps:

a. Make the K factor table active by selecting it.  

b. From ArcView main menu, select File>Export.

c. In the Export dialog box, select “dbase” as the format.

6. Calculate average K values for each soil type.

a. Open dbase file from step 5 in MS Excel.  

b. From the Excel main menu, select Data>Pivot table.  In the first dialog box select “excel list” and “pivot table”. In second dialog box provide a range of data by highlighting the data.  In the third dialog box, check new spreadsheet and press “layout” button.  In the layout dialog box, drag the box for vegetation classifications into left side of table and the box for K factor values into center of table.  Double click on the K factor box in the center of table and change to average. Select the “ok” button, then the “finish” button.  This will create a table of average K factor values for each vegetation type.  Exact steps will vary with version of Excel.  Other software tools can be used to get the average values.

7. Perform a “Convert to grid theme” on the soil layer.

8. “Reclassify” the soil grid using calculated average K factor values.  If using ArcView with Spatial Analyst, do the following:

a. Make the new grid active.

b. From ArcView main menu, select Analysis>”Map calculator”.

c. Enter an equation like ((([soil]) = 1) * 0.17) + ((( [soil]) = 2) * 0.22)  where “soil” is the name of the soil grid, “1” and “2” are the identifiers for each soil class, and “0.17” and “0.22” are the average K factor values for each  soil class calculated above.
C Factor

The C Factor map is the current USLE C factor. The C factor is the product of two subfactors C1 and C2.  Subfactors use estimates of percent ground cover, percent aerial cover, and average minimum drip height.  C factor values range from 0 (complete cover) to greater than 0.45 (no cover).

Option 1 

Option 1 uses default published C factor values for general vegetation types (see figure below for table from USLE Users manual). This option is used when no field data exists, except for a generalized vegetation layer.

1. Acquire the generalized vegetation layer.

2. “Edit the attribute table” by adding a new item to the attribute table and populate with generalized vegetation classifications.  For example, group all pre-existing vegetation categories into forest, shrub and grasslands.

3. Acquire default C factor values for forest, shrub and grassland areas in the USLE user’s manual. Values for vegetation types can be obtained from tables 10-12 of Predicting Rainfall Erosion Losses: A Guide to Conservation Planning. USDA Agriculture Handbook Number 537, December 1978, US Government Printing Office. Copies of these tables are provided in the following figures.

4. “Edit the attribute table” by adding a new numeric item to the attribute table and populate with the applicable C factor value for each vegetation type (forest, shrubs, grasslands).

5. “Convert the grid theme” using the C factor value as the classifier.
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USLE User’s manual table showing C factor values 

for permanent pasture, range and idle land.
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USLE User’s manual yable showing C factor values 

for undisturbed forest lands.
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meadow, the selected seedbed soil loss ratio is
multiplied by a factor from table 5-D. If mulch
is applied, a subfactor read from the upper curve

' Porcentage of surface covered by residue in contact with the
soil.

* Excollont soil condition—Highly stable soil aggregates in fop-
soil with fine tree roofs and litter mixed in.

Good—Moderately stable soil aggregates in topsoil or highly
stable aggregates in subsoil (topsoil removed during raking), only
traces of litter mixed in.

Fair—Highly unstable soil aggregates in topsoil or moderately
stable aggregates in subsoil, no litter mixed in.

Poor—No topsail, highly erodible soil aggregates in subsoil, no
litter mixed in.

? NC—No live vegetation.

WC—75 percent cover of grass and weeds having an average
drop fall height of 20 in. For intermediate percent-
ages of cover, interpolate between columns.

* Modify the listed C values as follows to account for effects of

surface roughness and aging:

First year affer treatment: multiply listed C values by 0.40 for
rough surface (depressions >6 in); by 0.65 for moderately
rough; and by 0.90 for smooth (depressions <2 in).

For 1 fo 4 years after freatment: multiply listed factors by 0.7.

For 4+ to 8 years: use table 6.

More than 8 years: use table 7.

“For first 3 years: use C values as listed.

For 3+ 1o 8 years affer treatment: use table 6.

More than 8 years after treatment: use table 7.

of figure 6 is multiplied by the residual subfactor
to obtain C. When canopy develops, a canopy sub-
factor from figure 5 is also included.




USLE User’s manual table showing C factor values for woodland sites.

Option 2 

Option 2 is for when an installation only has LCTA data and the MSAccess LCTA database program . Use when installation has standardized LCTA data and vegetation layer.

1. Use the Access LCTA User Interface Version 1.0.4 software and installation MS Access LCTA database to create an erosion summary.  Refer to the document entitled Access LCTA - A Microsoft Access Land Condition Trend Analysis User Interface Users Guide for additional information.  Get the most recent years data and save to a DBbaseIV file with plotid, dmce, dmcn, cfactor.  Use the SQL queries in Appendix G to calculate C factor values from the LCTA database.

2. Acquire a generalized vegetation type layer (grass, shrub, forest) or create from more detailed vegetation layer.  

3. “Create a point layer” depicting LCTA plot locations from coordinate information contained in the database.

4. “Merge” the LCTA layer with the vegetation layer.  If using ArcView with Spatial Analyst, “Join” attributes tables based on the “Shape” item. 

5. Save the edited table to a new file.  If using ArcView with Spatial Analyst, use the following steps:

a. Make the C factor table active by selecting it.  

b. From ArcView main menu, select File>Export.

c. In the Export dialog box, select “dbase” as the format.

6. Calculate average C values for each vegetation type.

a. Open dbase file from step 5 in MS Excel.  

b. From the Excel main menu, select Data>Pivot table.  In the first dialog box select “excel list” and “pivot table”. In second dialog box provide a range of data by highlighting the data.  In the third dialog box, check new spreadsheet and press “layout” button.  In the layout dialog box, drag the box for vegetation classifications into left side of table and the box for C factor values into center of table.  Double click on the C factor box in the center of table and change to average. Select the “ok” button, then the “finish” button.  This will create a table of average C factor values for each vegetation type.  Exact steps will vary with version of Excel.  Other software tools can be used to get the average values.
7. Perform a “Convert to grid theme” on the vegetation layer.

8. “Reclassify” the vegetation grid using calculated average C factor values.  If using ArcView with Spatial Analyst, do the following:

a. Make the new grid active.

b. From ArcView main menu, select Analysis>”Map calculator”.

c. Enter an equation like ((([veg]) = 1) * 13) + ((( [veg]) = 2) * 22)  where “veg” is the name of the vegetation grid, “1” and “2” are the identifiers for each vegetation class, and “13” and “22” are the average c factor values for each  vegetation class calculated above.

Option 3 

Use when an installation only has LCTA and no general GIS data layers.  Not likely to use this option since almost all installations with LCTA data have some GIS used for plot allocation. 

1. Use the Access LCTA User Interface Version 1.0.4 software and installation MS Access LCTA database to create an erosion summary.  Refer to the document entitled Access LCTA - A Microsoft Access Land Condition Trend Analysis User Interface Users Guide for additional information.  Get the most recent years data and save to a DBbaseIV file with plotid, dmce, dmcn, cfactor.  Note: LCTA point distributions may not be acceptable for adequate interpolation results.  Use the SQL queries in Appendix G to calculate C factor values from the LCTA database.

2. “Create a point layer” from LCTA coordinate data.

3. Interpolate C factor values between plot locations.  If using ArcView with Spatial Analyst, do the following:

a. Make points file the active map in the view.

b. From ArcView main menu, select Surface>Interpolate grid.  In the first interpolation dialog box set extent equal to the boundary map and cell size to a reasonable number based on input data.  In second interpolation dialog box set z value to the c factor values.  Try different interpolation options to produce a map that is most reasonable. 

c. Save data to file.  From ArcView main menu, select File>Export.  In Export dialog box select DBase format.

4. “Convert layer (from step 3) to a grid theme”.

Option 4 

Option 4 uses LCTA and remotely sensed data. Use when LCTA and remote sensing data is available. Guidance on processing options is beyond the scope of this document.  If this option is required, examples of data processing can be found in Senseman, G.M., S.A. Tweddale, A.B. Anderson, and C.F. Bagley. 1996. Correlation of Land Condition Trend Analysis (LCTA) Rangeland Cover Measures to Satellite-Imagery-Derived Vegetation Indicies. USACERL Technical Report 97/07, October 1996. 28pp.  

Option 5 

Option 5 can be used by those who do not have LCTA or the LCTA MSAccess database program.  Since the C factor is calculated by using a combination of vegetation measures, it can be hand-calculated for use in LCM.  The C factor is the product of two subfactors C1 and C2 (C1 * C2).  Subfactor C1 requires estimates of percent ground cover, percent aerial cover, and average minimum drip height.  Subfactor C2 uses only the estimate of percent ground cover.  The first figure below graphically shows subfactor C1 calculation assuming 25% ground cover, 60% percent aerial cover, and average minimum drip height of 2.0.  A C1 factor value of 0.78 is obtained by using a ground cover of 25% (on the X axis of the left most graph in the first figure) and going straight up until you hit the 60% canopy cover line (y axis on left-most graph in first figure).  Go straight across to the right most-graph (in the first figure) and stop at the minimum drip height line for 2.0.  Read straight down on the X-axis for a value of 0.78 for C1.  To calculate C2 use the graph in the second figure below.  Take your ground cover estimate (25%) on the Y-axis and read straight across to the curve.  Then read straight down on the X-axis to get a C2 factor value of 0.21.  The C factor value is 0.78 * 0.21 = 0.164 (or C1 *C2 = C).
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Graphical calculation of C factor subfactor (C1).
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Graphical calculation of C factor subfactor (C2).

LS Factor
The LS factor LCM data layer is the slope length and steepness factor for military training and testing lands.  The LS factor in the Revised Universal Soil Loss Equation (RUSLE) represents the erodability of slope length and steepness relative to a standard unit plot that has a length of 72.6 ft and a steepness of 9%, where all other conditions are similar.  LS values are not absolute values but are referenced to a value of 1.0 at a 72.6 ft slope length and 9% steepness.  Values generally range form 0 to 150.

Option 1 

Option one uses representative slope and slope lengths from the NASIS database.  This data is not available from older NRCS databases like MUIR.  This method is applicable when other sources of slope and slope length are not available or of poor quality.

1. “Reclassify” the digital soil survey map using representative slope values. Representative slope values must be obtained from the state NRCS office.  If representative slope values are not available, use midpoint slope values.  Slope ranges can be found in the soil series name and/or description.  A midpoint can be calculated from this range.  Slope values can be found in the attributes associated with each soil type in the map.   Obtain the soils coverage for the installation.  Use NRCS SSURGO soils coverage and NASIS database if available. Information in NASIS is basically the same information that can be obtained from a typical NRCS soil survey report.  For information regarding NRCS/NASIS data and availability, contact George Teachman at: George.Teachman@daapgea050.apgea.army.mil.  

a. Convert NASIS database from Access 2000 to alternate Access software version if required for Access software/database compatibility.   On 2000 platform conversion is accomplished by:

i. Open database.  

ii. Choose tools 

iii. database utilities

iv. convert database.

2. Complete this step if using NASIS data.  Query NASIS database for slope information (Note for more efficient use of the NASIS data, the user may opt to extract slope data at the same time as K factor and other soil data is acquired).  If NASIS data is not available skip to step 3.

a. Open query in design view.

b. Add “mapunit”, “component”, and “chorizon” tables.

c. Add the following fields: (1) mapunit_symbol (mapunit); (2) mapunit_name (mapunit); (3) slope_length_usle (component); (4) slope_gradient (component)  (5) componenet_name (componenet); (6) componenet_percent_r (componenet); (7) horizon_depth_to_top (chorizon).

d. Show all fields.

e. Sort by “mapunit_symbol”.

f. Enter the value of  “0” for the field criteria “horizon_depth_to_top”. 

g. Run the query that will result in a new table.  

h. View table.  

i. Save table and query.

j. The resulting table is slope data for all soil types and component series.  It may be necessary to manually edit the table to delete multiple slope values. The criteria for table edits can be based on the “percent_component” field that provides the representative percent of the soil component.  Choose the larger mapunit_symbol soils component percent for a representative slope value.  You will also need to calculate the midpoint for each soil type. 

k. Once the table has been edited, save the table and close.  At this time the user can create a new Make Table query based on the previous table.  This will remove any extraneous data fields and allow the user to rename fields if necessary.  Export as dbfIV file for table joins to SSURGO coverage. 

14. Complete this step if using Non-SSURGO data with MUIR database. If using NASIS data, skip this step.

a. Tables used for query include: (1) mapunit; (2) component and (3) chorizon

b. The table items “mapunit_symbol” or “Mapunit name” may be used for “Join” relationships in ArcView

c. Construct query using tables to include the following items; (1) muid, (2) mapunit_symbol; (3) mapunit_name; and (4) slope.  

d. Edit table to calculate midpoint slope value.

15. “Join” query.dbf to soils coverage based on common item name.  For example SSURGO data utilizes the item muid for join relationships. Non-SSURGO data may use mapunit_sysmbol or Mapunit_name.  

a. If using ArcView with Spatial Analyst, do the following:

i. Open the query.dbf and the soils tables to join.

ii. Make the source table active (soils).

iii. Click the name of the common item for the “Join”.
iv. Make the destination table (query.dbf) active.

v. Click the name of the common item for the “Join”.
vi. From the Table menu choose “Join”, or click the “Join” button.

vii. “Convert to grid theme” based on slope values in soils table join.

b. If using ArcView with Spatial Analyst, do the following:

i. Click on the theme (soils with query.dbf) to “Convert to grid theme” theme.

ii. From the Theme menu, choose “Convert to grid theme”.
iii. In the Conversion Field dialog, choose an item in the feature theme that will be used to give values to the cells in the output grid theme.

16. Use “Map Calculator” to calculate the LS factor map using the following equation.  Change the slopelength to correct value (in feet).  You will have to assume an average slope length.  Final LS factor map will be called “[Map Calculation 1]”. Be careful entering this equation in the map calculator since the map calculator is very sensitive to equation syntax.

(((([Slope] / 180.AsGrid * 3.1414.AsGrid) < 5.14)  *  (10.8.AsGrid  *  ([Slope] / 180.AsGrid * 3.1414.AsGrid).Sin + 0.03.AsGrid)) + ((([Slope] / 180.AsGrid * 3.1414.AsGrid)   >=  5.14)  *  (16.8.AsGrid * ([Slope] / 180.AsGrid * 3.1414.AsGrid).Sin - 0.50.AsGrid)))  * ((SlopeLength/72.6).AsGrid).Pow(((((([Slope of Map calculation 1] / 180.AsGrid * 3.1414.AsGrid).Sin/0.0896.AsGrid)/(3.AsGrid*(([Slope] / 180.AsGrid * 3.1414.AsGrid).Sin).Pow( 0.8 ) + 0.56.AsGrid)))/(1.AsGrid+(((([Slope] / 180.AsGrid * 3.1414.AsGrid).Sin/0.0896.AsGrid)/(3.AsGrid*(([Slope] / 180.AsGrid * 3.1414.AsGrid).Sin).Pow( 0.8 ) + 0.56.AsGrid))))))

Option 2 

This option uses LCTA or similar field data to estimate LS factor values.  This method should generally not be used unless quality DEM or published values from a soil survey are not available. 

1. Use the Access LCTA User Interface Version 1.0.4 software and installation MS Access LCTA database to create an erosion summary.  Refer to the document entitled Access LCTA - A Microsoft Access Land Condition Trend Analysis User Interface Users Guide for additional information.  Get the most recent years data and save to a DBbaseIV file with plotid, dmce, dmcn, LS (use mean value if several values are offered per plot).  Use the queries in Appendix G to calculate LS factors from the LCTA database.

2. Acquire a generalized soil type layer created from more detailed soils layer or use the plot allocation map used when LCTA plots were allocated (has 8 to 16 strata each associated with 1 or more LCTA plots).  Generally there is not enough field data to estimate LS factor values for each soil series so you may need to aggregate soil series into similar soil groupings is using soils to extrapolate calculated LS values.

3. “Create a point layer” depicting LCTA plot locations from coordinate information contained in the database.

4. “Merge” the LCTA layer with the soil layer.  If using ArcView with Spatial Analyst, “Join” attributes tables based on the “Shape” item. 

5. Save the edited table to a new file.  If using ArcView with Spatial Analyst, use the following steps:

a. Make the LS factor table active by selecting it.  

b. From ArcView main menu, select File>Export.

c. In the Export dialog box, select “dbase” as the format.

6. Calculate average LS values for each soil type.

a. Open dbase file from step 5 in MS Excel.  

b. From the Excel main menu, select Data>Pivot table.  In the first dialog box select “excel list” and “pivot table”. In second dialog box provide a range of data by highlighting the data.  In the third dialog box, check new spreadsheet and press “layout” button.  In the layout dialog box, drag the box for vegetation classifications into left side of table and the box for LS factor values into center of table.  Double click on the LS factor box in the center of table and change to average. Select the “ok” button, then the “finish” button.  This will create a table of average LS factor values for each vegetation type.  Exact steps will vary with version of Excel.  Other software tools can be used to get the average values.

7. Perform a “Convert to grid theme” on the soil layer (or plot allocation layer).

8. “Reclassify” the (or plot allocation layer) grid using calculated average LS factor values.  If using ArcView with Spatial Analyst, do the following:

a. Make the new grid active.

b. From ArcView main menu, select Analysis>”Map calculator”. Enter an equation like ((([soil]) = 1) * 0.17) + ((( [soil]) = 2) * 0.22)  where “soil” is the name of the soil grid, “1” and “2” are the identifiers for each soil class, and “0.17” and “0.22” are the average LS factor values for each  soil class calculated above.

Option 3 

Option 3 uses an installation Digital Elevation Model (DEM), LCTA data and ArcView Spatial Analyst or other GIS grid software. Using preferred GIS grid software, calculate LS values for each cell in the DEM using average slope length from LCTA data and RUSLE LS factor equations.

1. Acquire DEM data for installation

2. Convert DEM heights (Z axis) to same units as horizontal (x and y axes).  If using ArcView with Spatial Analyst, do the following:

a. Make the new grid active.

b. From ArcView main menu, select Analysis>”Map calculator”.

c. Enter the following equation: “[DEM] * 0.3048” where [DEM] is the DEM data and 0.3048 is the conversion factor for feet to meters.  Enter an equation like “[DEM] * 1” where [DEM] is the DEM data and 1 is the conversion factor for meters to meters.

d. The result will be a file named “[Map calculation 1]”.

3. Estimate slope using “Derive Slope” command in ArcView and the [Map calculation 1] map derived from the original DEM.  The result will be a file named “[Slope of Map Calculation 1]”.

4. Query LCTA database (see Appendix G) for “slopelength” item for each LCTA plot.  Average “slopelength” data in MS Excel software.

5. Finally, use “Map Calculator” to calculate the LS factor map using the following equation.  Change the slopelength to correct value (in feet).  An average slope length from LCTA data or other source must be used.  Final LS factor map will be called “[Slope of Map Calculation 2]”. Be careful entering this equation in the map calculator since the map calculator is very sensitive to equation syntax.

 (((([Slope of Map calculation 1] / 180.AsGrid * 3.1414.AsGrid) < 5.14)  *  (10.8.AsGrid  *  ([Slope of Map calculation 1] / 180.AsGrid * 3.1414.AsGrid).Sin + 0.03.AsGrid)) + ((([Slope of Map calculation 1] / 180.AsGrid * 3.1414.AsGrid)   >=  5.14)  *  (16.8.AsGrid * ([Slope of Map calculation 1] / 180.AsGrid * 3.1414.AsGrid).Sin - 0.50.AsGrid)))  * ((slopelength/72.6).AsGrid).Pow(((((([Slope of Map calculation 1] / 180.AsGrid * 3.1414.AsGrid).Sin/0.0896.AsGrid)/(3.AsGrid*(([Slope of Map calculation 1] / 180.AsGrid * 3.1414.AsGrid).Sin).Pow( 0.8 ) + 0.56.AsGrid)))/(1.AsGrid+(((([Slope of Map calculation 1] / 180.AsGrid * 3.1414.AsGrid).Sin/0.0896.AsGrid)/(3.AsGrid*(([Slope of Map calculation 1] / 180.AsGrid * 3.1414.AsGrid).Sin).Pow( 0.8 ) + 0.56.AsGrid))))))

5. If you have a map of slope lengths, you can use the equation in step 4 above and substitute the slope length grid in for the single slope length value.

Option 4 

Option 4 uses a DEM and the ATTACC ArcView extension “ATTACC LS Factor Calculator.”  Use the LS Factor calculator software to calculate LS values for each cell in DEM.  The LS Factor calculator requires one input DEM and several data field values for analysis and output results.  The calculator input dialog will save input values between analysis sessions for future input revisions.  The following are helpful guidelines when using the calculator.  See ATTACC LS Factor Calculator Users Manual for further information.

1. The “Select Elevation Units” input field should represent the Z units of the input elevation map or DEM

2. The “Analysis Resolution” input field specifies the analysis resolution for all calculations and should be set to the resolution appropriate for the input elevation map or DEM.

3. Name the output LS Factor grid in the “Output Map Layers” input field and select the “Use Current Working Directory” box to save the output LS Factor grid to the current directory.

4. To save to an alternate output directory, unselect the “Use Current Working Directory” box and enter a new output directory path.

5. Review output LS Factor grid.

T Factor

T factor is an estimate of the maximum average annual rate of erosion by wind or water that a soil can sustain without loss of productivity.  T factor is one of six factors used in USLE/RUSLE to estimate average annual soil loss.  T factor is in Tons/acre/yr.  Estimates of T factor are based on soil properties including soil depth.  T factor values range from 1 to 5.  The higher the T value, the less susceptible the soil is to soil loss.

Option 1 

Option 1 uses the installations digitized soil survey map.

1. Obtain the soils coverage for the installation.  Use NRCS SSURGO soils coverage and NASIS database if available. Information in NASIS is basically the same information that can be obtained from a typical NRCS soil survey report.  The figure below shows an example NRCS soil survey manual physical and chemical properties table that contains T factor values by soil type.  For information regarding NRCS/NASIS data and availability, contact George Teachman at: George.Teachman@daapgea050.apgea.army.mil.  

a. If necessary, Convert NASIS database from Access 2000 to alternate Access software version if required for Access software/database compatibility.   On 2000 platform conversion is accomplished by:

i. Open database.  

ii. Choose tools 

iii. database utilities

iv. convert database.
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Example NRCS soil survey manual of physical and chemical properties table that contains T factor values by soil type.
2. Complete this step if using NASIS data.  Query NASIS database for T factor (Note that this database also contains K factor values, see section above on K factor map layer development.  For more efficient use of the NASIS data, the user may opt to extract T factor data at the same time K factor data) based on the soils data used for analysis.  If NASIS data is not available skip to step 3.

a. Open query in design view.

b. Add “mapunit”, “component”, and “chorizon” tables.

c. Add the following fields: (1) mapunit_symbol (mapunit); (2) mapunit_name (mapunit); (3) t_factor (component); (4) component_name (component); (5) component_percent_r (component); (6) horizon_depth_to_top (chorizon).

d. Show all fields.”

e. Enter the value of  “0” for the field criteria “horizon_depth_to_top”. 

f. Run the query that will result in a new table.  

g. View table.  

h. Save table and query.

i. The resulting table from step 3 provides T factor values for all soils type and component series at a soil depth of 0 (the soil surface).  At this time several T factor values may exist for duplicate soil symbols.  This occurs due to multiple soils component types for a single soil symbol.  It may be necessary to manually edit the table to delete multiple T factor values. The criteria for table edits can be based on the “percent_component” field which provides the representative percent of the soil component.  Choose the larger mapunit_symbol soils component percent for a representative T factor value.  In the case where the “percent_component” values are the same use the limiting T factor values that represent the most erosivity (i.e. the higher the T factor value, the greater the erosivity).  Alternatively, an average value can be used for duplicative T values for multiple soils component types.  It is necessary to manually edit each duplicate mapunit_symbol value based on this criteria.  The table editing process should only take a few minutes, due to the relatively small number of duplicate mapunit_symbol values.  

j. Once the table has been edited, save the table and close.  At this time the user can create a new Make Table query based on the previous table.  This will remove any extraneous data fields and allow the user to rename fields if necessary.  Export as dbfIV file for table joins to SSURGO coverage.
3. Complete this step if using Non-SSURGO data with MUIR database. If using NASIS data, skip this step.

a. Tables used for query include: (1) mapunit; (2) component and (3) t_factor (component).

b. The table items “mapunit_symbol” or “Mapunit name” may be used for “Join” relationships in ArcView

c. Construct query using tables to include the following items; (1) muid, (2) mapunit_symbol; (3) mapunit_name; and (4) t_factor.

4. “Join” query.dbf to soils coverage based on common item name.  For example SSURGO data utilizes the item muid for join relationships. Non-SSURGO data may use mapunit_sysmbol or Mapunit_name.  

a. If using ArcView with Spatial Analyst, do the following:

i. Open the query.dbf and the soils tables to join.

ii. Make the source table active (soils).

iii. Click the name of the common item for the “Join”.
iv. Make the destination table (query.dbf) active.

v. Click the name of the common item for the “Join”.
vi. From the Table menu choose “Join”, or click the “Join” button.

vii. “Convert to grid theme” based on T factor items in soils table join.

b. If using ArcView with Spatial Analyst, do the following:

i. Click on the theme (soils with query.dbf) to “Convert to grid theme” theme.

ii. From the Theme menu, choose “Convert to grid theme”.
iii. In the Conversion Field dialog, choose an item in the feature theme that will be used to give values to the cells in the output grid theme.

R Factor

Rainfall and runoff (R) factor values quantify the erosivity of the climate in an area.  R factor values are frequently provided as published isoerodent maps from a variety of sources (Renard et al 1997).  Isoerodent maps are essentially contour maps of R factor values.

Option 1 

Option 1 uses isoerodent maps produced by the USDA.

1. Acquire installation boundary layer in ArcInfo or ArcView format.

2. If necessary, convert shapefile data to ArcInfo format.

3. Consult NRCS Isoerodent map for applicable R Value (see figure below).  Usually use on value per installation.  Isoerodient maps can be digitized if there is detailed information for your installation (generally not detailed enough).
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Example NRCS isoerodent map of R factor values.
4. “Edit the layer’s attribute table” and add an “Rvalue” item.

5. Populate all polygon feature records to the determined R Value in Step 2.

6. “Convert to grid theme”.

Option 2 

Option 2 uses the “City” database provided with RUSLE software.  Use this option if you do not have the isoerodent maps but have the RUSLE software.

1. Acquire installation boundary layer in ArcInfo or ArcView format.

2. If necessary, convert shapefile data to ArcInfo format.

3. Run RUSLE software and extract the applicable R Value.  See RUSLE users manual for more detailed information on using RUSLE software.

7. “Edit the layer’s attribute table” and add an “Rvalue” item.

4. Populate all polygon feature records to the determined R Value in Step 2.

5. “Convert to grid theme”.

Option 3 

Option 3 uses the installations local NRCS office to get an R factor value.  Use this option if you do not have the isoerodent maps.  Local NRCS offices often use slightly different R values than the isoerodent maps provided based on local knowledge of climatic conditions.  Phone numbers for an installations local or state NRCS office can be obtained from any NRCS state office.

1. Acquire installation boundary layer in ArcInfo or ArcView format.

2. If necessary, convert shapefile data to ArcInfo format.

3. Contact local NRCS office and request applicable R Value.  

4. “Edit the layer’s attribute table” and add an “Rvalue” item.

5. Populate all polygon feature records to the determined R Value in Step 2.

6. “Convert to grid theme”.

Option 4 

R values can be determined from installation weather station data.  Do not use this method unless as a last resort.  Data acquisition, clean up, and quality control can be very time consuming.  Data quality issues can dramatically affect R factor value estimates.  For details on estimating R factor values from weather station data, see the RUSLE Guide.

Impact Factor

The impact factor is the change in the C factor data that results from a single pass of a vehicle.  Impact factor is in the same units as the C factor.  The impact factor is often referred to as the deltaC factor.

Option 1 

Option 1 uses subject matter experts (SME) to estimate the impact factor.

1. Ask installation expert (LCTA, LRAM or other personnel) to use personal experience to estimate what percent of vegetation cover is lost with a single pass of a tank.  C values range from 0 to 0.45.  Multiply 0.45 by percent vegetation lost to get the impact factor (i.e. 50% vegetation loss with one pass of a vehicle would be 0.50 * 0.45 = 0.225) 

2. Impact estimates from step 1 are usually provided by vegetation type (grass, shrub, forest), but can by any site descriptor.   Find a spatial layer that identifies these areas or “Reclassify” another layer into these categories (i.e., vegetation layer into lifeform layer). 

3. “Reclassify” the descriptor values (grass, shrub, forest) with the impact values (ie 0.22, 0.13, 0.14).

Option 2 

Option 2 is similar to the subject matter experts (SME) approach of Option 1 except that impact study data is used instead of opinions to estimate the impact factor.

1. Ask installation personnel if they have had any vehicle impact studies conducted on their lands.  If yes, request copy of report.  In the report find out what percent of vegetation was lost with a single pass of a vehicle.  Only consider vegetative cover and not the species composition data.  C values range from 0 to 0.45.  Multiply 0.45 by percent vegetation lost to get the impact factor (i.e. 50% vegetation loss with one pass of a vehicle would be 0.50 * 0.45 = 0.225) 

2. Impact estimates from step 1 are usually provided by vegetation type (grass, shrub, forest), but can by any site descriptor.   Find a spatial layer that identifies these areas or “Reclassify” another layer into these categories (i.e., vegetation layer into lifeform layer). 

3. “Reclassify” the descriptor values (grass, shrub, forest) with the impact values (ie 0.22, 0.13, 0.14).

Option 3 

Option 3 uses LCTA data and GIS vegetation data to estimate an impact factor.  If installation has LCTA data, extract DMCE, DMCN, Plotid, % aerial cover, percent ground cover, and minimum drip height for each plot.  Do this once using only data points with single pass disturbance data and once with only data points with no disturbance.  This will result in two datasets.  Use the following SQL queries in Appendix G for calculating impact values from traditional LCTA databases.
1. Subtract C factor value from disturbed data set from C factor value from undisturbed data set.  Only use plots that have both values. This is the deltaC dataset.  You will probably use a spreadsheet for this processing.

2. Use the DMCE, DMCN, Plotid data to “add an XY event theme ”.

3. Identify the vegetation type of each plot (usually a high level of vegetation classification like grass, shrub, forest).

4. In a spreadsheet combine the plot type (vegetation type) data with the deltaC data.  Average the DeltaC values for all plots in a vegetation type (grass, shrub, forest). 

5. “Convert to grid theme”.

6. “Reclassify” the vegetation grid using the average DeltaC values. If using ArcView with Spatial Analyst, do the following:

a. Make the new grid active.

b. From ArcView main menu, select Analysis>”Map calculator”.

c. Enter an equation like ((([veg]) = 1) * 0.17) + ((( [veg]) = 2) * 0.22)  where “veg” is the name of the vegetation grid, “1” and “2” are the identifiers for each veg class, and “0.17” and “0.22” are the average deltaC values for each veg class calculated above.

Recovery Factor

The recovery factor is the recovery period (expressed in number of years) that an area requires to naturally recover the amount of plant cover typically found in an undisturbed area.  

Option 1 

Option 1 uses subject matter experts (SME) to estimate the recovery factor.

1. Ask installation expert (LCTA, LRAM or other personnel) to use personal experience to estimate how long (in years) it takes a denuded site to be fully revegetated without LRAM investment.   

2. Recovery estimates from step 1 are usually provided by vegetation type (grass, shrub, forest), but can be by any site descriptor.   Find a spatial layer that identifies these areas or “Reclassify” another layer into these categories (i.e., vegetation layer into lifeform layer). 

3. “Reclassify” the descriptor values (grass, shrub, forest) with the impact values (ie 3, 6, 10).

Option 2 

Option 2 is similar to the subject matter experts (SME) approach of Option 1 except that recovery study data is used instead of opinions to estimate the recovery factor.

1. Ask installation personnel if they have had any vehicle impact studies conducted on their lands.  If yes, ask if the studies were remeasured for recovery.  If yes, request copy of report.  In the report find out what percent of vegetation recovered in how many years.  Assume a linear rate of recovery and estimate total years of recovery.  

2. Recovery estimates from step 1 are usually provided by vegetation type (grass, shrub, forest), but can be by any site descriptor.   Find a spatial layer that identifies these areas or “Reclassify” another layer into these categories (i.e., vegetation layer into lifeform layer). 

3. “Reclassify” the descriptor values (grass, shrub, forest) with the impact values (ie 3, 6, 10).

Wind Erosion Input Layers

K Factor

The Wind Erosion Equation K factor is the ridge roughness factor.   This is not the same as the Water Erosion K factor.  The K factor is a function of ridge height and spacing from tillage operations.  In most instances on military training and testing lands, the K factor is assumed to be 1.  However, some military installations have included surface roughness measures as part of their LCTA monitoring programs.  If data is available, this data can be used.

Option 1 

Option 1 uses a default value for the K factor.

1. Acquire installation boundary layer in ArcInfo or ArcView format.

2. If necessary, convert shapefile data to ArcInfo format.

3. Use a default K factor value of “1”. 

4. “Edit the attribute table” by adding a “Kvalue” item.

5. Populate all polygon feature records to the default K Value in Step 3.

6. “Convert to grid theme”.

Option 2 

Option 2 uses field data for the K factor.  Field data on surface roughness is not usually collected with LCTA data.  This data is usually beyond the scope of an RSC data development process.  However if data exists, the following documents general data develop procedures.

1. Ask installation personal to roughness values and data layer for extrapolating roughness values.     

2. Roughness estimates from step 1 are usually provided by soil type, but can be by any site descriptor.  Use the spatial extrapolation layer provided by the installation. 

3. “Reclassify” the descriptor values (ie soil type) with the appropriate roughness values.

C Factor

The C factor is the climatic factor of the Wind Erosion Equation.  This is not the same as the Water Erosion C factor.  Usually a C factor value for an installation is obtained from a C Factor Map provided by the Natural Resources Conservation Service (NRCS).  This C factor map is published in the NRCS – National Agronomy Manual (190-V-NAM, Second Edition, March 1988, Part 502 – Wind Erosion, Exhibit 502.63-a: Annual “C” Values).  C factor values can also be calculated from weather station data.  Skidmore (Skidmore, E. L. 1986. Wind erosion climatic erosivity.  Climate Change 9:195-208.) provides equations for calculating C factor values from weather data.  It is generally not recommended that C factor values be derived from local data since data preparation can be very time consuming and greatly affects final results.

Option 1 

Option 1 uses the NRCS C Factor isoerodent map.  This is the preferred method of data development.

1. Acquire installation boundary layer in ArcInfo or ArcView format.

2. If necessary, convert shapefile data to ArcInfo format.

3. Locate the installation on the isoerodent map (see figure below) and determine the correct C factor value to use for the installation.  Isoerodent maps are found in “NRCS – National Agronomy Manual (190-V-NAM, Second Edition, March 1988, Part 502 – Wind Erosion, Exhibit 502.63-a: Annual “C” Values”. (See following graph for example isoerodent map.)

4. “Edit the attribute table” by adding a “Cvalue” item.

5. Populate all polygon feature records to the C Value in Step 3.

6. “Convert to grid theme”.



Example NRCS isoerodent C factor map.

Option 2 

Option 2 uses field data for the C factor.  Field data on climatic conditions is generally beyond the scope of RSC LCM data development.  However if data exists, the following documents general data develop procedures.

1. Ask installation personnel to climatic data.  Calculate C factor values as documented in Skidmore, E. L. 1986. Wind erosion climatic erosivity.  Climate Change 9:195-208.

2. C factor values from step 1 are usually provided for the whole installation.  Use and installation data layer to spatially extrapolate data. 

3. “Reclassify” a boundary map with the appropriate C factor value.

I Factor

The I factor is the soil erodibility index.  The I factor of a soil is frequently published in the interpretive table section of most modern soil surveys.  This factor is expressed as the average annual soil loss in tons per acre per year from a field that is isolated, unsheltered, wide, bare, and smooth at a location with the C factor of 100.   I factor values can also be obtained from ITAM publications produced by installations or from installation specific data.

Option 1 

Option 1 uses the installations digitized soil survey map. This option is the preferred data development option for most installations.  If installations already have spatially explicit information on current soil conditions and recovery rates to disturbance, one of the other data development options may be used. 

I factor values are available for most published soil surveys from the U.S. Department of Agriculture's (USDA) Natural Resource Conservation Service (NRCS).  Wind erodibility groups are soils that have similar properties affecting their resistance to soil blowing.  Each wind erodibility group has a specified I factor value.  I factor values can be found in the table of Physical and Chemical Properties of Soils in published soil survey manuals.  The figure below shows a table reproduced from an NRCS soil survey manual that lists wind erodibility groups by soil type and the following table shows suggested I factor values for western installations. 



Example NRCS soil survey manual wind erodibility groups by soil type.

Wind erodibility groups and suggested I factor values for western installations1.

	Wind 

Erodibility Group
	Agricultural I Factor
	Rangeland I Factors

	
	
	Biocrusted
	Undisturbed
	Disturbed
	Intermediate

	1
	310
	134
	310
	310
	310

	2
	180
	86
	134
	180
	160

	3
	86
	38
	56
	86
	86

	4
	86
	38
	48
	86
	56

	4L
	86
	38
	48
	86
	56

	5
	56
	21
	38
	56
	38

	6
	48
	21
	30
	48
	30

	7
	38
	12
	21
	38
	21

	8
	21
	4
	12
	21
	16


1. Table reproduced from “Cochran, C. 2000. Wind Erodibility Groups for Western Installation. The Bridge, Winter 2000, pp9-10.

Typically, a user must “reclassify” a soils map layer delineating soil mapping units into a new I factor map layer by assigning I factor values to each mapping unit in the original soils map.

1. Obtain soils coverage for installation.  Use NRCS SSURGO soils coverage and NASIS database if available. For information regarding NRCS/NASIS data and availability, contact George Teacheman at: George.Teachman@daapgea050.apgea.army.mil.

a. If necessary, convert NASIS database from Access 2000 to alternate Access software version if required for Access software/database compatibility.   On 2000 platform conversion is accomplished by:

i. Open database.  

ii. Choose tools 

iii. database utilities

iv. convert database.

2. Complete this step if using NASIS data.  Query NASIS database for 200 Sieve values based on the soils data used for analysis.  If NASIS data is not available skip to step 3.

a. Open query in design view

b. Add “mapunit”, “component”, and “chorizon” tables 

c. Add the following fields: (1) mapunit_symbol (mapunit); (2) mapunit_name (mapunit); (3) i_factor (component); (4) soil_eordibility_factor_whole (chorizon); (5) component_name (component); (6) component_percent_r (component); (7) horizon_depth_to_top (chorizon)

d. Show all fields

e. Sort by “mapunit_symbol”

f. Enter the value of  “0” for the field criteria “horizon_depth_to_top”. 

g. Run query resulting in new table.  

h. View table.  

i. Save table and query.

j. The resulting table from step 3 provides sieve values for all soils type and component series at a soil depth of 0 (the soil surface).  At this time several sieve values may exist for duplicate soil symbols.  This occurs due to multiple soils component types for a single soil symbol.  It may be necessary to manually edit the table to delete multiple I factor values. The criteria for table edits can be based on the “percent_component” field which provides the representative percent of the soil component.  Choose the larger mapunit_symbol soils component percent for a representative sieve value.  In the case where the “percent_component” values are the same use the limiting sieve values that represent the most erosivity (i.e. the higher the sieve value, the greater the erosivity).  Alternatively, an average value can be used for duplicative sieve for multiple soils component types.  It is necessary to manually edit each duplicate mapunit_symbol value based on this criteria.  The table editing process should only take a few minutes, due to the relatively small number of duplicate mapunit_symbol values.  

k. Once the table has been edited, save the table and close.  At this time the user can create a new Make Table query based on the previous table.  This will remove any extraneous data fields and allow the user to rename fields if necessary.  Export as dbfIV file for table joins to SSURGO coverage.

3. Complete this step if using Non-SSURGO data with MUIR database. If using NASIS data, skip this step.

a. Tables used for query include: (1) mapunit; (2) component and (3) chorizon

b. Items mapunit_symbol or Mapunit name may be used for join relationships in ArcView

c. Construct query using tables to include the following items; (1) muid, (2) mapunit_symbol; (3) mapunit_name; (4) tfactor; and (5) k-factor (kf) or (kw).  Note: t-factor is found in component table and k-factor is located in chorizon table.

4. Join query.dbf to soils coverage based on common item name.  For example SSURGO data utilizes the item muid for join relationships. Non-SSURGO data may use mapunit_sysmbol or Mapunit_name.  

a. If using ArcView with Spatial Analyst, do the following:

i. Open the query.dbf and the soils tables to “join”.

ii. Make the source table active (soils).

iii. Click the name of the common item for the “join”.

iv. Make the destination table (query.dbf) active.

v. Click the name of the common item for the “join”.

vi. From the Table menu choose Join, or click the “Join” button.

vii. “Convert to grid theme” based on sieve items in soils table join.

b. If using ArcView with Spatial Analyst, do the following:

i. Click on the theme (soils with query.dbf) to convert to grid theme.

ii. From the Theme menu, choose Convert to Grid (“convert to grid theme”).  In the Conversion Field dialog, choose an item in the feature theme that will be used to give values to the cells in the output grid theme.

Option 2 

Option 2 uses I factor adapted for military lands by the NRCS and Yuma Proving Ground.  The following table provides modified I factor values by Wind Erosion Group from NRCS soil surveys. This approach for data development is appropriate for installations that can estimate recover rates for I factor values and do not want to use the default NRCS erodibility values.

The suggested Rangeland I values in the table below are based on United States Department of Agriculture (USDA) Natural Resources Conservation Service (NRCS) guidelines, field measurements taken at the U.S. Army Yuma Proving Ground.  The Undisturbed factors are for land that has rested for a period of at least six months and has had at least four separate rainfall events.  The Intermediate factors are for land that has rested for at least three months and has had at least one rainfall event.  The Disturbed factors are for land that has not had a rainfall event since the last land-disturbing activity and has not rested for a minimum of three months.  The suggested biocrust I values may be used for areas with 50 percent or more of the ground covered with microphytic crusts. The suggested biocrust I values represent the minimum I values allowed for crusting, based on guidance in the USDA-Natural Resources Conservation Service National Agronomy Manual, Title 190; Part 502 (Draft).

1. Use the Wind Erodibility Group map created in Option 1 above for I Factor data development.  

2. Use erodibility estimates from the following table instead of the soil survey values for NRCS Wind Erodibility Groups.  Note that estimates are provided for several soil conditions: crusted, disturbed etc.  Guidance from installation personnel will be required to determine the correct category to use. 

3. “Reclassify” the descriptor values (ie soil type) with the appropriate erodibility values.

Option 3 

Option 3 uses field data for the I factor.  Field data on soil erodibility is not usually collected with LCTA data.  This data is usually beyond the scope of an RSC data development process.  However if data exists and has been processed, the following documents general data develop procedures.

1. Ask installation personal for erodibility values and data layer for extrapolating erodibility values.     

2. Erodibility estimates from step 1 are usually provided by soil type, but can be by any site descriptor.  Use the spatial extrapolation layer provided by the installation. 

3. “Reclassify” the descriptor values (ie soil type) with the appropriate erodibility values.

I Impact

The I impact factor is the change in the I factor that results from a single pass of a vehicle.  Vehicle impact data are available from a variety of sources such as installation studies, published literature, and/or subject matter experts.  The choice of data sources for the ATTACC model will likely vary between installations.  The approach used to develop the I impact factor is partially based on the method used to develop the I factor.  The two approaches must be consistent.  Each option below indicates with which I factor method it is appropriate. 

Option 1 

Option 1 is used to develop the I impact factor if the I factor was developed using Option 1.  Option 1 uses a default value of zero for the I impact factor.  This is because the I factor for Option 1 assumes disturbed conditions.  

1. Acquire installation boundary layer in ArcInfo or ArcView format.

2. If necessary, convert shapefile data to ArcInfo format.

3. Assume a default value of “0” for I impact.

4. Add “IImpact” item to layer’s attribute table.

5. Populate all polygon feature records to the default I impact value in Step 3.

6. Convert coverage to grid.

Option 2 

This option is used to develop the “I impact” factor if the previously developed “I factor” was developed using the “I factor - Option 2 procedure.  Option 2 uses I impact factors adapted for military lands by the NRCS and Yuma Proving Ground.  The following table provides modified I impact factor values by the Wind Erosion Group from NRCS soil surveys. This approach for data development is appropriate for installations that can estimate recover rates for I impact factor values and do not want to use the default NRCS erodibility values.

1. Use the Wind Erodibility Group map created in Option 1 above for I Factor data development.  

2. Use erodibility impact estimates from the following table instead of the soil survey values for NRCS Wind Erodibility Groups.  Note that estimates are provided for several soil conditions: crusted, disturbed etc.  Guidance from installation personnel will be required to determine the correct category to use.  It is important to use the same soil condition for I impact factor that was used for the I factor (ie if crusted was used for I factor, then crusted should be used for I impact factor).

3. “Reclassify” the descriptor values (i.e. soil type) with the appropriate erodibility impact values.
Wind erodibility groups and suggested I factor values for western 

installations1.

	Wind 

Erodibility Group
	Agricultural I Factor
	Rangeland I Factors

	
	
	Biocrusted
	Undisturbed
	Disturbed
	Intermediate

	1
	0 310
	134
	0 310
	0 310
	0 310

	2
	0 180
	86
	134
	0 180
	160

	3
	0 86
	38
	56
	0 86
	0 86

	4
	0 86
	38
	48
	0 86
	56

	4L
	0 86
	38
	48
	0 86
	56

	5
	0 56
	21
	38
	0 56
	38

	6
	0 48
	21
	30
	0 48
	30

	7
	0 38
	12
	21
	0 38
	21

	8
	0 21
	4
	12
	0 21
	16


1. Table reproduced from “Cochran, C. 2000. Wind Erodibility Groups for Western Installation. The Bridge, Winter 2000, pp9-10.

Option 3 

Option 3 uses field data for the I impact factor.  Field data on soil erodibility impact is not usually collected with LCTA data.  This data is usually beyond the scope of an RSC data development process.  However if data exists and has been processed, the following documents general data develop procedures.

Experimental impact studies that specifically examined the impact of military vehicles on installation resources have been completed (Silcox 1995, Thurow et al 1995.  Van Horne and Sharp 1998, Watts 1998, Wilson 1988).  Many of these studies quantify the impact of single and multiple passes of a vehicle.  Data from these types of studies can be used to estimate a change in I factor associated with a pass of a vehicle.  The data from these studies must then be extrapolated across the installation. Results of studies of related impacts such as off-road civilian vehicle impact studies can also be used to infer changes in I factor associated with vehicle impacts.  Data can be extrapolated by vegetation type, soil type, or other relevant spatial data.

1. Ask installation personal for erodibility impact values and data layer for extrapolating values.     

2. Erodibility impact estimates from step 1 are usually provided by soil type, but can be by any site descriptor.  Use the spatial extrapolation layer provided by the installation. 

3. “Reclassify” the descriptor values (ie soil type) with the appropriate erodibility impact values.

I Recovery

Option 1

Option 1 is used to develop the I recovery factor if the I factor was developed using Option 1.  Option 1 uses a default value of zero for the I recovery factor.  This is because the I factor for Option 1 assumes disturbed conditions.  

1. Acquire installation boundary layer in ArcInfo or ArcView format.

2. If necessary, convert shapefile data to ArcInfo format.

3. Assume a default value of “0” for I recovery.

4. “Edit the attribute table” by adding  “IRecovery” item.

5. Populate all polygon feature records to the default I recovery value in Step 3.

6. “Convert to grid theme”.

Option 2

Option 2 uses subject matter experts (SME) to estimate the I recovery factor.  This option for developing recovery factors is appropriate with options 2 or 3 for developing I factors.

1. Ask installation expert (LCTA, LRAM or other personnel) to use personal experience to estimate how long it takes (in years) for a disturbed site to be fully recovered without LRAM investment.  This recovery time is for soil crust formation not revegetation.   

2. Recovery estimates from step 1 are usually provided by soil type but can be by any site descriptor.   Find a spatial layer that identifies these areas or “reclassify” another layer into these categories. 

3. “Reclassify” the descriptor values (soil types) with the recovery values (ie 3, 6, 10).

Option 3 

Option 3 is similar to the subject matter experts (SME) approach of Option 1 except that recovery study data is used instead of opinions to estimate the recovery factor. This option for developing recovery factors is appropriate with options 2 or 3 for developing I factors.

1. Ask installation personnel if they have had any vehicle impact studies conducted on their lands.  If yes, ask if the studies were remeasured for recovery.  Recovery for this factor is the recovery of the soil crust and aggregate, not revegetation of the site. If yes, request copy of report.  In the report find out what percent of vegetation recovered in how many years.  Assume a linear rate of recovery and estimate total years of recovery.  

2. Recovery estimates from step 1 are usually provided by soil type but can be by any site descriptor.   Find a spatial layer that identifies these areas or “reclassify” another layer into these categories. 

3. “Reclassify” the descriptor values (soil type) with the recovery values (i.e. 3, 6, 10).

Plant Height

The Plant Height data layer is a map layer representing the average height of vegetation.  Plant height is one of the components that make up the L factor in the modified Wind Erosion Equation used to estimate wind erosion in the LCM.  The L factor is the unsheltered distance in feet along the prevailing wind direction.  For areas of perennial pasture, the L factor approaches 0.  For arid military installations that are predominantly bare with spaced clumps of grass or shrubs, the L factor can be estimated using plant spacing, plant height, foliage density, and vegetation type.  

Option 1 

Option 1 uses subject matter experts to estimates plant height.

1. Ask installation expert (LCTA, LRAM or other personnel) to use personal experience to estimate average vegetation height of woody cover for vegetation types typically found on an installation. 

2. Height estimates from step 1 are usually provided by vegetation type but can by any site descriptor.   Find a spatial layer that identifies these areas or “reclassify” another layer into these categories (i.e., vegetation layer into lifeform layer). 

3. “Reclassify” the descriptor values with the height values.

Option 2 

Use this option when an installation only has LCTA and no general GIS data layers.  Not likely to use this option since almost all installations with LCTA data have some GIS used for plot allocation. 

1. Query the LCTA database for the most recent years data and create a file with PlotID, DMCE, DMCN, StemsPerAcre, AvgHt.  The queries in Appendix G can be used to summarize data from a traditional LCTA database. 

2.  “Create a point layer” from LCTA coordinate data.

3. Interpolate values between plot locations.  If using ArcView with Spatial Analyst, do the following:

a. Make points file the active map in the view.

b. From ArcView main menu, select Surface>”Interpolate grid”.  In the first interpolation dialog box set extent equal to the boundary map and cell size to a reasonable number based on input data.  In second interpolation dialog box set z value to the average plant height values.  Try different interpolation options to produce a map that is most reasonable. 

c. Save data to file.  From ArcView main menu, select File>Export.  In Export dialog box select DBase format.

4. “Convert to grid theme”.

Option 3 

Option 3 is for when an installation has LCTA data and some GIS data for extrapolation. Use when installation has standardized LCTA data and vegetation layer.

1. Use LCTA database to create an erosion summary.  Get the most recent years data and save to a DBbaseIV file with PlotID, DMCE, DMCN, StemsPerAcre, AvgHt.  The database query in Appendix G can be used to extract data from a traditional LCTA database. 

2. Acquire a generalized vegetation type layer (grass, shrub, forest) or create from more detailed vegetation layer.  

3. “Create a point layer” depicting LCTA plot locations from coordinate information contained in the database.

4. “Merge” LCTA layer with height layer.  If using ArcView with Spatial Analyst, “ join” attributes tables based on the “Shape” item. 

5. Save the table to new file.  If using ArcView with Spatial Analyst, use the following steps:

a. Make the height factor table active by selecting it.  

b. From ArcView main menu, select File>Export.

c. In the Export dialog box, select “dbase” as the format.

6. Calculate average height value for each vegetation type.

a. Open dbase file from step 5 in MS Excel.  

b. From the Excel main menu select Data>Pivot table.  In first dialog box select “excel list” and “pivot table”. In second dialog box provide range of data by highlighting the data.  In third dialog box check new spreadsheet and press “layout” button.  In the layout dialog box drag box for vegetation classifications into left side of table and box for cover factor values into center of table.  Double click on the c factor box in the center of table and change to average. Select the “ok” button then the “finish” button.  This will create a table of average c factor values for each vegetation type.  Exact steps will vary with version of Excel.  Other software tools can be used to get the average values.

7. “Convert (the vegetation layer) to grid theme”.

8. “Reclassify” the vegetation grid using average height factor values.  If using ArcView with Spatial Analyst, do the following:

a. Make the new grid active.

b. From ArcView main menu, select Analysis>”Map calculator”. Enter an equation like ((([veg]) = 1) * 13) + ((( [veg]) = 2) * 22)  where “veg” is the name of the vegetation grid, “1” and “2” are the identifiers for each vegetation class, and “13” and “22” are the average height factor values for each  vegetation class calculated above.

Plant Spacing

The plant spacing map is the number of woody stems per acre.  The wind erosion component of the ATTACC LCM will calculate plant spacing from the number of plants.  Plant spacing is another component of the L factor used in the Wind Erosion Equation.

Option 1 

Option 1 uses subject matter experts to estimate stems per acre.

1. Ask installation expert (LCTA, LRAM or other personnel) to use personal experience to estimate stems per acre of woody cover for vegetation types typically found on an installation. 

2. Stems per acre estimates from step 1 are usually provided by vegetation type but can by any site descriptor.   Find a spatial layer that identifies these areas or “reclassify” another layer into these categories (i.e., vegetation layer into lifeform layer). 

3. “Reclassify” the descriptor values with the stems per acre values.

Option 2 

Use this option when an installation only has LCTA and no general GIS data layers.  Not likely to use this option since almost all installations with LCTA data have some GIS used for plot allocation. 

1. Query the LCTA database for the most recent years data and create a file with PlotID, DMCE, DMCN, StemsPerAcre, AvgHt.  The queries found in Appendix G can be used to summarize data from a traditional LCTA database. 

2.  “Create a point layer” from LCTA coordinate data.

3. Interpolate values between plot locations.  If using ArcView with Spatial Analyst, do the following:

a. Make points file the active map in the view.

b. From ArcView main menu, select Surface>Interpolate grid.  In the first interpolation dialog box set extent equal to the boundary map and cell size to a reasonable number based on input data.  In second interpolation dialog box set z value to the c factor values.  Try different interpolation options to produce a map that is most reasonable. 

c. Save data to file.  From ArcView main menu, select File>Export.  In Export dialog box select DBase format.

4. “Convert to grid theme”.

Option 3 

Option 3 is for when an installation has LCTA data and some GIS data for extrapolation. Use when installation has standardized LCTA data and vegetation layer.

1. Use LCTA database to create an erosion summary.  Get the most recent years data and save to a DBbaseIV file with PlotID, DMCE, DMCN, StemsPerAcre, AvgHt.  The database query found in Appendix G can be used to extract data from a traditional LCTA database. 

2. Acquire a generalized vegetation type layer (grass, shrub, forest) or create from more detailed vegetation layer.  

3. “Create a point layer” depicting LCTA plot locations from coordinate information contained in the database.

4. “Merge” LCTA layer with stems per acre layer.  If using ArcView with Spatial Analyst, “join” attributes tables based on the “Shape” item. 

5. Save the table to new file.  If using ArcView with Spatial Analyst, use the following steps:

a. Make the height factor table active by selecting it.  

b. From ArcView main menu, select File>Export.

c. In the Export dialog box, select “dbase” as the format.

6. Calculate stems per acre value for each vegetation type.

a. Open dbase file from step 5 in MS Excel.  

b. From the Excel main menu select Data>Pivot table.  In first dialog box select “excel list” and “pivot table”. In second dialog box provide range of data by highlighting the data.  In third dialog box check new spreadsheet and press “layout” button.  In the layout dialog box drag box for vegetation classifications into left side of table and box for cover factor values into center of table.  Double click on the c factor box in the center of table and change to average. Select the “ok” button then the “finish” button.  This will create a table of average c factor values for each vegetation type.  Exact steps will vary with version of Excel.  Other software tools can be used to get the average values.

7. “Convert to grid theme”.

8. “Reclassify” the vegetation grid using average stems per acre factor values.  If using ArcView with Spatial Analyst, do the following:

a. Make the new grid active.

b. From ArcView main menu, select Analysis>”Map calculator”.

c. Enter an equation like ((([veg]) = 1) * 13) + ((( [veg]) = 2) * 22)  where “veg” is the name of the vegetation grid, “1” and “2” are the identifiers for each vegetation class, and “13” and “22” are the stems per acre factor values for each  vegetation class calculated above.

Foliage Density

Foliage density is the percent area vertically occupied by the plant.  A value of 1 is complete cover.  A value of 0.1 is 10% vertical cover.  Foliage density is an ocular estimate for the dominant vegetation form found in an area.  Foliage density is another component of the L factor used in the Wind Erosion Equation.

Option 1 

Option 1 uses subject matter experts (SME) to estimate foliage density.  Some LCTA programs have estimated foliage density for the dominant plant species found on their installations.  If this data is available, it may be used.  If field data is not available, installation personnel can estimate foliage densities. Typically, a user must “reclassify” a vegetation map layer delineating plant communities into a foliage density map by assigning the appropriate values to each category.

1. Ask installation expert (LCTA, LRAM or other personnel) to use personal experience to estimate foliage density of the dominant plant form for typical areas found on an installation.    

2. Estimates from step 1 are usually provided by vegetation type or plant community, but can be by any site descriptor.   Find a spatial layer that identifies these areas or “reclassify” another layer into these categories (i.e., vegetation layer into lifeform layer). 

3. “Reclassify” the descriptor values (grass, shrub, forest) with the foliage density values (ie 0.3, 0.6, 0.1).

Canopy Width

Canopy width is the average canopy width of the dominant vegetation on a site. Canopy width can be estimated for some LCTA belt transect data sets but usually must be estimated by subject matter expert opinion.  Ocular estimates for the dominant vegetation type can be made.  Canopy width is another component of the L factor used in the Wind Erosion Equation.

Option 1 

1. Ask installation expert (LCTA, LRAM or other personnel) to use personal experience to estimate canopy width of the dominant plant form for typical areas found on an installation.    

2. Estimates from step 1 are usually provided by vegetation type or plant community, but can be by any site descriptor.   Find a spatial layer that identifies these areas or “reclassify” another layer into these categories (i.e., vegetation layer into lifeform layer). 

3. “Reclassify” the descriptor values (grass, shrub, forest) with the canopy width values (ie 0.3, 0.6, 0.1).

Vegetation Type

Vegetation type has three values: 0.75 for deciduous vegetation, 1.0 for evergreen vegetation, and 0.875 for mixed vegetation.  Typically, a user must “reclassify” a vegetation map layer delineating plant communities into a vegetation type map by assigning the appropriate values each category.  LCTA data can be used to determine vegetation type but is probably not worthwhile.  Vegetation type is another component of the L factor used in the Wind Erosion Equation.

Option 1 

Option one uses a vegetation map to develop a vegetation type data layer

1. Obtain a vegetation map for the installation.  Use the attribute tables to classify each vegetation class into primarily deciduous, evergreen, or mixed vegetation.  If attribute data is not available, ask installation expert (LCTA, LRAM or other personnel) to classify each vegetation class.    

2. “Reclassify” vegetation layer into deciduous, evergreen, or mixed vegetation classes.   

3. “Reclassify” the descriptor values (deciduous, evergreen, or mixed) with the vegetation type values (ie 1.0, 0.75, 0.875).

4. “Convert to grid theme”.

Dry Wt Production

The Dry weight production map is a data layer representing the estimate of dry weight biomass production.  For rangeland conditions, it is used together with the small grain equivalent map (see section below) to calculate the V factor for the Wind Erosion Equation.   The V factor is the vegetative factor and accounts for the amount, kind, and orientation of vegetation in pounds per acre of small grain equivalent.  

Total biomass production refers to the amount of vegetation that can be expected to grow annually.  It is often expressed in pounds per acre of air-dry vegetation for favorable, normal, and unfavorable years.  Favorable years are years in which the amount and distribution of precipitation and temperatures are such that growing conditions are substantially better than normal.  In normal years these conditions are about average for the area.  In unfavorable years these conditions are well below average.

Biomass production values are available for most published soil surveys from the U.S. Department of Agriculture's (USDA) Natural Resource Conservation Service (NRCS).  Biomass production estimates can be found in the table of Rangeland Productivity and Characteristic Plant Communities in published soil survey manuals.  The following figure shows a table reproduced from an NRCS soil survey manual that lists biomass production estimates by soil type.  Typically, a user must “reclassify” a soils map layer delineating soil mapping units into a new biomass map layer by assigning biomass production values to each mapping unit in the original soils map.
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TABLE 5.--RANGELAND PRODUCTIVITY AND CHARACTERISTIC PLANT COMMUNITIES

(Only the soils that support rangeland vegetation suitable for grazing are listed)

| | Total production | I |
Soil name and | Range site | | Ccharacteristic vegetation |Compo-|
mp symol | |Kind of year | Dry | |sition|
| | |ueight | | 1
| | |Lbracre| |
| | | | |
1 I I T
Riverbend family--|Limy Upland, Deep, 2-7" P.z.--|Favorable | 150 |creosotebush----
| |Normal | 100 |cactus------
| |unfavorable | 50 |other shrubs:
| ] | |other annual grasse:
| | | |other annual forbs-:
| | | |
Carrizo family----|Sandy Bottom, 2-7" P.z.-=-==-~ |Favorable | 2,000 |catclaw acacia
| |Normal | 1,000 |Blue paloverde:
| |unfavorable | 500 |ironwood--
| | |
| | |
| | |
| | | |hite burrobrush---
| | | [Littleleaf paloverde-
| | | |pesert Lavender-
| | |
| | |
| | | |other shrubs--
| | | |other perennial forbs:
| | |
| | |
| | |




Example NRCS soil survey manual dry weight production estimates.

Option 1 

Option 1 uses the installations digitized soil survey map.

1. Obtain soils coverage for installation.  Use NRCS SSURGO soils coverage and NASIS database if available. For information regarding NRCS/NASIS data and availability, contact George Teacheman at: George.Teachman@daapgea050.apgea.army.mil.

a. If necessary, convert NASIS database from Access 2000 to alternate Access software version if required for Access software/database compatibility.   On 2000 platform conversion is accomplished by:

i. Open database.  

ii. Choose tools 

iii. database utilities

iv. convert database.

2. Complete this step if using NASIS data.  Query NASIS database for 200 Sieve values based on the soils data used for analysis.  If NASIS data is not available skip to step 3.

a. Open query in design view

b. Add “mapunit”, “component”, and “chorizon” tables 

c. Add the following fields: (1) mapunit_symbol (mapunit); (2) mapunit_name (mapunit); (3) range_production (component); (4) componenet_name (componenet); (5) componenet_percent_r (componenet); (6) horizon_depth_to_top (chorizon)

d. Show all fields

e. Sort by “mapunit_symbol”

f. Enter the value of  “0” for the field criteria “horizon_depth_to_top”. 

g. Run query resulting in new table.  

h. View table.  

i. Save table and query.

j. The resulting table from step 3 provides sieve values for all soils type and component series at a soil depth of 0 (the soil surface).  At this time several sieve values may exist for duplicate soil symbols.  This occurs due to multiple soils component types for a single soil symbol.  It may be necessary to manually edit the table to delete multiple dry wt. Prod. factor values. The criteria for table edits can be based on the “percent_component” field which provides the representative percent of the soil component.  Choose the larger mapunit_symbol soils component percent for a representative sieve value.  In the case where the “percent_component” values are the same use the limiting sieve values that represent the most erosivity (i.e. the higher the sieve value, the greater the erosivity).  Alternatively, an average value can be used for duplicative sieve for multiple soils component types.  It is necessary to manually edit each duplicate mapunit_symbol value based on this criteria.  The table editing process should only take a few minutes, due to the relatively small number of duplicate mapunit_symbol values.  

k. Once the table has been edited, save the table and close.  At this time the user can create a new Make Table query based on the previous table.  This will remove any extraneous data fields and allow the user to rename fields if necessary.  Export as dbfIV file for table joins to SSURGO coverage.

3. Complete this step if using Non-SSURGO data with MUIR database. If using NASIS data, skip this step.

a. Tables used for query include: (1) mapunit; (2) component and (3) rsprod.

b. Items mapunit_symbol or Mapunit name may be used for join relationships in ArcView

c. Construct query using tables to include the following items; (1) muid, (2) mapunit_symbol; (3) mapunit_name; (4) prodfav; (5) prodnorm; (6) produnfv.  Note: prod values found in rsprod table.

4. “Join” query.dbf to soils coverage based on common item name.  For example SSURGO data utilizes the item muid for join relationships. Non-SSURGO data may use mapunit_sysmbol or Mapunit_name.  

a. If using ArcView with Spatial Analyst, do the following:

i. Open the query.dbf and the soils tables to “join”.

ii. Make the source table active (soils).

iii. Click the name of the common item for the “join”.

iv. Make the destination table (query.dbf) active.

v. Click the name of the common item for the “join”.

vi. From the Table menu choose Join, or click the “Join” button.

vii. “Convert to grid theme” based on sieve items in soils table join.

b. If using ArcView with Spatial Analyst, do the following:

i. Click on the theme (soils with query.dbf) to convert to grid theme.

ii. From the Theme menu, choose Convert to Grid (“convert to grid theme”)

iii. In the Conversion Field dialog, choose an item in the feature theme that will be used to give values to the cells in the output grid theme.

Small Grain Equivalent

The data layer represents the small grain equivalent that is used together with the dry weight biomass production map (see above section) to calculate the V factor of the Wind Erosion Equation.  Usually the small grain equivalent for rangeland conditions is set to 4.  However this value can be adjusted to reflect local conditions.

Option 1 

Option 1 uses a default value for the small grain equivalent.

1. Acquire installation boundary layer in ArcInfo or ArcView format.

2. If necessary, convert shapefile data to ArcInfo format.

3. Use a default value of 4 for the small grain equivalent.  Usually use one value per installation.  

4. “Edit the attribute table” by adding “SmGrEq” item. 

5. Populate all polygon feature records to the default value in Step 2.

6. “Convert to grid theme”.

T Factor

Option 1 

T factor is an estimate of the maximum average annual rate of erosion by wind or water that a soil can sustain without loss of productivity.  T factor is one of six factors used in USLE/RUSLE to estimate average annual soil loss.  T factor is in Tons/acre/yr.  Estimates of T factor are based on soil properties including soil depth.  T factor values range from 1 to 5.  The higher the T value, the less susceptible the soil is to soil loss.

Option 1 uses the installations digitized soil survey map.

1. Obtain the soils coverage for the installation.  Use NRCS SSURGO soils coverage and NASIS database if available. Information in NASIS is basically the same information that can be obtained from a typical NRCS soil survey report (see figure below for example soil survey report table for Physical and Chemical Properties).  For information regarding NRCS/NASIS data and availability, contact George Teachman at: George.Teachman@daapgea050.apgea.army.mil.  

a. If necessary, convert NASIS database from Access 2000 to alternate Access software version if required for Access software/database compatibility.   On 2000 platform conversion is accomplished by:

i. Open database.  

ii. Choose tools 

iii. database utilities

iv. convert database.
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Example NRCS soil survey manual of physical and chemical properties that contains T factor values by soil type
2. Complete this step if using NASIS data.  Query NASIS database for T factor (Note that this database also contains K factor values, see section above on K factor map layer development.  For more efficient use of the NASIS data, the user may opt to extract T factor data at the same time K factor data) based on the soils data used for analysis.  If NASIS data is not available skip to step 3.

a. Open query in design view.

b. Add “mapunit”, “component”, and “chorizon” tables.

c. Add the following fields: (1) mapunit_symbol (mapunit); (2) mapunit_name (mapunit); (3) t_factor (component); (4) componenet_name (component); (5) componet_percent_r (component); (6) horizon_depth_to_top (chorizon).

d. Show all fields.

e. Sort by “mapunit_symbol”.

f. Enter the value of  “0” for the field criteria “horizon_depth_to_top”. 

g. Run the query which will result in a new table.  

h. View table.  

i. Save table and query.

j. The resulting table from step 3 provides T factor values for all soils type and component series at a soil depth of 0 (the soil surface).  At this time several T factor values may exist for duplicate soil symbols.  This occurs due to multiple soils component types for a single soil symbol.  It may be necessary to manually edit the table to delete multiple T factor values. The criteria for table edits can be based on the “percent_component” field which provides the representative percent of the soil component.  Choose the larger mapunit_symbol soils component percent for a representative T factor value.  In the case where the “percent_component” values are the same use the limiting T factor values that represent the most erosivity (i.e. the higher the T factor value, the greater the erosivity).  Alternatively, an average value can be used for duplicative T values for multiple soils component types.  It is necessary to manually edit each duplicate mapunit_symbol value based on this criteria.  The table editing process should only take a few minutes, due to the relatively small number of duplicate mapunit_symbol values.  

k. Once the table has been edited, save the table and close.  At this time the user can create a new Make Table query based on the previous table.  This will remove any extraneous data fields and allow the user to rename fields if necessary.  Export as dbfIV file for table joins to SSURGO coverage.

3. Complete this step if using Non-SSURGO data with MUIR database. If using NASIS data, skip this step.

a. Tables used for query include: (1) mapunit; (2) component and (3) t_factor (component).

b. The table items “mapunit_symbol” or “Mapunit name” may be used for “Join” relationships in ArcView

c. Construct query using tables to include the following items; (1) muid, (2) mapunit_symbol; (3) mapunit_name; and (4) t_factor.

4. “Join” query.dbf to soils coverage based on common item name.  For example SSURGO data utilizes the item muid for join relationships. Non-SSURGO data may use mapunit_sysmbol or Mapunit_name.  

a. If using ArcView with Spatial Analyst, do the following:

i. Open the query.dbf and the soils tables to join.

ii. Make the source table active (soils).

iii. Click the name of the common item for the “Join”.
iv. Make the destination table (query.dbf) active.

v. Click the name of the common item for the “Join”.
vi. From the Table menu choose “Join”, or click the “Join” button.

vii. “Convert to grid theme” based on T factor items in soils table join.

b. If using ArcView with Spatial Analyst, do the following:

i. Click on the theme (soils with query.dbf) to “Convert to grid theme” theme.

ii. From the Theme menu, choose “Convert to grid theme”.
iii. In the Conversion Field dialog, choose an item in the feature theme that will be used to give values to the cells in the output grid theme.

Vegetation Impact Factor

The impact factor is the change in the cover factor that results from a single pass of a vehicle.  Vehicle impact data are available from a variety of sources such as installation studies, published literature, LCTA data, and/or subject matter experts.  The choice of data sources for the ATTACC model will likely vary between installations.

Experimental impact studies that specifically examined the impact of military vehicles on installation resources have been completed (Silcox 1995, Thurow et al 1995.  Van Horne and Sharp 1998, Watts 1998, Wilson 1988).  Many of these studies quantify the impact of single and multiple passes of a vehicle.  Data from these studies can be used to estimate a change in cover factor associated with a pass of a vehicle.  The data from these studies must then be extrapolated across the installation. Results of studies of related impacts such as off-road civilian vehicle impact studies can also be used to infer changes in cover factor associated with vehicle impacts.  Data can be extrapolated by vegetation type, soil type, or other relevant spatial data. 

For installations not having experimental studies or off-road vehicle impact studies, LCTA data can be used to estimate the change in cover Factor values resulting from training impact (Shaw and Diersing 1989, Shaw and Diersing 1990, Warren and Bagley 1992, Shaw et al 1990). During the collection of LCTA field data, a determination of the presence or absence of vehicle disturbance is made at each point-intercept along the line transect.  This determination allows each field measurement plot to be divided into disturbed and undisturbed subsets.  A C factor value for disturbed and undisturbed subsets can be calculated. The difference between disturbed and undisturbed values is an estimate of the impact on vegetative cover due to a single pass of vehicle traffic.  This difference is called the Training Impact Factor in the ATTACC methodology. 

An average Impact Factor is calculated for a group of plots representing similar environmental conditions.  The Impact Factor is then extrapolated across the installation using an installation's vegetation, soils, and plot allocation strata maps, and/or other relevant GIS maps.

Option 1 

Option 1 uses subject matter experts (SME) to estimate the impact factor. Note Impact factor for dust erosion is different than for water erosion.  The impact factor for dust is in units of percent cover while water erosion is in units of C.

1. Ask installation expert (LCTA, LRAM or other personnel) to use personal experience to estimate what percent of vegetation cover is lost with a single pass of a tank.  Cover values range from 0 to 100.  Multiply 100 by percent vegetation lost to get the impact factor (ie 50% vegetation loss with one pass of a vehicle would be 0.50 * 100 = 50).

2. Impact estimates from step 1 are usually provided by vegetation type (grass, shrub, forest), but can by any site descriptor.   Find a spatial layer that identifies these areas or “reclassify” another layer into these categories (i.e., vegetation layer into lifeform layer). 

3. “Reclassify” the descriptor values (grass, shrub, forest) with the impact values (ie 10, 50, 72).

Option 2 

Option 2 is similar to the subject matter experts (SME) approach of Option 1 except that impact study data is used instead of opinions to estimate the impact factor.

1. Ask installation personnel if they have had any vehicle impact studies conducted on their lands.  If yes, request copy of report.  In the report find out what percent of vegetation was lost with a single pass of a vehicle.  Only consider vegetative cover not the species composition.  Cover values range from 0 to 100.  Multiply 100 by percent vegetation lost to get the impact factor (ie  50% vegetation loss with one pass of a vehicle would be 0.50 * 100 = 50)

2. Impact estimates from step 1 are usually provided by vegetation type (grass, shrub, forest), but can by any site descriptor.   Find a spatial layer that identifies these areas or “reclassify” another layer into these categories (i.e., vegetation layer into lifeform layer). 

3. “Reclassify” the descriptor values (grass, shrub, forest) with the impact values (ie 10, 50, 73).

Option 3 

Option 3 uses only LCTA data to estimate an impact factor.  If the installation has LCTA data, extract DMCE, DMCN, Plotid, % aerial cover, percent ground cover, and minimum drip height for each plot.  Once using only data points with single pass disturbance data and once with only data points with no disturbance.  This will result in two datasets.  Use the SQL queries found in Appendix G for calculating impact values from traditional LCTA databases.  Calculate Cover factor value for each plot in each data set

1. Subtract Cover factor value from disturbed data set from Cover factor value from undisturbed data set.  Only use plots that have both values. This is the deltaCover dataset.

2. Use the DMCE, DMCN, Plotid data to create a points layer.

3. Identify the vegetation type of each plot (usually a high level of vegetation classification like grass, shrub, forest).

4. Average the DeltaCover values for all plots in a vegetation type (grass, shrub, forest) 

5. Convert to grid format.

6. “Reclassify” the vegetation grid using the average DeltaCover values.

Vegetation Recovery Factor

Provide the name and location of the recovery factor map. The select file button can also be used to select a file name using the file open dialog box. The recovery factor for dust may or may not be the same as for other measures of land condition.  If you have already specified an impact factor in another dialog box, you will not see that value displayed here.

The recovery factor is the recovery period (expressed in number of years) that an area requires to naturally recover the amount of plant cover typically found in an undisturbed area.  Recovery periods are available for some installations from experimental data.  Unfortunately these types of data are not always available or possible to collect.  Estimates of natural recovery can also be obtained from the literature, subject matter experts, or personal experience.  

Frequently in the ATTACC methodology, installation ITAM personnel (or designated experts) estimated recovery rates.  These estimated recovery rates are associated with maps representing vegetation type, soil type, or another spatially distributed land feature, so that the information can be extrapolated across the installation.  Expert opinions were validated using experimental data on recovery rates and literature, where available and applicable

Option 1 

Option 1 uses subject matter experts (SME) to estimate the recovery factor.  Note that the recovery estimate for water erosion and dust erosion may be the same data layer and can be reused.

1. Ask installation expert (LCTA, LRAM or other personnel) to use personal experience to estimate how long it takes a denuded site to be fully revegetated without LRAM investment.   

2. Recovery estimates from step 1 are usually provided by vegetation type (grass, shrub, forest), but can be by any site descriptor.   Find a spatial layer that identifies these areas or “reclassify” another layer into these categories (i.e., vegetation layer into lifeform layer). 

3. “Reclassify” the descriptor values (grass, shrub, forest) with the impact values (ie 3, 6, 10).

Option 2 

Option 2 is similar to the subject matter experts (SME) approach of Option 1 except that recovery study data is used instead of opinions to estimate the recovery factor.  Note that the recovery estimate for water erosion and dust erosion may be the same data layer and can be reused.

1. Ask installation personnel if they have had any vehicle impact studies conducted on their lands.  If yes, ask if the studies were remeasured for recovery.  If yes, request copy of report.  In the report find out what percent of vegetation recovered in how many years.  Assume a linear rate of recovery and estimate total years of recovery.  

2. Recovery estimates from step 1 are usually provided by vegetation type (grass, shrub, forest), but can be by any site descriptor.   Find a spatial layer that identifies these areas or “reclassify” another layer into these categories (i.e., vegetation layer into lifeform layer). 

3. “Reclassify” the descriptor values (grass, shrub, forest) with the impact values (ie 3, 6, 10).

Dust Erosion Input Layers

Sieve 200 

A sieve size of 200 has a sieve opening size of 0.074-mm. Sieve values range from 0 to 100% for this data layer. The following figure shows an example NRCS soil survey manual table with sieve 200 values. 
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Example Engineering Index Properties table from a soil survery report containing Sieve 200 values.
Option 1 

Option 1 uses the installations digitized soil survey map.

1. Obtain the soils coverage for the installation.  Use NRCS SSURGO soils coverage and NASIS database if available. Information in NASIS is basically the same information that can be obtained from a typical NRCS soil survey report.  The following figure shows a typical Engineering Index Properties table for a soil survey report.  This table contains information on sieve size.  For information regarding NRCS/NASIS data and availability, contact George Teachman at: George.Teachman@daapgea050.apgea.army.mil.  

a. If necessary, Convert NASIS database from Access 2000 to prior version if Access software is pre-2000.   On 2000 platform – Open database.  Choose tools > database utilities> convert database.

2. Complete this step if using NASIS data.  Query NASIS database for 200 Sieve values based on the soils data used for analysis.  If NASIS data is not available skip to step 3.

a. Open query in design view

b. Add “mapunit”, “component”, and “chorizon” tables 

c. Add the following fields: (1) mapunit_symbol (mapunit); (2) mapunit_name (mapunit); (3) component_name (componenet); (4) component_percent_r (component); (5) horizon_depth_to_top (chorizon)

d. Show all fields

e. Sort by “mapunit_symbol”

f. Enter the value of  “0” for the field criteria “horizon_depth_to_top”. 

g. Run query resulting in new table.  

h. View table.  

i. Save table and query.

j. The resulting table from step 3 provides sieve values for all soils type and component series at a soil depth of 0 (the soil surface).  At this time several sieve values may exist for duplicate soil symbols.  This occurs due to multiple soils component types for a single soil symbol.  It may be necessary to manually edit the table to delete multiple sieve 200 factor values. The criteria for table edits can be based on the “percent_component” field which provides the representative percent of the soil component.  Choose the larger mapunit_symbol soils component percent for a representative sieve value.  In the case where the “percent_component” values are the same use the limiting sieve values that represent the most erosivity (i.e. the higher the sieve value, the greater the erosivity).  Alternatively, an average value can be used for duplicative sieve for multiple soils component types.  It is necessary to manually edit each duplicate mapunit_symbol value based on this criteria.  The table editing process should only take a few minutes, due to the relatively small number of duplicate mapunit_symbol values.  

k. Once the table has been edited, save the table and close.  At this time the user can create a new Make Table query based on the previous table.  This will remove any extraneous data fields and allow the user to rename fields if necessary.  Export as dbfIV file for table joins to SSURGO coverage.

3. Complete this step if using Non-SSURGO data with MUIR database. If using NASIS data, skip this step.

a. Tables used for query include: (1) mapunit; (2) component and (3) chorizon

b. Items mapunit_symbol or Mapunit name may be used for join relationships in ArcView

c. Construct query using tables to include the following items; (1) muid, (2) mapunit_symbol; (3) mapunit_name; (4) component_percent_r (component).  Note: compenent_percent_r is found in component table.

4. “Join” query.dbf to soils coverage based on common item name.  For example SSURGO data utilizes the item muid for join relationships. Non-SSURGO data may use mapunit_sysmbol or Mapunit_name.  

a. If using ArcView with Spatial Analyst, do the following:

i. Open the query.dbf and the soils tables to join.

ii. Make the source table active (soils).

iii. Click the name of the common item for the join.

iv. Make the destination table (query.dbf) active.

v. Click the name of the common item for the join.

vi. From the Table menu choose “Join”, or click the Join button.

vii. “Convert to grid theme” based on sieve items in soils table join.

b. If using ArcView with Spatial Analyst, do the following:

i. Click on the theme (soils with query.dbf) to convert to grid theme.

ii. From the Theme menu, choose "Convert to Grid”.

iii. In the Conversion Field dialog, choose an item in the feature theme that will be used to give values to the cells in the output grid theme.

Option 2 

Sieve values can be obtained from field data samples.  This data is not generally available.  

Cover

The vegetation cover factor is the percent vegetative cover (0-100%) for an area.

Option 1 

Use when an installation only has LCTA and no general GIS data layers.  Not likely to use this option since almost all installations with LCTA data have some GIS used for plot allocation. 

1. Use access LCTA program to run the erosion summary.  Get the most recent years data and save to a file with plotid, dmce, dmcn, aercov.  Also, LCTA point distributions may not be acceptable for adequate interpolation results.  If you do not have the ACCESS LCTA program, you can directly query a traditional LCTA database (see Appendix G).

2.  “Create a point layer” from LCTA coordinate data.

3. Interpolate C factor values between plot locations.  If using ArcView with Spatial Analyst, do the following:

4. Make points file the active map in the view.

5. From ArcView main menu, select Surface>Interpolate grid.  In the first interpolation dialog box set extent equal to the boundary map and cell size to a reasonable number based on input data.  In second interpolation dialog box set z value to the c factor values.  Try different interpolation options to produce a map that is most reasonable. 

6. Save data to file.  From ArcView main menu, select File>Export.  In Export dialog box select DBase format.

7. Convert layer from step 3 to a grid file.

Option 2 

Option 2 is for when an installation has LCTA data and some GIS data for extrapolation. Use when installation has standardized LCTA data and vegetation layer.

1. Use LCTA database to create an erosion summary.  Get the most recent years data and save to a DBbaseIV file with plotid, dmce, dmcn, cfactor.  If you do not have access to ACCESS LCTA program use the query found in Appendix G to get data from traditional LCTA database.

2. Acquire a generalized vegetation type layer (grass, shrub, forest) or create from more detailed vegetation layer.  

3. “Create a point layer” depicting LCTA plot locations from coordinate information contained in the database.

4. “Merge” LCTA layer with vegetation layer.  If using ArcView with Spatial Analyst, “Join” attributes tables based on the “Shape” item. 

5. Save the table to new file.  If using ArcView with Spatial Analyst, use the following steps:

6. Make the cover factor table active by selecting it.  

7. From ArcView main menu, select File>Export.

8. In the Export dialog box, select “dbase” as the format.

9. Calculate average cover value for each vegetation type.

10. Open dbase file from step 5 in MS Excel.  

11. From the Excel main menu select Data>Pivot table.  In first dialog box select “excel list” and “pivot table”. In second dialog box provide range of data by highlighting the data.  In third dialog box check new spreadsheet and press “layout” button.  In the layout dialog box drag box for vegetation classifications into left side of table and box for cover factor values into center of table.  Double click on the c factor box in the center of table and change to average. Select the “ok” button then the “finish” button.  This will create a table of average c factor values for each vegetation type.  Exact steps will vary with version of Excel.  Other software tools can be used to get the average values.

12. “Convert (vegetation layer) to grid theme”.

13. “Reclassify” the vegetation grid using average cover factor values.  If using ArcView with Spatial Analyst, do the following:

14. Make the new grid active.

15. From ArcView main menu, select Analysis>”Map calculator”.

16. Enter an equation like ((([veg]) = 1) * 13) + ((( [veg]) = 2) * 22)  where “veg” is the name of the vegetation grid, “1” and “2” are the identifiers for each vegetation class, and “13” and “22” are the average cover factor values for each  vegetation class calculated above.

Option 3 

Option 3 uses LCTA and RS data.  

Impact Factor

Option 1 

Option 1 uses subject matter experts (SME) to estimate the impact factor. Note Impact factor for dust erosion is different than for water erosion.  The impact factor for dust is in units of percent cover while water erosion is in units of C.

1. Ask installation expert (LCTA, LRAM or other personnel) to use personal experience to estimate what percent of vegetation cover is lost with a single pass of a tank.  Cover values range from 0 to 100.  Multiply 100 by percent vegetation lost to get the impact factor (ie 50% vegetation loss with one pass of a vehicle would be 0.50 * 100 = 50).

2. Impact estimates from step 1 are usually provided by vegetation type (grass, shrub, forest), but can by any site descriptor.   Find a spatial layer that identifies these areas or “Reclassify” another layer into these categories (i.e., vegetation layer into lifeform layer). 

3. “Reclassify” the descriptor values (grass, shrub, forest) with the impact values (ie 10, 50, 72).

Option 2 

Option 2 is similar to the subject matter experts (SME) approach of Option 1 except that impact study data is used instead of opinions to estimate the impact factor.

1. Ask installation personnel if they have had any vehicle impact studies conducted on their lands.  If yes, request copy of report.  In the report find out what percent of vegetation was lost with a single pass of a vehicle.  Only consider vegetative cover not the species composition.  Cover values range from 0 to 100.  Multiply 100 by percent vegetation lost to get the impact factor (ie  50% vegetation loss with one pass of a vehicle would be 0.50 * 100 = 50)

2. Impact estimates from step 1 are usually provided by vegetation type (grass, shrub, forest), but can by any site descriptor.   Find a spatial layer that identifies these areas or “Reclassify” another layer into these categories (i.e., vegetation layer into lifeform layer). 

3. “Reclassify” the descriptor values (grass, shrub, forest) with the impact values (ie 10, 50, 73).

Option 3 

Option 3 uses only LCTA data to estimate an impact factor.  
1. If installation has LCTA data, extract DMCE, DMCN, Plotid, % aerial cover, percent ground cover, and minimum drip height for each plot.  Once using only data points with single pass disturbance data and once with only data points with no disturbance.  This will result in two datasets.  Use the SQL queries found in Appendix G for calculating impact values from traditional LCTA databases.

2. Calculate Cover factor value for each plot in each data set

3. Subtract Cover factor value from disturbed data set from Cover factor value from undisturbed data set.  Only use plots that have both values. This is the deltaCover dataset.

4. Use the DMCE, DMCN, Plotid data to “add an XY event theme”.

5. Identify the vegetation type of each plot (usually a high level of vegetation classification like grass, shrub, forest).

6. Average the DeltaCover values for all plots in a vegetation type (grass, shrub, forest) 

7. “Convert to grid theme”.

8. “Reclassify” the vegetation grid using the average DeltaCover values.

Recovery Factor

Option 1 

Option 1 uses subject matter experts (SME) to estimate the recovery factor.  Note that the recovery estimate for water erosion and dust erosion may be the same data layer and can be reused.

1. Ask installation expert (LCTA, LRAM or other personnel) to use personal experience to estimate how long (in years) it takes a denuded site to be fully revegetated without LRAM investment.

2.  Recovery estimates from step 1 are usually provided by vegetation type (grass, shrub, forest), but can be by any site descriptor.   Find a spatial layer that identifies these areas or “Reclassify” another layer into these categories (i.e., vegetation layer into lifeform layer). 

3. “Reclassify” the descriptor values (grass, shrub, forest) with the impact values (ie 3, 6, 10).

Option 2 

Option 2 is similar to the subject matter experts (SME) approach of Option 1 except that recovery study data is used instead of opinions to estimate the recovery factor.  Note that the recovery estimate for water erosion and dust erosion may be the same data layer and can be reused.

1. Ask installation personnel if they have had any vehicle impact studies conducted on their lands.  If yes, ask if the studies were remeasured for recovery.  If yes, request copy of report.  In the report find out what percent of vegetation recovered in how many years.  Assume a linear rate of recovery and estimate total years of recovery.  

2. Recovery estimates from step 1 are usually provided by vegetation type (grass, shrub, forest), but can be by any site descriptor.   Find a spatial layer that identifies these areas or “Reclassify” another layer into these categories (i.e., vegetation layer into lifeform layer). 

3. “Reclassify” the descriptor values (grass, shrub, forest) with the impact values (ie 3, 6, 10).

T factor

Option 1 

T factor is an estimate of the maximum average annual rate of erosion by wind or water that a soil can sustain without loss of productivity.  T factor is one of six factors used in USLE/RUSLE to estimate average annual soil loss.  T factor is in Tons/acre/yr.  Estimates of T factor are based on soil properties including soil depth.  T factor values range from 1 to 5.  The higher the T value, the less susceptible the soil is to soil loss.

Option 1 uses the installations digitized soil survey map.

1. Obtain the soils coverage for the installation.  Use NRCS SSURGO soils coverage and NASIS database if available. Information in NASIS is basically the same information that can be obtained from a typical NRCS soil survey report (see figure below for example soil survey report table for Physical and Chemical Properties).  For information regarding NRCS/NASIS data and availability, contact George Teachman at: George.Teachman@daapgea050.apgea.army.mil.  Figure below shows data as typically found in an NRCS soil survey manual.

a. Convert NASIS database from Access 2000 to alternate Access software version if required for Access software/database compatibility.   On 2000 platform conversion is accomplished by:

i. Open database.  

ii. Choose tools 

iii. database utilities

iv. convert database.
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Example NRCS soil survey manual of physical and chemical properties that contains T factor values by soil type.
2. Complete this step if using NASIS data.  Query NASIS database for T factor (Note that this database also contains K factor values, see section above on K factor map layer development.  For more efficient use of the NASIS data, the user may opt to extract T factor data at the same time K factor data) based on the soils data used for analysis.  If NASIS data is not available skip to step 3.

a. Open query in design view.

b. Add “mapunit”, “component”, and “chorizon” tables.

c. Add the following fields: (1) mapunit_symbol (mapunit); (2) mapunit_name (mapunit); (3) t_factor (component); (4) componenet_name (component); (5) componet_percent_r (component); (6) horizon_depth_to_top (chorizon).

d. Show all fields.

e. Sort by “mapunit_symbol”.

f. Enter the value of  “0” for the field criteria “horizon_depth_to_top”. 

g. Run the query that will result in a new table.  

h. View table.  

i. Save table and query.

j. The resulting table from step 3 provides T factor values for all soils type and component series at a soil depth of 0 (the soil surface).  At this time several T factor values may exist for duplicate soil symbols.  This occurs due to multiple soils component types for a single soil symbol.  It may be necessary to manually edit the table to delete multiple T factor values. The criteria for table edits can be based on the “percent_component” field which provides the representative percent of the soil component.  Choose the larger mapunit_symbol soils component percent for a representative T factor value.  In the case where the “percent_component” values are the same use the limiting T factor values that represent the most erosivity (i.e. the higher the T factor value, the greater the erosivity).  Alternatively, an average value can be used for duplicative T values for multiple soils component types.  It is necessary to manually edit each duplicate mapunit_symbol value based on these criteria.  The table editing process should only take a few minutes, due to the relatively small number of duplicate mapunit_symbol values.  

k. Once the table has been edited, save the table and close.  At this time the user can create a new Make Table query based on the previous table.  This will remove any extraneous data fields and allow the user to rename fields if necessary.  Export as dbfIV file for table joins to SSURGO coverage.

3. Complete this step if using Non-SSURGO data with MUIR database. If using NASIS data, skip this step.

a. Tables used for query include: (1) mapunit; (2) component and (3) t_factor (component).

b. The table items “mapunit_symbol” or “Mapunit name” may be used for “Join” relationships in ArcView

c. Construct query using tables to include the following items; (1) muid, (2) mapunit_symbol; (3) mapunit_name; and (4) t_factor.

4. “Join” query.dbf to soils coverage based on common item name.  For example SSURGO data utilizes the item muid for join relationships. Non-SSURGO data may use mapunit_sysmbol or Mapunit_name.  

a. If using ArcView with Spatial Analyst, do the following:

i. Open the query.dbf and the soils tables to join.

ii. Make the source table active (soils).

iii. Click the name of the common item for the “Join”.
iv. Make the destination table (query.dbf) active.

v. Click the name of the common item for the “Join”.
vi. From the Table menu choose “Join”, or click the “Join” button.

vii. “Convert to grid theme” based on T factor items in soils table join.

b. If using ArcView with Spatial Analyst, do the following:

i. Click on the theme (soils with query.dbf) to “Convert to grid theme” theme.

ii. From the Theme menu, choose “Convert to grid theme”.
iii. In the Conversion Field dialog, choose an item in the feature theme that will be used to give values to the cells in the output grid theme.

Days Rain

Option 1 

Option 1 uses a probability map produced by the EPA. For further information on EPA dust models refer to Emission Factor Documentation for AP-42.

1. Acquire installation boundary layer in ArcInfo or ArcView format.

2. If necessary, convert shapefile data to ArcInfo format.

3. Consult EPA probability map for applicable value.  Usually use on value per installation.

a. The graphic shown in the figure was scanned from AP-42.
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Figure 13.2.2-1. Mean number of days with 0.01 inch or more of precipitation in United States.




Mean number of days with 0.01 inch or more of precipitation in United States (from Emission Factor Documentation for AP-42).

4. “Edit attribute table” for this layer by adding “probabilityvalue” item.

5. Populate all polygon feature records to the determined probability value in Step 2.

6. “Convert coverage to grid theme”.

Option 2 

Probability values can be determined from installation weather station data.  Generally this is a method of last resort.  Data acquisition, clean up, and quality control can be very time consuming.  Data quality issues can dramatically affect value estimates.  

5 Software Options and General ArcView Processing Procedures

ATTACC LCM Software Options

The following section lists the software options recommended for ATTACC Land Condition Module (LCM) data layer development and Land Condition Curve (LCC) processing.  The software is divided into required and optional sections, although any of the software options can be utilized.  Required software use focuses on ESRI’s ArcView software for data layer development, ATTACC LCM software ArcView extensions for LCC processing and Microsoft Access and Excel for data table query and manipulation.

Required Software

1. ESRI ArcView 3.x

ArcView 3.x is a desktop geographic information system (GIS) that is used to query, view and manipulate geospatial data for use in LCM data layer development.  The Spatial Analyst extension provided by ESRI, allows users to view, edit and analyze raster data.  This GIS platform is used most often by ITAM GIS user groups and provides comprehensive functionality for data development.  In addition, ArcView 3.x is the current GIS platform for ATTACC LCM and LS software for LCM data layer development and LCC processing.  Additional information regarding ArcView 3.x can be found at: http://www.esri.com/software/arcview/ or http://support.esri.com. 

ArcView applications used for the ATTACC LCM:

A. ATTACC LCM Software (Version 2.0)

The LCM software Version 2.0 is an ArcView GIS software application that estimates changes in land condition associated with mission activity. The LCM automates ATTACC methodology for generating land condition curves and is the primary software for the ATTACC LCM model. The POC for the LCM is Mr. George Teachman, U.S. Army Environmental Center (USAEC), ATTN:  SFIM-AEC-EQN, 5179 Hoadley Rd, Aberdeen Proving Ground, MD  21010-5401; 410-436-1593.  Additional information can be found at: http://army-itam.com/attacc/lcm/chapter1.html.

B. ATTACC LS Software

The LS factor software is an automated ArcView® GIS software application included within the ATTACC LCM Version 2.0 application that provides a quantitative representation of both the slope length and steepness and its relationship soil erosion rate.  This application is used as a primary option in the development of the LCM LS Factor data layer for LCC processing.   Additional information can be found at: http://army-itam.com/attacc/lcm/chapter1.html.

C. The Soil Data Viewer Version 2.0.1 (Optional)

The Soil Data Viewer is a Natural Resources Conservation Service (NRCS) extension to ArcView GIS software that allows the user to create and view soil-based thematic maps.  The Soil Data Viewer shields users and applications from the complexity of the soil database and incorporates rules for appropriate use of soil data.  It provides an easy to use tool for geospatial analysis of soil information for resource assessment and management.  This application is used as a secondary option in the development of the LCM T and K Factor data layer for LCC processing.  Additional information can be found at: http://itc.nrcs.usda.gov/soildataviwer.

2. Microsoft Access

Microsoft Access is database management software designed to query, analyze and edit tabular data.   Access provides utilities for importing and exporting databases, SQL query operations and database management functions. This application is used as a primary option in the development of the LCM T and K Factor data layers when NRCS soils database data are incorporated.  MS Access also provides a platform to execute Structured Query Language (SQL) queries with installation Land Condition Trend Analysis (LCTA) databases for developing the LCM C Factor, Impact Factor and Distribution data layers for LCM processing. Additional information regarding Microsoft products can be found at: http://www.microsoft.com/.

3. Microsoft Excel

Microsoft Excel is spreadsheet management software designed to analyze, edit and construct tabular data.  This application is used as a primary option in importing, exporting and editing tabular data as well as C Factor data layer calculations. Additional information regarding Microsoft products can be found at: http://www.microsoft.com/.
4. Internet Browsers

Various Internet browsers are available for access to the World Wide Web.  The ability to access web- based information is essential to direct acquisition of on-line help documents provided by software vendors and ATTACC POCs.  Examples of Internet browsers include Netscape and Internet Explorer.

Optional Software

1. ESRI ArcInfo (Desktop)

ArcInfo Desktop provides complete geoprocessing functionality utilizing a menu-driven interface.  ArcInfo Desktop includes all the functionality of ArcView and adds a complete set of data management, analysis, and conversion tools with the ArcToolbox application. With these tools, the user can perform data conversion, generalization, aggregation, overlays, buffer creation, statistical calculations, and numerous other functions. This software is used as an option to LCM ArcView data layer development procedures.  ArcInfo Desktop operates on Windows NT and Windows 2000. Additional information can be found at: http://www.esri.com/software/arcgis/arcinfo/index.html. 

2. ESRI ArcInfo (PC Workstation) 

ArcInfo Workstation provides complete geoprocessing functionality utilizing the classic user interface (ARC, ARCEDIT, ARCPLOT, ARC Macro Language [AML], and more).  In addition to providing an environment familiar to many ArcInfo users, the software includes fundamental and matchless geoprocessing functionality.  ArcInfo Workstation operates on Windows NT, Windows 2000, and several UNIX platforms. This software is used as an option to LCM ArcView data layer development.  Additional information can be found at: http://www.esri.com/software/arcgis/arcinfo/index.html. 

3. ERDAS IMAGINE 8.x

ERDAS IMAGINE is a map-based graphical tool for indexing, viewing, managing and analyzing remote sensing imagery data.  This software is used in the classification and management of remote sensing imagery for LCM data development.  Additional information can be found at http://www.erdas.com.

General ArcView Processing Procedures

This section summarizes ArcView GIS processing procedures applicable to development of ATTACC LCM data input layers.  

Adding an XY Event theme

This procedure enables the user to create a point theme with X and Y coordinates from an existing table containing XY coordinates.

XY event theme tables contain the exact position of features as XY coordinates, such as the location of LCTA plot locations or the points where soil samples have been taken.  XY coordinates can be obtained by reading a map, measuring positions on a view, field surveying, using a GPS (Global Positioning System) receiver, geocoding the table that contains address information, etc.   The XY coordinates can be in any coordinate system and units, such as longitude-latitude, or meters.
To Create a X Y Event Theme 

1. Add the table with X and Y coordinates in ArcView by clicking the “Add Table” button within the project window. If using a table containing X and Y coordinates from an existing theme (shapefile or coverage), click the theme in the project views Table of Contents to activate it and open the table by clicking the “Open Theme Table” button.

     Add Table

1.
Make the Project window active.

2.
From the Project menu, choose “Add Table”.

3.
From the File Type list, choose INFO, dBASE (.dbf), or Delimited Text (.txt).

4.
Navigate to the directory that contains the file you want to add.

5.
Double-click the file you want to add or choose the file and press OK.

ArcView adds the table to your project.

2. From the View menu choose “Add Event Theme”.  If this menu choice is dimmed out, you’ll need to add the table to your view first.

3.  Choose the “XY” button at the top of the dialog box.

4. In the Table list, select the table that contains the XY coordinates.  Choose the appropriate fields within the table containing the coordinate information.

5. Press OK.  ArcView adds a theme where each location in the table is represented by a point.

6. Convert to shapefile if necessary.  

Note: If the event theme is not converted to a shapefile, it will not be permanently saved.

Applying a Mask for Analysis

Both ArcInfo and ArcView allow the use of mask grids when conducting analysis.  The mask grid can be applied to mask out areas where analysis will not take place. 

To apply the mask when conducting analysis in the Grid module of ArcInfo, do the following:

1. Set the mask in the Grid environment by typing SETMASK <grid>.

2. Conduct any processing necessary.  For further details on SETMASK, consult the ArcInfo Help documentation.

To apply the mask when conducting analysis in ArcView using Spatial Analyst:

1. Add the analysis grid and mask to the View.

2. From the Analysis menu, choose Properties.

3. In the Properties dialog window, choose the analysis grid from the dropdown list.

Convert to Grid Theme 

Covert from Feature Theme to Grid Theme

To use ArcView to convert feature themes to grid themes:

1. Click on the feature themes you want to convert to grid themes.

2. From the Theme menu, choose “Convert to Grid”.

3. If the view's analysis properties haven't been set to a specific value, then you'll be prompted to set the extent and cell size for the output grid theme. Do so in the “Conversion Extent” dialog and press “OK”.

4. In the “Conversion Field” dialog, choose a field in the feature theme that will be used to give values to the cells in the output grid theme. Press “OK”.

5. Provide a name and directory for the output grid data set, then press “OK”. Grid data set names cannot be longer than 14 characters and cannot contain a "." or space.

6. If the conversion field was a string or integer field, then you can choose whether or not to add all the attributes of the feature theme to the table of the output grid theme.

7. Choose whether or not to add the new grid theme to the view.

8. If necessary, start over with step 2 for each feature theme activated.

Notes:

Any type of feature theme created form any type of source file can be converted to a grid theme. It doesn’t matter if the source data for a feature theme comes from a CAD drawing, ARC/INFO coverage, or shapefile; it can be converted to a grid theme. If you wish to convert a data base theme to a grid theme, you must first convert it to a shapefile with Convert to Shapefile in the Theme menu.

Only the selected features in a theme will be converted to the output grid theme. If the theme does not contain a selected set, then all features will be converted to the output grid theme.

When you convert polygons, cells are given the value of the polygon found at the center of each cell. When you convert lines, cells are given the value of the line that intersects each cell. Cells that are not intersected by a line are given the value of “No Data”. When you convert points, cells are given the value of the points found within each cell. Cells that don't contain a point are given the value of “No Data”. If more than one line or point is found in a cell, then the cell is arbitrarily given the value of one of the lines or points. If this is a problem, use a smaller cell size during conversion. If you have the Spatial Analyst then “Neighborhood Statistics” in the “Analysis” menu can be used to give you more control on which value is given to a cell.

You can convert feature themes using both string and numeric fields. If you use a string field, then each unique string in the feature theme is assigned a unique value in the output grid theme. A field named “S_Value” will be added to the table of the output grid theme to hold the original string value from the feature theme.

Covert from Image (Single Band) Theme to Grid Theme

To use ArcView to convert an image theme with a single band to a grid theme:

1. Activate the image themes that you want to convert to grid themes by clicking on them.

2. From the Theme menu, choose “Convert to Grid”.

3. Provide a name and directory for the output grid data set, then press “OK”. Grid data set names cannot be longer than 14 characters and cannot contain a "." or space.

4. Choose whether or not to add the new grid theme to the view.

Covert from Image (Multiple Band) Theme to Grid Theme

To use ArcView to convert an image theme with multiple bands to a grid theme:

1. Activate the image themes that you want to convert to grid themes by clicking on them.

2. From the Theme menu, choose “Convert to Grid”.

3. You are prompted if you want to convert all bands or not. If Yes then goto step 5. If No then continue to next step

4. Select the band you want to convert.

5. Provide a name and directory for the output grid data set, then press “OK”. This will be repeated for every band if you selected to convert all bands. Grid data set names cannot be longer than 14 characters and cannot contain a "." or space.

6. Choose whether or not to add the new grid theme to the view. This will be repeated for every band if you selected to convert all bands.

Notes:

Image themes created from image catalogs or grid data sets cannot be converted to grid themes. You also cannot convert an image theme whose data source has rotation parameters in its world file.

The conversion of image themes to grid themes is merely a change in file type. The output grid theme will have the same extent, cell size, and cell values as the original image theme. The analysis environment settings for the view are ignored.

If the image theme’s data source has a colormap, then this colormap is written to a file to be used with the new grid data set. The colormap is given the same name as the output grid data set, with a .clr file extension appended to it. If you add this grid data set to a view as an image theme, then this colormap file is used to display the data set.

Convert to Shapefile
This procedure is used to convert an active theme into an ArcView shapefile, building a spatial index and automatically adding the shapefile as a theme to your current view.  If features are selected in the theme when the conversion takes place, only the selected features will be converted.

1. Click on the name of the theme you want to convert to make it active. 

2. Choose “Convert to Shapefile” from the “Theme” menu.

3. In the dialog box that appears, specify a name and location to save the shapefile. Press “OK”.

4. You are then prompted to add the new shapefile to the view you are currently working on as a theme.

Dialog box options:
File Name - Type name of the shapefile you want to create.  If you type a file name and don't give a file name extension, ArcView will automatically add the extension .shp.

Drives - Select the drive on which you want to save the file.

Directories - Select the directory location where you want to save the file. Double click a directory in this box to see a list of sub-directories it contains.

Creating a New dBASE Table
This procedure creates a new table with user defined field properties, records and data.

1. Create a new table in your project

In the Project window, select the “Tables” icon and then press the “New” button.  Enter a name and a disk location for the dBASE file that ArcView will create to store the source data for the table.  A new table will appear in your project.  ArcView names new tables in numerical order: Table1, Table2, Table3, etc. 

2. Add fields to the table

On the “Table” menu bar, select the “Add Field” choice from the “Edit” menu.  The “Field Definition” dialog box will appear allowing you to define the field in the table.  

3. Add records to the table

On the “Table” menu bar, select the “Add Record” choice from the “Edit” menu.  This will add a single record to the table.  Repeat this action as many times as needed.

4. Add data to the table

On the “Table” tool bar, select the “Edit” tool.  This allows you to edit the empty cells in the table.  See the section entitled, “Editing the values in a table”.

NOTE:  Spaces, periods and other non-alphanumeric characters in file or directory names may cause problems.  Spaces and underscores are the only non-alphanumeric characters that should be used.  It is also recommended that you follow an 8.3 naming convention.

Editing the attribute table

Editing the values of a table

This procedure will allow the user to edit, and delete values in an existing table.  Only tables based on dBASE or INFO files on disk may be edited. 
1. Add table in ArcView by clicking on the “Add Table” button within the project window.  If editing a table from an existing theme (shapefile or coverage), click the theme in the project views Table of Contents to activate it and open the table by clicking the “Open Theme Table” button.

      Add Table

a. Make the Project window active.

b. From the Project menu, choose “Add Table”.

c. From the File Type list, choose INFO, dBASE (.dbf), or Delimited Text (.txt).

d. Navigate to the directory that contains the file you want to add.

e. Double-click the file you want to add or choose the file and press “OK”.
2. From the “Table” menu, Choose “Start Editing”.

3. Select the “Edit” tool and place the cursor in the field of the record you want to edit. You can add or delete fields and records and edit the values in the table by typing directly into the filed or table cell. When using the “Edit” tool in the table, the following keyboard accelerators are supported for the editable cell:

TAB   Moves to the cell to the right

SHIFT-TAB   Moves to the cell to the left

RETURN   Moves down a cell

SHIFT-RETURN   Moves up a cell

To finish editing and commit your changes, choose “Stop Editing” from the “Table” menu.

Note: You cannot edit tables whose source data is a delimited text file or the result of a SQL query to a database.  To edit data in these tables you should first export them to dBASE or INFO format and then add them back into your project.  You can only edit the values of fields in the destination table if the active table is composed of one or more joined tables.  

Overview of Editing a Table:

If you have write access to the source data for your table, and if the source data is in INFO or dBase format, you can perform numerous editing tasks on the table in ArcView. 

1.    To make a table editable:  

Choose “Start Editing” from the Table’s “Table” menu.  The names of fields in the table that you can edit appear in normal font.  The fields that you cannot edit are shown in italics.

2.    To undo and redo edits

Choose “Undo Edit” from the “Edit” menu to undo the last edit to the table.  Choosing this option repeatedly enables you to successively undo all the edits you made to the table since you started editing.  This option does not undo the addition or deletion of a field.  The “Redo Edit” option allows you to re-apply the last edit that was undone.  Choosing this option repeatedly enables you to successively redo all the edits you undid since you started editing.
3.    To save edits and continue editing

Choose “Save Edits” from the “Table” menu to save all edits made to the table during the current edit session. Once you save the edits, you can continue to edit the table but you are not able to undo or redo any edits that were made prior to choosing “Save Edits”.

4. To save your edits out to a new table

Choose “Save Edits As” from the “Table” menu to save your edits out to a new file rather than changing the original file.  The edited version of the original table will be written out to the new dBase file, editing will be disabled on the original table, and the edits will not be written to the original file.  The new file will be opened as a new table and editing will be started on the new table automatically.

5. To stop editing and commit your edits

Choose “Stop Editing” from the “Table” menu to disable editing on the table.  You will be prompted to save your edits.

Exporting Tables
The “Export Table” dialog box exports the active table to a file.  If any records have been selected, only these records will be exported.  Fields that have been hidden are not exported. 

1. Add table in ArcView by clicking on the “Add Table” button within the project window.  If exporting a table from an existing theme (shapefile or coverage), click the theme in the project views Table of Contents to activate it and open the table by clicking the “Open Theme Table” button.

Add Table

a.
Make the Project window active.

b.
From the “Project” menu, choose “Add Table”.

c.
From the File Type list, choose INFO, dBASE (.dbf), or Delimited Text (.txt)

d.
Navigate to the directory that contains the file you want to add.

e.    Double-click the file you want to add or choose the file and press “OK”.

2. From the File menu, choose “Export”.

3. In the “Export Table” dialog box, choose the type of file to export.

4. In the new dialog box, navigate to where you want to write the file.

5. Type the name of the file to save in the “File Name” field.

6. Click “OK” or press RETURN.
Dialog box options for export type:

dBASE -  dBASE format (*.dbf).

INFO - INFO database files.

Delimited text - Text files with fields separated by commas (*.txt).

Note: INFO files will be saved to a directory as a numbered pair of files (for example, arc0001.dat and arc0001.nit).  Another pair of files will be created that the INFO database requires called arc.dir and arc.nsp.  These files are created only once for a given directory. In order to use INFO files exported from ArcView in ARC/INFO, users should name the directory that the files are written to "info".

Join

You can join a table to the active table based on the values of a common field found in both tables. Join establishes a one-to-one or many-to-one relationship between the destination table (the active table) and the source table (the table you are joining into the active table). Typically, the source table contains descriptive attributes of features that you wish to join into a theme's table so that you can symbolize, label, query and analyze the features in the theme using the data from your source table.

Tables are joined based on a field that is found in both tables. The name of the field does not have to be the same in both tables, but the data type has to be the same. You can join numbers to numbers, strings to strings, booleans to booleans and dates to dates.

To join two tables:

1. Open the tables you wish to join.

2. Make the source table active.

3. Click the name of the common field you wish to use.

4. Make the destination table active.

5. Click the name of the common field you wish to use.

6. From the “Table” menu choose “Join”, or click the “Join” button.

The table that is active when you choose “Join” is the destination table. The last table that was active is the source table.

If the “Join” option is dimmed out when trying to join tables:

The problem may be because the source table already contains a join. For example, if you join table A to table B and then try to join table B to table C, the join option will appear dimmed out. 

To see if your source table already contains a join, make it active and look at the “Remove All Joins” option in the Table menu. If “Remove All Joins” is not dimmed out, your source table does contain one or more joins.

To perform a join in this situation you can either choose “Remove All Joins” to remove any existing join(s) from your source table and then perform the join or export the source table into a new table, add that table into your project, then do the join. The latter option is more useful than the first because it ensures that all the data in your original table is joined to the destination table. 

The destination table (the table that is active when you choose “Join”) can contain existing joins.

“Join” will also be dimmed out if the data types of the fields that you are joining are different. For example, trying to join tables on an identification code field that is of type number in one table and of type string in another table. The string field is left justified while the number field is right justified. To resolve this issue, add a field to one of the tables that is of the appropriate type and use the calculator to add the identification codes from the original field.  Remember, joins are also not possible if the source table is in edit mode.

Editing joined data

When editing a joined table, you can only edit the fields in the destination table. Edits to the fields from source tables must be performed directly on those tables. You can then use Refresh from the Table menu to show the changes in the joined table.

How are joins saved?

When you save a project containing a join, ArcView saves the definition of the join rather than saving the joined data itself. The next time you open the project, ArcView rejoins any joined tables by reading their files from disk or re-executing the SQL queries they are based on. In this way, any changes to the source or destination tables that have taken place since they were last joined are automatically included in the project, and reflected in any views, tables, charts or layouts based on the joined data.

Because joining tables has no effect on their physical files on disk, you don't need to have write permission to files to be able to join them in ArcView. For example, if you are working with themes representing geographic data accessed across your network from a remote, read-only GIS database, you can still join your own data tables to these themes and work with your data spatially.

If you want to make a new table on disk to permanently store the joined data, you choose “Export” from the “Table” menu. You would do this, for example, if you wanted to use the table in another application.

To remove joined fields from a table you are working on, choose “Remove All Joins” from the “Table” menu.

Spatial joins

If you join two theme attribute tables together using their Shape field as the common field, ArcView automatically bases the join on the spatial relationship between the features in the two themes. 

Map Calculator
1. From the “Analysis” menu, choose “Map Calculator”.

2. The “Map Calculator” dialog aids in the creation of an expression that produces a new output grid theme. The expression can be based on a single grid theme or multiple grid themes.  To aid in the creation of the expression, there are five groups of inputs in the “Map Calculator” dialog.  The first is the layers scrolling list which identifies the available grid layers in the active view; the second, arithmetic operator buttons; the third, a keypad of numbers; the fourth, a group of relational and boolean operators; and the fifth, a series of mathematical functions.  A typical sample session follows.

3. Double-click on a layer from the “Layers” scrolling list.

4. Press one of the arithmetic operators (e.g., *, /, -, and +).

5. Press the appropriate numbers on the keypad to apply to the values of the input layer using the arithmetic operation.

6. Press another arithmetic operator.

7. Choose a second layer from the “Layers” scrolling list.

8. Choose a mathematical functional group from the dropdown list to the far right of the “Map Calculator” (e.g., Logarithms, Arithmetic, Trigonometric, or Power).

9. Choose one of the mathematical buttons that appears in the mathematical function group of buttons.

10. Repeat steps 6 - 9 until you've entered all components of the expression.  Press Evaluate.

As you make selections from the input scrolling list and buttons, an expression builds in the expression box in the “Map Calculator” dialog.  If you use the mouse to select from the input scrolling list and buttons, only valid expressions can be created in the expression box.  However, if you type directly into the expression box, you can create an invalid expression.  Once you make a choice from one of the input scrolling lists or press a button, the error checking is reinstated for the subsequent mouse choices.

The Map Calculator can create simple expressions with a single function or complex expressions with many operations and functions.  Mathematical operators apply a mathematical operation to the values in two or more input grid themes; mathematical functions apply a mathematical function to the values in a single input grid theme.  There are three groups of mathematical operators in the Map Calculator: Arithmetic, Boolean, and Relational.

Arithmetic Operators - The Arithmetic operators (*, /, -, +) allow for the addition, subtraction, multiplication, and division of two grid themes, or numbers, or combination of the two.

Boolean Operators - The Boolean operators (And, Not, Or, and Xor) use Boolean logic (TRUE or FALSE) on the input values. Output values of TRUE are written as 1 and FALSE as 0.

Relational Operators - The Relational operators (<, <=, <>, =, >, and >=) evaluate specific relational conditions. If the condition is TRUE, the output is assigned 1; if the condition is FALSE, the output is assigned 0.  In an avalanche study, a relational operator can be used to show the areas of highest avalanche risk by identifying all cells that are greater than 5,000 meters.

There are four subgroups of mathematical functions: Logarithms, Arithmetic, Trigonometric, and Powers.

Logarithm - The Logarithm functions perform exponential and logarithmic calculations on input grid themes and numbers.  The base e, base 10 and base 2 exponential capabilities and the natural log, base 10, and base 2 logarithmic capabilities are available.

Arithmetic - The “Abs” button takes the absolute value of the values in an input grid theme.  Two rounding functions, the “Ceil” and “Floor” buttons, convert decimal-point values into whole numbers.  The Int and “Float” buttons convert values from and to integer and floating-point values.  And, the “IsNull” button returns 1 if the values on the input theme are No Data, and 0 if they are not.

Trigonometric - Trigonometric functions perform various trigonometric calculations on the values in an input grid theme.  The sine, cosine, tangent, inverse sine, inverse cosine, and inverse tangent functions are available.

Power - The square root of the values on the input grid layer can be calculated, the square determined, or the values can be raised to a power.

To edit the expression of a grid theme

Activate the grid theme created from a previous map calculation.  From the Theme menu, choose “Edit Theme Expression”.  The Map Calculator dialog appears, with the current expression that created the grid theme displayed in the expression box.  To change any of the components of the expression, highlight the portion of the expression to change, press the delete key on the keyboard, and then type in the desired component.  To perform another expression, bring up a second Map Calculator dialog with Map Calculator in the Analysis menu.

The “Not” button before an operator evaluates the opposite of the operator.  The “Parenthesis” button allows you to force the sequence of the evaluations within an expression.  By default, the expression is evaluated from left to right.  However, with parentheses, the evaluation will first occur within the parenthesis and then go through the other criteria from left to right.

The output grid theme from Map Calculator is automatically named "Map Calculation" followed by a unique number.  The grid data set associated with the output theme is written to the project's working directory, with the name "calc" followed by a unique number.  Use Properties in the Theme menu to find out which data set is associated with which theme.  Use Properties in the Project menu to change the project's working directory.  The grid data set associated with the output theme is temporary and is deleted when the theme is deleted.  Use “Save Data Set” in the Theme menu or save the project to prevent the grid data set from being deleted when the theme is deleted.

For additional help on the individual dialog choices, see ArcView Help “Map Calculator (Dialog box)”

Merge

Use the Merge process in the ArcView GeoProcessing wizard when you want to create a new theme containing two or more adjacent themes of the same shapefile type. 

1. Select themes to merge: Choose two or more themes that are of the same geometry type. The Finish button will not be enabled until you have two or more themes of the same type selected. You can use the Control and Shift keys in conjunction with your mouse click to select more than one or a range of themes.

2. Use Fields from: Choose the theme that contains the attributes you want to use in the theme that will result from this merge operation. If each of the other chosen themes have the same fields, then all cells in the attribute table of the merged theme will be populated. If any of the other input themes have additional fields, that data will not be included. If any of the other input themes are missing the fields, then no data will be added to those fields for the features of the selected theme.

Note: The dropdown list of available themes will not be activated until two or more themes of the same shapefile type have been selected for merging. To select more than one theme, you need to hold down the Shift key.

3. Specify the output file: Browse for or enter the shapefile name that will be used to store the results of the merge operation.

Projection Utility

Load the extension from the Extensions dialog.

1. Select File > Extensions

Place a check mark next to the extension “Projection Utility Wizard”

2. Open a view.

3. From the view's File menu, choose ArcView Projection Utility.

Step 1: Navigate to and/or select the shapefile to project. Click Next.

Step 2: Choose the current coordinate system information for the shapefile.  Click Next.


    When asked if you want to save the new information to the shapefile, select Yes.

Step 3: Choose the new coordinate system information for the shapefile.  Click Next.

Step 4: Navigate to where the new shapefile will be saved.  Click Next.


    Verify the input and output information and click Finish.

Reclassify 
Reclass Category Cell Values

To use ArcView Spatial Analyst to reclassify cell values of a grid theme that represent categories:

1. Activate the categorical grid theme to reclassify.

2. From the Analysis menu, choose Reclassify.

3. Choose the field in the grid theme to classify in the Classification Field dropdown list.

4. To perform a one-to-one reclassification change the original values on the reclassification scrolling list (identified in the Old Values column) to the desired value in the New Value column. Any combination of ranges, lists, or single values can be used for the Old Values column. Separate ranges by a dash (-), lists by a comma (,). Edit an entry by clicking on it and typing in the new specification. The New Value can be only a single value or "No Data".

5. When the reclassification scrolling list is complete, press OK.

Notes:

Reclassify will always create an integer grid theme.

If you desire to assign unique, sequential values (starting with 1) to each of the categorical values, press the Unique button.

To add a new record to the reclassification scrolling list (both the Old and New Values being zero), press the Add button. The new record is added under the selected entry or at the end of the list if there is not a selected record. You can select a record by clicking on the column to the left of the Old Values column. To delete a record from the reclassification scrolling list, select the record and press the Delete button. When you delete a record, the cells with that value will retain their original values.

The Lookup button can be used to create a grid theme with values of one of the fields in the input grid theme. This can be used to create a grid theme of pH values from a grid theme of soil types that has pH as a field in its table.

A reclassification file can be loaded with the Load button or the existing reclassification specified in the reclassification scrolling list can be saved to a file with the Save button.

By pressing the Classify button, the classification method can be changed in the Type dropdown list, the number of classes in the Number of classes type-in box, and the precision of the output values from the Round values at dropdown list.

Reclassify Continuous Cell Values

To use ArcView Spatial Analyst to reclassify cell values of a grid theme representing a continuous variable:

1. Activate the continuous grid theme to reclassify.

2. From the Analysis menu, choose Reclassify.

3. Choose the field in the grid theme to classify in the Classification Field dropdown list.

4. By default the Old Values on the reclassification scrolling list are grouped into 9 equal interval classes. To reclassify the input continuous grid theme into more or fewer classes, press the Classify button or type in the desired ranges in the reclassification scrolling list. Separate ranges by a dash (-).

5. In the Classification dialog, choose the type of classification in the Type dropdown list. Specify the number of classes to reclassify the input values into, either by entering the value in the Number of classes type-in box or use the accompanying dropdown list. Identify the precision to use to break classes in the Round values at dropdown list. For more information on the classifications available with the Classification dialog.

6. When the reclassification scrolling list is complete, press OK.

Notes:

Reclassify will always create an integer grid theme.

To add a new record to the reclassification scrolling list (both the Old and New Values being zero), press the Add button. The new record is added under the selected entry or at the end of the list if there's no selected record. You can select a record by clicking on the column to the left of the Old Values column. To delete a record from the reclassification scrolling list, select the record and press the Delete button . When you delete a record, the cells with that value will retain their original values.

A reclassification file can be loaded with the Load button or the existing reclassification specified in the reclassification scrolling list can be saved to a file with the Save button.

Reclass Null Cell Values

To use ArcView Spatial Analyst to reclassify the null or No Data cell values of a grid theme

1. Activate the grid theme with the No Data values to reclassify.

2. From the Analysis menu, choose Reclassify.

3. Choose the field in the grid theme to classify in the Classification Field dropdown list.

4. To change a value or values to No Data type in "No Data" in the New Values column for those values you wish to change. To change No Data to a value change the No Data record in the New Values column to the desired new value.

5. When the reclassification scrolling list is complete, press OK.

Notes:

Reclassify will always create an integer grid theme.

Union

Use the Union process in the ArcView GeoProcessing wizard when you want to produce a new theme containing the features and attributes of two polygon themes. 

1. Select input theme to union. Choose the theme you want to use as the input theme for the union operation. You will see the number of features in this theme displayed when you select it.

2. Select polygon overlay theme to union. Choose the theme you want to use as the overlay theme. You will see the number of features in this theme displayed once you select it.

3. Specify the output file: Browse for or enter the file name that will be used to store the results of the union operation.
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Appendix A:
RSC LCM Data Directory Structure
This section documents the Western Regional Support Center (WRSC) Land Condition Module (LCM) directory structure for archiving ATTACC related ITAM spatial datasets. 

	Directory Structure Level
	Contents

	1st
	2nd
	3rd
	4th
	5th
	

	Doc
	
	
	
	
	Input grid processing procedures and other documentation

	Final
	
	
	
	
	LCM input data/grids and curve output results

	
	Data
	
	
	
	Final coverages/grids for input grid generation

	
	Input
	
	
	
	

	
	
	Basic
	
	
	

	
	
	
	Boundary
	
	

	
	
	
	Distrib
	
	

	
	
	
	
	Opt1
	

	
	
	
	
	Opt2
	

	
	
	
	
	Opt3
	

	
	
	
	Restrict
	
	

	
	
	
	TrngArea
	
	

	
	
	Water Erosion
	
	

	
	
	
	CFactor
	
	

	
	
	
	KFactor
	
	

	
	
	
	Impact
	
	

	
	
	
	LSFactor
	
	

	
	
	
	RFactor
	
	

	
	
	
	Recovery
	
	

	
	
	
	TFactor
	
	

	
	
	Wind Erosion
	
	

	
	
	
	Kfact_W
	
	

	
	
	
	
	Option 1
	(default value)

	
	
	
	
	Option 2
	(field data)

	
	
	
	Cfact_W
	
	

	
	
	
	
	Option 1
	(c factor map)

	
	
	
	
	Option 3
	(installation weather data)

	
	
	
	Ifact_W
	
	

	
	
	
	
	Option 1
	(Soil survey)

	
	
	
	
	Option 2
	(Field data)

	
	
	
	Impact_W
	
	

	
	
	
	
	Option 1
	(default)

	
	
	
	
	Option 2
	(Impact studies)

	
	
	
	Irecov_W
	
	

	
	
	
	
	Option 1
	(none)

	
	
	
	
	Option 2
	(Impact studies)

	
	
	
	PlantH_W
	

	
	
	
	
	Option 1
	(LCTA only)

	
	
	
	PlantS_W
	

	
	
	
	
	Option 1
	(LCTA only)

	
	
	
	
	Option 2
	(LCTA and GIS)

	
	
	
	Foliag_W
	

	
	
	
	
	Option 1
	(SME)

	
	
	
	Canopy_W
	

	
	
	
	
	Option 1
	(SME)

	
	
	
	VegType_W
	

	
	
	
	
	Option 1
	(default values)

	
	
	
	DryWP_W
	

	
	
	
	
	Option 1
	(Soil survey)

	
	
	
	
	Option 2
	(Field data)

	
	
	
	SGEq_W
	

	
	
	
	
	Option 1
	(default value)

	
	
	
	
	Option 2
	(field data)

	
	
	
	Tfact_W
	
	

	
	
	
	
	
	

	
	
	
	VegIF_W
	

	
	
	
	
	Option 2 
	(Impact studies)

	
	
	
	VegRF_W
	

	
	
	
	
	Option 1
	(SME)

	
	
	
	
	Option 2
	(Impact studies)

	
	
	Dust Erosion
	
	

	
	
	
	Sieve_D
	
	

	
	
	
	
	Option 1 
	(Soil survey)

	
	
	
	
	Option 2
	(Field data)

	
	
	
	Cover_D
	
	

	
	
	
	
	Option 1
	(LCTA only)

	
	
	
	
	Option 2
	(LCTA and GIS)

	
	
	
	
	Option 3
	(LCTA and RS)

	
	
	
	ImpFac_D
	
	

	
	
	
	
	Option 1
	(SME)

	
	
	
	
	Option 2
	(Impact studies)

	
	
	
	
	Option 3
	(LCTA data)

	
	
	
	Recov_D
	
	

	
	
	
	
	Option 1
	(SME)

	
	
	
	
	Option 2
	(Impact studies)

	
	
	
	Tfact_D
	
	

	
	
	
	
	Option 1
	(Soil survey)

	
	
	
	DORain_D
	
	

	
	
	
	
	Option 1
	(probability map)

	
	
	
	
	Option 2
	(installation weather data)

	
	Output
	
	
	
	LCM curve output results

	Source
	
	
	
	
	Raw data for LCM grid generation- use subdirectories when applicable.  This data remains unchanged.)

	
	DEM
	
	
	
	

	
	LCTA
	
	
	
	

	
	Soils
	
	
	
	

	
	inst_data
	
	
	
	

	
	rsc_data
	
	
	
	

	
	ned_data
	
	
	
	

	
	other
	
	
	
	

	Work
	
	
	
	
	Workspace for editing and preparing data for LCM input grids


Appendix B:
RSC Data Quality Assessment and Preparation
1. Take all raw shapefiles from the installation and move them into the SOURCE directory.

2. In an orderly fashion, begin moving applicable raw source data to the WORK directory.  Here the data will be converted, projected, edited and prepared for LCM input grid creation.  Move over one layer at a time and work on the layer individually.

3. In the WORK directory, “Convert all shapefiles to coverages”.  The methodology used will depend upon the feature present in the shapefile (3 options).

a. Use ArcTool Box (ArcGIS Desktop) for all feature types (arc, point, and polygon)

i. Conversion Tools > Import to Coverage > Shapefile to Coverage

b. ArcInfo command line, for point and arc shapefiles 

i. Arc: shapearcroads roads1

ii. Arc: build roads1 line

c. ArcInfo command line, for polygons (if this method is not followed, the attribute table will be dropped)

4. Set the coordinate PRECISION to double double

a. Usage: PRECISION <SINGLE | DOUBLE> {HIGHEST | LOWEST | SINGLE | DOUBLE}

b. Arc: precision double double

c. Shapefiles store feature coordinates as double-precision floating point numbers. You should create a double-precision coverage from the shapefile so maximum detail and coordinate accuracy will be maintained.

5. Run the SHAPEARC command and specify an out_subclass.

a. Usage: SHAPEARC <in_shape_file> <out_cover> {out_subclass} {DEFAULT | DEFINE}

b. Arc: shapearc bndry27.shp tempcov temp

c. Because polygon shapefiles allow for non-planar or overlapping features, it is necessary you create a region subclass {out_subclass} in the output coverage. While the input shapefile may or may not have overlapping features, “Converting the shapefile to a coverage” with a region subclass will accommodate both situations and maintain all of the attributes in the region subclass attribute table.

6. Run CLEAN on the coverage to create polygon topology. Specify appropriate dangle and fuzzy tolerances.

a. Usage: CLEAN <in_cover> {out_cover} {dangle_length} {fuzzy_tolerance} {POLY | LINE}

b. Arc: clean tempcov cleanedcov # .1 poly

c. It is necessary you clean the coverage to create proper polygon and region topology. Prior to executing CLEAN, the new coverage will not have a polygon feature class and will only have preliminary region topology.

7. Execute REGIONPOLY to convert the region subclass to a polygon feature class with attributes. You must use the out_table option when the input shapefile contains overlapping features. This option creates an INFO file which lists the relationship between each polygon and the regions which it is part of. When a polygon belongs to two or more region features, the output polygons in the coverage created by REGIONPOLY will have the attributes of the associated region feature with the lowest internal number. The attributes of the other overlapping features are not maintained. To avoid this problem, edit the original shapefile, or the coverage resulting from Step C, to eliminate overlapping features. If overlaps do exist and you want to maintain them, do not perform REGIONPOLY.

a. Usage: REGIONPOLY <in_cover> <out_cover> <in_subclass> {out_table}

b. Arc: regionpoly cleanedcov bndry27 temp junk.dat

c. warning -  The REGIONPOLY command will only create labels in the output coverage if you use the out_table option. Use CREATELABELS, followed by BUILD for polygons to ensure proper attribute maintenance.

d. Arc: createlabels

e. Usage: CREATELABELS <cover> {id_base}

f. Arc: createlabels bndry27 0

g. Using an id_base of 0 will cause the creation of new labels for all polygons.  In this case, each User-ID will equal the polygon’s internal number minus one.  This is the default value.

h. Arc: build bndry27 line

i. Arc: build bndry27 poly

8. Poly Shapearc Process Summary:

a. Arc: precision double double

b. Arc: shapearc bndry27.shp tempcov temp

c. Arc: clean tempcov cleanedcov # # poly

d. Arc: regionpoly cleanedcov bndry27 temp junk.dat

e. Arc: createlabels bndry27 0

f. Arc: build bndry27 line

g. Arc: build bndry27 poly

9. Define the projection of the new coverages.  The below example assumes the original projection is UTM, NAD27 and that the projection has not been defined.

a. Arc: projectdefine

b. Usage: PROJECTDEFINE <COVER | GRID | FILE | TIN> <target>

c. Arc: projectdefine cover bndry27

d. Define Projection

e. Project: projection utm

f. Project: units meters

g. Project: datum nad27

h. Project: zone 18

i. Project: parameters

j. Arc: 

10. Re-project the coverages to datum NAD83.

a. Arc: project

b. Usage: PROJECT <COVER | GRID | FILE> <input> <output> {projection_file} {NEAREST | BILINEAR | CUBIC} {out_cellsize}

c. Arc: project cover bndry27 bndry83

d. *****************************************    

*     The INPUT projection has been defined      *

*********************************************

Use OUTPUT to define the output projection and END to finish.   

Project: output   

Project: projection utm   

Prject: units meters   

Project: datum nad83   

Project: zone 18   

Project: parameters    

Project: end

11. Review the newly projected data in ArcView and look for data inconsistencies, table completeness, etc.

12. If data needs editing, use ArcEdit to complete the necessary changes.

13. When data is complete and ready for final input grid creation, move a copy of the data layer to the FINAL>DATA directory.  This directory is only used to house final coverages and grids that will be used for LCM grid generation.

14. Once final copy is moved to FINAL>DATA, kill or delete all related data in WORK.

15. Continue with the above steps until all applicable data required for LCM input grids are in the FINAL>DATA directory.

16. Processing of the LCM input grids should also be done in the WORK directory.  Once each LCM input grid is complete, it should be moved from WORK to FINAL>INPUT><XX> and all temporary processing files killed or deleted.

Appendix C:
Data Requirements Tree for Implementing ATTACC LCM v.2.0This appendix includes the ATTACC LCM Data Tree to help installations understand what data is required to implement the different land conditions included in the ATTACC LCM v.2.0.  The ATTACC LCM Data Tree was developed making the following assumptions: 

1. Basic data layers required for any LCM implementation.  Water, Wind, Dust data layers only required if installation opts to implement that measure of land condition.

2. Data layer names used are based on standard ITAM data layer naming conventions obtained from ATSC at the time this document was written.  Italics are used for specific map names.  Regular text is used for general names.

3. Depending on installation policies and data layer development, not all maps may be applicable or similar maps may be used.  For example, restricted areas.  Special interest areas may or may not be available for training.

4. The definition of LCTA data is any field data that is part of the ITAM program. Utility of data depends on what parameters are measured.

5. Options are generally listed from less spatially accurate to more spatially accurate.  Options generally listed from less data intensive to more data intensive.  Options generally listed from less computationally difficult to more computationally difficult. 

6. Basic format of outline is: 

a. Level 1: land condition measure

b. Level 2: Input data layer

c. Level 3: Data development option

d. Level 4: Data sources and processing (citations eventually for detailed processing guidance).

The following outline is the ATTACC LCM Data Tree.  The ATTACC LCM Data Tree lists installation data required to develop each ATTACC LCM input for each data development option.  The tree is intended to quickly identify data required for a development option so that the data developer can quickly assess if that data development option is appropriate for the available data.  

Data Requirements Tree For ATTACC LCM v.2.0

1. Basic Data

1.1. Boundary

1.1.1. Data source

1.1.1.1.  Installation boundary map

1.1.2. Data processing

1.1.2.1.  “Convert to grid theme”

1.2. Training Areas

1.2.1. Data source

1.2.1.1.  Training area boundaries/sub boundaries map

1.2.2. Data processing

1.2.2.1.  Verify names to match RFMSS and AIM

1.2.2.2.  “Convert to grid theme”

1.3. Restricted Areas

1.3.1. Option 1 (Default) (No restricted areas, over estimates CC)

1.3.1.1.  Data source

1.3.1.1.1. Installation boundary map

1.3.1.2.  Data processing

1.3.1.2.1. “Convert to grid theme”

1.3.2. Option 2 (Restricted areas)

1.3.2.1. Data source

1.3.2.1.1. Secure/classified/off-limits sites map

1.3.2.1.2. Lakes/ponds map

1.3.2.1.3. Endangered species sites map

1.3.2.1.4. Archaeological/cultural sites map

1.3.2.1.5. Cemeteries map

1.3.2.1.6. Recreation areas map

1.3.2.1.7. Airfields/assault strips map

1.3.2.1.8. Impact areas, dudded w/buffer zones map

1.3.2.1.9. Impact areas, non duded w/buffer zones map

1.3.2.1.10. Cantonment Areas/Camps map

1.3.2.1.11. Special interest natural/recreation areas map

1.3.2.2. Data processing

1.3.2.2.1.  “Overlay restriction maps”

1.3.2.2.2.  “Convert to grid theme”
1.4. Distribution

1.4.1. Option 1 (Default) (Even distribution, over estimates CC)

1.4.1.1.  Data source

1.4.1.1.1. Installation boundary map

1.4.1.2.   Data processing

1.4.1.2.1. “Convert to grid theme”

1.4.2. Option 2 (SME)

1.4.2.1.  Data source

1.4.2.1.1. Subject matter expert 

1.4.2.1.2. Any GIS data required to delineate low, med, high use areas

1.4.2.2.   Data processing

1.4.2.2.1. Delineate low, med, high use areas

1.4.2.2.2. “Convert to grid theme”

1.4.3. Option 3 (LCTA only)

1.4.3.1.  Data source

1.4.3.1.1. LCTA data and plot locations (LCTA transect/plots map)

1.4.3.2.   Data processing

1.4.3.2.1. Spatially interpolate between LCTA disturbance data points.

1.4.4. Option 4 (LCTA/RS)

1.4.4.1.  Data source

1.4.4.1.1. LCTA data and plot locations (LCTA transect/plots map)

1.4.4.1.2. Satellite Imagery maps

1.4.4.2.   Data processing

1.4.4.2.1. Regress LCTA disturbance data with RS data

1.4.4.2.2. “Reclassify” RS imagery with regression results

1.4.5. Option 5 (LCTA/GIS/RS)

1.4.5.1.  Data source

1.4.5.1.1. LCTA data and plot locations (LCTA transect/plots map)

1.4.5.1.2. Distances from roads map (derived from Roads map)

1.4.5.1.3. Slope map

1.4.5.1.4. Vegetation cover map

1.4.5.1.5. Other similar maps

1.4.5.2.   Data processing

1.4.5.2.1. Regress LCTA disturbance data with GIS data

1.4.5.2.2. “Reclassify” GIS data with regression results

1.4.6. Option 6 (Vehicle tracking data)

1.4.6.1.  Data source

1.4.6.1.1. GPS vehicle tracking data

1.4.6.2.   Data processing

1.4.6.2.1. Convert tracking location data to number of passes per grid cell

2. Water Erosion Data

2.1. K Factor

2.1.1. Option 1 (Soil survey)

2.1.1.1.  Data source

2.1.1.1.1. Soils map

2.1.1.1.2. Soils attribute values (NRCS sources)

2.1.1.2.  Data processing

2.1.1.2.1. “Reclassify” soils map using K attribute values

2.1.1.2.2. “Convert to grid theme”

2.1.2. Option 2 (Field data)

2.1.2.1.  Data source

2.1.2.1.1. LCTA data and plot locations (LCTA transect/plots map)

2.1.2.1.2. Soils map (optional)

2.1.2.2.  Data processing

2.1.2.2.1. Using soil data calculate K factor for each plot

2.1.2.2.2. Create a K factor map by interpolating between K factor data points or reclassifying the soils map into K factor values

2.2. C Factor

2.2.1. Option 1 (Default values)

2.2.1.1.  Data sources

2.2.1.1.1. NRCS RUSLE manual

2.2.1.1.2. Vegetation cover map

2.2.1.2.  Data processing 

2.2.1.2.1. “Reclassify” vegetation map using default C factor values for each vegetation type

2.2.2. Option 2 (LCTA only)

2.2.2.1. Data sources

2.2.2.1.1. LCTA data and plot locations (LCTA transect/plots map)

2.2.2.2.  Data processing

2.2.2.2.1. Using LCTA data calculate C factor for each plot

2.2.2.2.2. Create a C factor map by interpolating between K factor data points

2.2.3. Option 3 (LCTA and GIS)

2.2.3.1.  Data sources

2.2.3.1.1. LCTA data and plot locations (LCTA transect/plots map)

2.2.3.1.2. Vegetation cover map (or similar type map)

2.2.3.2.  Data processing

2.2.3.2.1. Using LCTA data calculate C factor for each plot

2.2.3.2.2. “Reclassify” each vegetation type using the mean plot value

2.2.3.2.3. “Convert to grid theme”

2.2.4. Option 4 (LCTA and RS)

2.2.4.1. Data sources

2.2.4.1.1.  LCTA data and plot locations (LCTA transect/plots map)

2.2.4.1.2. Satellite Imagery map (or similar map)

2.2.4.2.  Data processing

2.2.4.2.1. Calculate C factor for each plot using LCTA veg data

2.2.4.2.2. Regress plot C values with imagery data

2.2.4.2.3. “Reclass” imagery data using regression equation developed

2.3. LS Factor

2.3.1. Option 1 (soil survey only)

2.3.1.1.  Data sources

2.3.1.1.1. Soils map (or Slope map optional)

2.3.1.2.  Data processing

2.3.1.2.1. Using represent slope values and slope length values calculate LS factor for each soil type.

2.3.1.2.2. “Reclass” soils map using representative LS value

2.3.1.2.3. “Convert to grid theme”

2.3.2. Option 2 (LCTA data)

2.3.2.1.  Data sources

2.3.2.1.1. LCTA data and plot locations (LCTA transect/plots map)

2.3.2.1.2. Soils map (optional)

2.3.2.2.  Data processing

2.3.2.2.1. Using LCTA slope and length data calculate LS for each plot

2.3.2.2.2. Create a LS factor map by interpolating between K factor data points or by reclassifying the soils map into K factor values

2.3.3. Option 3 (DEM)

2.3.3.1. Data sources

2.3.3.1.1. DEM map

2.3.3.2.  Data processing

2.3.3.2.1. Use LS software to calculate LS values for each cell in DEM

2.4. T Factor

2.4.1. Option 1 (Soil survey)

2.4.1.1. Data source

2.4.1.1.1. Soils map

2.4.1.1.2. Soils attribute values (NRCS sources)

2.4.1.2.  Data processing

2.4.1.2.1. “Reclassify” soils map using T attribute values

2.4.1.2.2. “Convert to grid theme”

2.5. R Factor

2.5.1. Option 1 (Isoerodent map)

2.5.1.1.  Data source

2.5.1.1.1. NRCS RUSLE manual

2.5.1.1.2. Installation boundary map

2.5.1.2.  Data processing

2.5.1.2.1. Look up R value from isoerodent map

2.5.1.2.2. “Reclassify” boundary map with R value

2.5.1.2.3. “Convert to grid theme”

2.5.2. Option 2 (City database)

2.5.2.1.  Data source

2.5.2.1.1. RUSLE software

2.5.2.1.2. Installation boundary map

2.5.2.2.  Data processing

2.5.2.2.1. Look up R value in RULSE software

2.5.2.2.2. “Reclassify” boundary map with R value

2.5.2.2.3. “Convert to grid theme”

2.5.3. Option 3 (NRCS state office)

2.5.3.1.  Data source

2.5.3.1.1. NRCS State office

2.5.3.1.2. Installation boundary map

2.5.3.2.  Data processing

2.5.3.2.1. Contact NRCS office and obtain R value

2.5.3.2.2. “Reclassify” boundary map with R value

2.5.3.2.3. “Convert to grid theme”

2.5.4. Option 4 (installation weather data)

2.5.4.1.  Data sources

2.5.4.1.1. Installation weather data

2.5.4.1.2. Installation boundary map (optional)

2.5.4.2.  Data processing

2.5.4.2.1. Using R factor equations calculate R from weather data

2.5.4.2.2. Create a R factor map by interpolating between R factor data points within the installation

2.5.4.2.3. “Convert to grid theme”
2.6. Impact Factor

2.6.1. Option 1 (SME)

2.6.1.1.  Data sources

2.6.1.1.1. Subject matter expert

2.6.1.1.2. Installation boundary map

2.6.1.1.3. Soils map (optional)

2.6.1.1.4. Vegetation cover map (optional)

2.6.1.2.  Data processing

2.6.1.2.1. Estimate change in C factor using expert opinion

2.6.1.2.2. Determine basis on which opinion can be extrapolated

2.6.1.2.3. “Reclassify” appropriate GIS map using expert values

2.6.1.2.3.1.  Installation boundary map if only one value

2.6.1.2.3.2.  Soils map if opinion based on soil type

2.6.1.2.3.3.  Vegetation cover map if opinion based on veg type

2.6.1.2.4. “Convert to grid theme”

2.6.2. Option 2 (Impact studies)

2.6.2.1.  Data sources

2.6.2.1.1. Impact study data

2.6.2.1.2. Installation boundary map

2.6.2.1.3. Soils map (optional)

2.6.2.1.4. Vegetation cover map (optional)

2.6.2.2.  Data processing

2.6.2.2.1. Estimate change in C factor using impact study data

2.6.2.2.2. Determine basis on which study data can be extrapolated

2.6.2.2.3. “Reclassify” appropriate GIS map using study data

2.6.2.2.3.1.  Installation boundary map if only one value

2.6.2.2.3.2.  Soils map if opinion based on soil type

2.6.2.2.3.3.  Vegetation cover map if opinion based on veg type

2.6.2.2.4. “Convert to grid theme”

2.6.3. Option 3 (LCTA data)

2.6.3.1.  Data sources

2.6.3.1.1. LCTA data and plot locations (LCTA transect/plots map)

2.6.3.1.2. Installation boundary map

2.6.3.1.3. Soils map (optional)

2.6.3.1.4. Vegetation cover map (optional)

2.6.3.2.  Data processing 

2.6.3.2.1. Estimate change in C factor using LCTA data for disturbed and undisturbed points

2.6.3.2.2. Determine basis on which LCTA data can be extrapolated

2.6.3.2.3. “Reclassify” appropriate GIS map using study data

2.6.3.2.3.1.  Installation boundary map if only one value

2.6.3.2.3.2.  Soils map if opinion based on soil type

2.6.3.2.3.3.  Vegetation cover map if opinion based on veg type

2.6.3.2.4. “Convert to grid theme”

2.7. Recovery Factor

2.7.1. Option 1 (SME)

2.7.1.1.  Data sources

2.7.1.1.1. Subject matter expert

2.7.1.1.2. Installation boundary map

2.7.1.1.3. Soils map (optional)

2.7.1.1.4. Vegetation cover map (optional)

2.7.1.2.  Data processing

2.7.1.2.1. Estimate recovery years using expert opinion

2.7.1.2.2. Determine basis on which opinion can be extrapolated

2.7.1.2.3. “Reclassify” appropriate GIS map using expert values

2.7.1.2.3.1.  Installation boundary map if only one value

2.7.1.2.3.2.  Soils map if opinion based on soil type

2.7.1.2.3.3.  Vegetation cover map if opinion based on vegetation type

2.7.1.2.3.4.  “Convert to grid theme”

2.7.2. Option 2 (Impact studies)

2.7.2.1.  Data sources

2.7.2.1.1. Impact study data

2.7.2.1.2. Installation boundary map

2.7.2.1.3. Soils map (optional)

2.7.2.1.4. Vegetation cover map (optional)

2.7.2.2.  Data processing

2.7.2.2.1. Estimate recovery years using impact study data

2.7.2.2.2. Determine basis on which study data can be extrapolated

2.7.2.2.3. “Reclassify” appropriate GIS map using study data

2.7.2.2.3.1.  Installation boundary map if only one value

2.7.2.2.3.2.  Soils map if opinion based on soil type

2.7.2.2.3.3.  Vegetation cover map if opinion based on veg type

2.7.2.2.4. “Convert to grid theme”

3. Wind Data

3.1. K Factor

3.1.1. Option 1 (default value)

3.1.1.1.  Data sources

3.1.1.1.1. Installation boundary map

3.1.1.2.  Data processing

3.1.1.2.1. “Reclassify” boundary map with a default K factor value of 1

3.1.1.2.2. “Convert to grid theme”

3.1.2. Option 2 (field data)

3.1.2.1.  Data sources

3.1.2.1.1. LCTA data and plot locations (LCTA transect/plots map)

3.1.2.1.2. Installation boundary map

3.1.2.1.3. Soils map

3.1.2.2.  Data processing

3.1.2.2.1. Estimate K factor using LCTA data for each plot

3.1.2.2.2. Extrapolate plot using appropriate GIS data layer

3.1.2.2.2.1.  Installation boundary map if single value for installation

3.1.2.2.2.2.  Soils map if unique value for each soil type

3.1.2.2.3. “Convert to grid theme”

3.2. C Factor

3.2.1. Option 1 (c factor map)

3.2.1.1.  Data source

3.2.1.1.1. NRCS C factor map

3.2.1.1.2. Installation boundary map

3.2.1.2.  Data processing

3.2.1.2.1. Look up C value from C factor map

3.2.1.2.2. “Reclassify” boundary map with C value

3.2.1.2.3. “Convert to grid theme”

3.2.2. Option 2 (NRCS state office)

3.2.2.1.  Data source

3.2.2.1.1. NRCS State office

3.2.2.1.2. Installation boundary map

3.2.2.2.  Data processing

3.2.2.2.1. Contact NRCS office and obtain C value

3.2.2.2.2. “Reclassify” boundary map with C value

3.2.2.2.3. “Convert to grid theme”

3.2.3. Option 3 (installation weather data)

3.2.3.1.  Data sources

3.2.3.1.1. Installation weather data

3.2.3.1.2. Installation boundary map (optional)

3.2.3.2.  Data processing

3.2.3.2.1. Using C factor equations calculate C from weather data

3.2.3.2.2. Create a C factor map by interpolating between C factor data points or reclassifying a soils or vegetation map into C factor values

3.2.3.2.3.  “Convert to grid theme”
3.3. I Factor

3.3.1. Option 1 (Soil survey)

3.3.1.1.  Data source

3.3.1.1.1. Soils map

3.3.1.1.2. Soils attribute values (NRCS sources)

3.3.1.2.  Data processing

3.3.1.2.1. “Reclassify” soils map using I attribute values

3.3.1.2.2. “Convert to grid theme”

3.3.2. Option 2 (Field data)

3.3.2.1.  Data source

3.3.2.1.1. LCTA data and plot locations (LCTA transect/plots map)

3.3.2.1.2. Soils map (optional)

3.3.2.2.  Data processing

3.3.2.2.1. Using soil data calculate I factor for each plot

3.3.2.2.2. Create a I factor map by interpolating between I factor data points or reclassifying the soils map into I factor values

3.4. I Impact

3.4.1. Option 1 (default)

3.4.1.1.  Data sources

3.4.1.1.1. Installation boundary map

3.4.1.2.  Data processing

3.4.1.2.1. “Reclassify” installation boundary with a default value of 0

3.4.2. Option 2 (Impact studies)

3.4.2.1.  Data sources

3.4.2.1.1. Impact study data

3.4.2.1.2. Installation boundary map

3.4.2.1.3. Soils map (optional)

3.4.2.2.  Data processing

3.4.2.2.1. Estimate change in I factor using impact study data

3.4.2.2.2. Determine basis on which study data can be extrapolated

3.4.2.2.3. “Reclassify” appropriate GIS map using study data

3.4.2.2.3.1.  Installation boundary map if only one value

3.4.2.2.3.2.  Soils map if opinion based on soil type

3.4.2.2.4. “Convert to grid theme”

3.5. I Recovery

3.5.1. Option 1 (SME)

3.5.1.1.  Data sources

3.5.1.1.1. Subject matter expert

3.5.1.1.2. Installation boundary map

3.5.1.1.3. Soils map (optional)

3.5.1.2.  Data processing

3.5.1.2.1. Estimate recovery years using expert opinion

3.5.1.2.2. Determine basis on which opinion can be extrapolated

3.5.1.2.3. “Reclassify” appropriate GIS map using expert values

3.5.1.2.3.1.  Installation boundary map if only one value

3.5.1.2.3.2.  Soils map if opinion based on soil type

3.5.1.2.3.3.  “Convert to grid theme”

3.5.2. Option 2 (Impact studies)

3.5.2.1.  Data sources

3.5.2.1.1. Impact study data

3.5.2.1.2. Installation boundary map

3.5.2.1.3. Soils map (optional)

3.5.2.2.  Data processing

3.5.2.2.1. Estimate recovery years using impact study data

3.5.2.2.2. Determine basis on which study data can be extrapolated

3.5.2.2.3. “Reclassify” appropriate GIS map using study data

3.5.2.2.3.1.  Installation boundary map if only one value

3.5.2.2.3.2.  Soils map if opinion based on soil type

3.5.2.2.4. “Convert to grid theme”

3.6. Plant Height

3.6.1. Option 1 (LCTA only)

3.6.1.1. Data sources

3.6.1.1.1. LCTA data and plot locations (LCTA transect/plots map)

3.6.1.2.  Data processing

3.6.1.2.1. Using LCTA data calculate average plant height for each plot

3.6.1.2.2. Create a plant height map by interpolating between plant height point data or reclassifying the vegetation map into plant height values 

3.6.2. Option 2 (LCTA and GIS)

3.6.2.1.  Data sources

3.6.2.1.1. LCTA data and plot locations (LCTA transect/plots map)

3.6.2.1.2. Vegetation cover map (or similar type map)

3.6.2.2.  Data processing

3.6.2.2.1. Using LCTA data calculate average plant height for each plot

3.6.2.2.2. “Reclassify” each vegetation type using the mean plot value

3.6.2.2.3. “Convert to grid theme”

3.7. Plant Spacing

3.7.1. Option 1 (LCTA only)

3.7.1.1. Data sources

3.7.1.1.1. LCTA data and plot locations (LCTA transect/plots map)

3.7.1.2.  Data processing

3.7.1.2.1. Using LCTA data calculate number plants for each plot

3.7.1.2.2. Create a plant number map by interpolating between plant number point data or reclassifying the vegetation map into plant number values 

3.7.2. Option 2 (LCTA and GIS)

3.7.2.1.  Data sources

3.7.2.1.1. LCTA data and plot locations (LCTA transect/plots map)

3.7.2.1.2. Vegetation cover map (or similar type map)

3.7.2.2.  Data processing

3.7.2.2.1. Using LCTA data calculate number plants for each plot

3.7.2.2.2. “Reclassify” each vegetation type using the mean plot value

3.7.2.2.3. “Convert to grid theme”

3.8. Foliage Density

3.8.1. Option 1 (SME)

3.8.1.1.  Data sources

3.8.1.1.1. Subject matter expert

3.8.1.1.2. Installation boundary map

3.8.1.1.3. Vegetation cover map (optional)

3.8.1.2.  Data processing

3.8.1.2.1. Estimate foliage density using expert opinion (SME, photos, or measurements)

3.8.1.2.2. Determine basis on which opinion can be extrapolated

3.8.1.2.3. “Reclassify” appropriate GIS map using expert values

3.8.1.2.3.1.  Installation boundary map if only one value

3.8.1.2.3.2.  Vegetation cover map if opinion based on veg type

3.8.1.2.4. “Convert to grid theme”

3.9. Canopy Width

3.9.1. Option 1 (SME)

3.9.1.1.  Data sources

3.9.1.1.1. Subject matter expert

3.9.1.1.2. Installation boundary map

3.9.1.1.3. Vegetation cover map (optional)

3.9.1.2.  Data processing

3.9.1.2.1. Estimate canopy width using expert opinion (SME, photos, or measurements)

3.9.1.2.2. Determine basis on which opinion can be extrapolated

3.9.1.2.3. “Reclassify” appropriate GIS map using expert values

3.9.1.2.3.1.  Installation boundary map if only one value

3.9.1.2.3.2.  Vegetation cover map if opinion based on veg type

3.9.1.2.4. “Convert to grid theme”

3.10. Vegetation Type

3.10.1. Option 1 (default value)

3.10.1.1.  Data sources

3.10.1.1.1. Installation boundary map

3.10.1.1.2. Vegetation cover map

3.10.1.2.  Data processing

3.10.1.2.1. “Reclassify” boundary map with a default value of 1 for evergreen vegetation, 0.875 for mixed vegetation, and 0.75 for deciduous vegetation

3.10.1.2.2. “Convert to grid theme”

3.11. Dry Wt Production

3.11.1. Option 1 (Soil survey)

3.11.1.1.  Data source

3.11.1.1.1. Soils map

3.11.1.1.2. Soils attribute values (NRCS sources)

3.11.1.2.  Data processing

3.11.1.2.1. “Reclassify” soils map using dry wt prod attribute values

3.11.1.2.2. “Convert to grid theme”

3.11.2. Option 2 (Field data)

3.11.2.1.  Data source

3.11.2.1.1. LCTA data and plot locations (LCTA transect/plots map)

3.11.2.1.2. Soils map (optional)

3.11.2.2.  Data processing

3.11.2.2.1. Using LCTA data calculate dry wt prod for each plot

3.11.2.2.2. Create a dry wt prod map by interpolating between dry wt prod point data or reclassifying the soils or vegetation map into dry wt prod values

3.12. Small Grain Equivalent

3.12.1. Option 1 (default value)

3.12.1.1.  Data sources

3.12.1.1.1. Installation boundary map

3.12.1.2.  Data processing

3.12.1.2.1. “Reclassify” boundary map with a default value of 4

3.12.1.2.2. “Convert to grid theme”

3.12.2. Option 2 (field data)

3.12.2.1.  Data sources

3.12.2.1.1. LCTA data and plot locations (LCTA transect/plots map)

3.12.2.1.2. Installation boundary map

3.12.2.1.3. Soils map

3.12.2.2.  Data processing

3.12.2.2.1. Estimate SGE using LCTA data for each plot

3.12.2.2.2. Extrapolate plot using appropriate GIS data layer

3.12.2.2.2.1.  Installation boundary map if single value for installation

3.12.2.2.2.2.  Soils map if unique value for each soil type

3.12.2.2.3. “Convert to grid theme”

3.13. T Factor

3.13.1.  Option 1 (Soil survey)

3.13.1.1. Data source

3.13.1.1.1. Soils map

3.13.1.1.2. Soils attribute values (NRCS sources)

3.13.1.2.  Data processing

3.13.1.2.1. “Reclassify” soils map using T attribute values

3.13.1.2.2. “Convert to grid theme”

3.14. Vegetation Impact Factor

3.14.1. Option 1 (SME)

3.14.1.1.  Data sources

3.14.1.1.1. Subject matter expert

3.14.1.1.2. Installation boundary map

3.14.1.1.3. Soils map (optional)

3.14.1.1.4. Vegetation cover map (optional)

3.14.1.2.  Data processing

3.14.1.2.1. Estimate change in vegetation using expert opinion

3.14.1.2.2. Determine basis on which opinion can be extrapolated

3.14.1.2.3. “Reclassify” appropriate GIS map using expert values

3.14.1.2.3.1.  Installation boundary map if only one value

3.14.1.2.3.2.  Soils map if opinion based on soil type

3.14.1.2.3.3.  Vegetation cover map if opinion based on veg type

3.14.1.2.4. “Convert to grid theme”

3.14.2. Option 2 (Impact studies)

3.14.2.1.  Data sources

3.14.2.1.1. Impact study data

3.14.2.1.2. Installation boundary map

3.14.2.1.3. Soils map (optional)

3.14.2.1.4. Vegetation cover map (optional)

3.14.2.2.  Data processing

3.14.2.2.1. Estimate change in vegetation using impact study data

3.14.2.2.2. Determine basis on which study data can be extrapolated

3.14.2.2.3. “Reclassify” appropriate GIS map using study data

3.14.2.2.3.1.  Installation boundary map if only one value

3.14.2.2.3.2.  Soils map if opinion based on soil type

3.14.2.2.3.3.  Vegetation cover map if opinion based on veg type

3.14.2.2.4. “Convert to grid theme”

3.15. Vegetation Recovery Factor

3.15.1. Option 1 (SME)

3.15.1.1.  Data sources

3.15.1.1.1. Subject matter expert

3.15.1.1.2. Installation boundary map

3.15.1.1.3. Soils map (optional)

3.15.1.1.4. Vegetation cover map (optional)

3.15.1.2.  Data processing

3.15.1.2.1. Estimate recovery years using expert opinion

3.15.1.2.2. Determine basis on which opinion can be extrapolated

3.15.1.2.3. “Reclassify” appropriate GIS map using expert values

3.15.1.2.3.1.  Installation boundary map if only one value

3.15.1.2.3.2.  Soils map if opinion based on soil type

3.15.1.2.3.3.  Vegetation cover map if opinion based on veg type

3.15.1.2.4. “Convert to grid theme”

3.15.2. Option 2 (Impact studies)

3.15.2.1.  Data sources

3.15.2.1.1. Impact study data

3.15.2.1.2. Installation boundary map

3.15.2.1.3. Soils map (optional)

3.15.2.1.4. Vegetation cover map (optional)

3.15.2.2.  Data processing

3.15.2.2.1. Estimate recovery years using impact study data

3.15.2.2.2. Determine basis on which study data can be extrapolated

3.15.2.2.3. “Reclassify” appropriate GIS map using study data

3.15.2.2.3.1.  Installation boundary map if only one value

3.15.2.2.3.2.  Soils map if opinion based on soil type

3.15.2.2.3.3.  Vegetation cover map if opinion based on veg type

3.15.2.2.4. “Convert to grid theme”

4. Dust Data

4.1. Sieve 200 

4.1.1. Option 1 (Soil survey)

4.1.1.1.  Data source

4.1.1.1.1. Soils map

4.1.1.1.2. Soils attribute values (NRCS sources)

4.1.1.2.  Data processing

4.1.1.2.1. “Reclassify” soils map using sieve attribute values

4.1.1.2.2. “Convert to grid theme”

4.1.2. Option 2 (Field data)

4.1.2.1.  Data source

4.1.2.1.1. LCTA data and plot locations (LCTA transect/plots map)

4.1.2.1.2. Soils map (optional)

4.1.2.2.  Data processing

4.1.2.2.1. Using LCTA data calculate sieve value for each plot

4.1.2.2.2. Create a sieve value map by interpolating between sieve value point data or reclassifying the soils map into dry sieve values

4.2. Cover

4.2.1. Option 1 (LCTA only)

4.2.1.1. Data sources

4.2.1.1.1. LCTA data and plot locations (LCTA transect/plots map)

4.2.1.2.  Data processing

4.2.1.2.1. Using LCTA data calculate percent cover for each plot

4.2.1.2.2. Create a percent cover map by interpolating between dry percent cover data or reclassifying the soils or vegetation map into percent cover values

4.2.2. Option 2 (LCTA and GIS)

4.2.2.1.  Data sources

4.2.2.1.1. LCTA data and plot locations (LCTA transect/plots map)

4.2.2.1.2. Vegetation cover map (or similar type map)

4.2.2.2.  Data processing

4.2.2.2.1. Using LCTA data calculate percent cover for each plot

4.2.2.2.2. “Reclassify” each vegetation type using the mean plot value

4.2.2.2.3. “Convert to grid theme”

4.2.3. Option 3 (LCTA and RS)

4.2.3.1. Data sources

4.2.3.1.1.  LCTA data and plot locations (LCTA transect/plots map)

4.2.3.1.2. Satellite Imagery map (or similar map)

4.2.3.2.  Data processing

4.2.3.2.1. Calculate percent cover for each plot using LCTA veg data

4.2.3.2.2. Regress plot cover values with imagery data

4.2.3.2.3. Reclass imagery data using regression equation developed

4.3. Impact Factor

4.3.1. Option 1 (SME)

4.3.1.1.  Data sources

4.3.1.1.1. Subject matter expert

4.3.1.1.2. Installation boundary map

4.3.1.1.3. Soils map (optional)

4.3.1.1.4. Vegetation cover map (optional)

4.3.1.2.  Data processing

4.3.1.2.1. Estimate change in cover using expert opinion

4.3.1.2.2. Determine basis on which opinion can be extrapolated

4.3.1.2.3. “Reclassify” appropriate GIS map using expert values

4.3.1.2.3.1.  Installation boundary map if only one value

4.3.1.2.3.2.  Soils map if opinion based on soil type

4.3.1.2.3.3.  Vegetation cover map if opinion based on veg type

4.3.1.2.4. “Covert to grid theme”

4.3.2. Option 2 (Impact studies)

4.3.2.1.  Data sources

4.3.2.1.1. Impact study data

4.3.2.1.2. Installation boundary map

4.3.2.1.3. Soils map (optional)

4.3.2.1.4. Vegetation cover map (optional)

4.3.2.2.  Data processing

4.3.2.2.1. Estimate change in cover using impact study data

4.3.2.2.2. Determine basis on which study data can be extrapolated

4.3.2.2.3. “Reclassify” appropriate GIS map using study data

4.3.2.2.3.1.  Installation boundary map if only one value

4.3.2.2.3.2.  Soils map if opinion based on soil type

4.3.2.2.3.3.  Vegetation cover map if opinion based on veg type

4.3.2.2.4. “Convert to grid theme”

4.3.3. Option 3 (LCTA data)

4.3.3.1.  Data sources

4.3.3.1.1. LCTA data and plot locations (LCTA transect/plots map)

4.3.3.1.2. Installation boundary map

4.3.3.1.3. Soils map (optional)

4.3.3.1.4. Vegetation cover map (optional)

4.3.3.2.  Data processing 

4.3.3.2.1. Estimate change in cover using LCTA data for disturbed and undisturbed points

4.3.3.2.2. Determine basis on which LCTA data can be extrapolated

4.3.3.2.3. “Reclassify” appropriate GIS map using study data

4.3.3.2.3.1.  Installation boundary map if only one value

4.3.3.2.3.2.  Soils map if opinion based on soil type

4.3.3.2.3.3.  Vegetation cover map if opinion based on veg type

4.3.3.2.4. “Convert to grid theme”

4.4. Recovery Factor

4.4.1. Option 1 (SME)

4.4.1.1.  Data sources

4.4.1.1.1. Subject matter expert

4.4.1.1.2. Installation boundary map

4.4.1.1.3. Soils map (optional)

4.4.1.1.4. Vegetation cover map (optional)

4.4.1.2.  Data processing

4.4.1.2.1. Estimate recovery years using expert opinion

4.4.1.2.2. Determine basis on which opinion can be extrapolated

4.4.1.2.3. “Reclassify” appropriate GIS map using expert values

4.4.1.2.3.1.  Installation boundary map if only one value

4.4.1.2.3.2.  Soils map if opinion based on soil type

4.4.1.2.3.3.  Vegetation cover map if opinion based on veg type

4.4.1.2.4. “Convert to grid theme”

4.4.2. Option 2 (Impact studies)

4.4.2.1.  Data sources

4.4.2.1.1. Impact study data

4.4.2.1.2. Installation boundary map

4.4.2.1.3. Soils map (optional)

4.4.2.1.4. Vegetation cover map (optional)

4.4.2.2.  Data processing

4.4.2.2.1. Estimate recovery years using impact study data

4.4.2.2.2. Determine basis on which study data can be extrapolated

4.4.2.2.3. “Reclassify” appropriate GIS map using study data

4.4.2.2.3.1.  Installation boundary map if only one value

4.4.2.2.3.2.  Soils map if opinion based on soil type

4.4.2.2.3.3.  Vegetation cover map if opinion based on veg type

4.4.2.2.4. “Convert to grid theme”

4.5. T factor

4.5.1. Option 1 (Soil survey)

4.5.1.1. Data source

4.5.1.1.1. Soils map

4.5.1.1.2. Soils attribute values (NRCS sources)

4.5.1.2.  Data processing

4.5.1.2.1. “Reclassify” soils map using T attribute values

4.5.1.2.2. “Convert to grid theme”

4.6. Days Rain

4.6.1. Option 1 (probability map)

4.6.1.1.  Data source

4.6.1.1.1. EPA manual

4.6.1.1.2. Installation boundary map

4.6.1.2.  Data processing

4.6.1.2.1. Look up value from EPA map

4.6.1.2.2. “Reclassify” boundary map with value

4.6.1.2.3. “Convert to grid theme”

4.6.2. Option 2 (installation weather data)

4.6.2.1.  Data sources

4.6.2.1.1. Installation weather data

4.6.2.1.2. Installation boundary map (optional)

4.6.2.2.  Data processing

4.6.2.2.1. Calculate probability of significant rain from weather data

4.6.2.2.2. Create a rainfall probability map by interpolating between rainfall probability point data or reclassifying the installation map into rainfall probability values

4.6.2.2.3. “Convert to grid theme”

The following outline summarizes the ATTACC LCM Data Tree.  The ATTACC LCM Data Tree is summarized by data useful for creating each class data.  This outline is useful for identifying types of data useful for implementing ATTACC LCM.

Overall Data List by Land Condition Measure 

1. Basic Data

1.1. Installation boundary map

1.2. Training area boundaries/sub boundaries map

1.3. Secure/classified off-limits sites map

1.4. Lakes/ponds map

1.5. Endangered species sites map

1.6. Archaeological/cultural sites map

1.7. Cemeteries map

1.8. Recreation areas map

1.9. Airfields/assault strips map

1.10. Impact areas, dudded w/buffer zones map

1.11. Impact areas, non duded w/buffer zones map

1.12. Cantonment Areas/Camps map

1.13. Special interest natural/recreation areas map

1.14. LCTA transect/plots map

1.15. Satellite Imagery maps

1.16. Roads map

1.17. Slope map

1.18. Vegetation cover map

2. Water Erosion

2.1. Soils map

2.2. LCTA transect/plots map

2.3. Vegetation cover map

2.4. Satellite Imagery map

2.5. DEM map

2.6. Installation boundary map

3. Wind Erosion

3.1. Installation boundary map

3.2. LCTA transect/plots map

3.3. Soils map

3.4. Vegetation cover map

4. Dust Erosion

4.1. Soils map

4.2. LCTA transect/plots map

4.3. Vegetation cover map

4.4. Satellite Imagery map

4.5. Installation boundary map

Appendix D:
ATTACC LCM Data Development Effort EstimatesThis appendix attempts to summarize typical installation data development requirements for implementing the ATTACC methodology.  Listed below are assumptions made in the analysis process.  Listed below are data development requirement times for each individual data element. Each data element is identified as being easy, intermediate, or difficult.  Time estimates are also provided.  Finally an overall data development time is estimated by groups of land condition measures typically implemented. 

This analysis in this appendix makes several assumptions.  These assumptions are listed below.  If the assumption is not valid, the potential consequences are provided.  

1. Qualified GIS/LCTA personnel

a. It is assumed that each installation has knowledgeable GIS and LCTA personnel that are familiar with the installations data.  Times assume that some time is required to understand the ATTACC methodology.

b. If this assumption is not correct, then additional time may be required to locate data, understand LCTA database structures, etc

2. GIS/LCTA is in a useable form

a. It is assumed that installation GIS and LCTA are in a useable format without the need for additional data cleanup, QAQC, etc.  

b. If installation data has not been used previously, this assumption is not correct.  However, these additional data development tasks are not specifically ATTACC related.  These additional activities will take additional time.

3. ATTACC is intended to use existing installation data

a. A requirement of ATTACC is to use existing installation GIS/LCTA and related data.  ATTACC was not intended to create additional data requirements for an installation beyond those already required to manage the installation.

b. Some installations may not have acquired as much data as a typical ITAM installation.  As such additional time may be required.

4. Installations have ATTACC implementation support

a. It is assumed that ITAM support mechanisms like the regional support centers are available to support installations implementing ATTACC.  

b. If these support mechanisms are not available, additional time may be required to understand the ATTACC methodology.

5. Time requirements represent first cut data development

a. There are several data development options for each data layer.  Some installations will be interested in trying alternative methods, improving upon their first attempts, or incorporating newly acquired data.  These activities have not been estimated.  Too much development is discouraged until all aspects of the ATTACC methodology have been developed.  Otherwise people involved with one aspect of the methodology develop beyond what the other groups are able to match.

b. If this assumption is invalid, additional time may be required.  The amount of time depends on the interest of the data developer.

The following effort estimates are for individual ATTACC LCM data layers and is structured after the ATTACC Data Requirements Tree.

1. Basic Data (1 ½ days total)

a. Boundary: Easy  (1 hour)

b. Training Areas: Easy (1 hour)

c. Restricted Areas: Easy (2 hour)

d. Distribution: Difficult (1 day)

2. Water Erosion Data (4 ½ days total)

a. K Factor: Easy (1 hour)

b. C Factor: Intermediate (1 day)

c. LS Factor: Intermediate (1 day)

d. T Factor: Easy (1 hour)

e. R Factor: Easy (1 hour)

f. Impact Factor: Intermediate (1 day)

g. Recovery Factor: Intermediate (1 day)

3. Wind Data (9 days total)

a. K Factor: Easy (1 hour)

b. C Factor: Easy (1 hour)

c. I Factor: Easy (1 hour)

d. I Impact: Difficult (1 day)

e. I Recovery: Difficult (1 day)

f. Plant Height: Difficult (1 day)

g. Plant Spacing: Difficult (1 day)

h. Foliage Density: Difficult (1 day)

i. Canopy Width: Difficult (1 day)

j. Vegetation Type: Easy (1 hour)

k. Dry Wt Production: Easy (1 hour)

l. Small Grain Equivalent: Easy (1 hour)

m. T Factor: Easy (1 hour)

n. Vegetation Impact Factor: Intermediate (1 day)

o. Vegetation Recovery Factor: Intermediate (1 day)

4. Dust Data (3 ½ days total)

a. Sieve 200: Easy (1 hour)

b. Cover: Intermediate (1 day)

c. Impact Factor: Intermediate (1 day)

d. Recovery Factor: Intermediate (1 day)

e. T factor: Easy (1 hour)

f. Days Rain: Easy (1 hour)

The following makes general average estimates of total effort required to develop data for individual land condition measures.  Summary estimates are based on typical data development options for individual data layers.

1. Water only: 1 week

2. Water and dust: 1 ½ week

3. Water, wind, and dust: 3 weeks

The following effort estimates are for tasks required to request and acquire data from the installation POC for transfer to the Regional Support Center (RSC).

1. Submit data acquisition and transfer request to installation POC. (1 hour)

2. Request SME data (recovery, impact and distribution) (1 hour)

3. Data transfer technical support (0.5 hours)

4. ftp data retrieval (0.5 hours)

5. Data review (QAQC) (2 hours)

6. Data editing if applicable (1-4+ hours)

7. Compile and process unavailable installation data if applicable (download from browser, obtain from contact entity or installation SME) ( 2-6+ hours)

8. Submit NRCS SSURGO/NASIS soils data request (0.5 hours)

9. Retrieve SSURGO/NASIS (0.5 hours)

10. Project all LCM installation data to ITAM standard (UTM, WGS84/NAD83, Zone, meters) (2 hours)

11. “Projectdefine” all final LCM Input grids to ITAM standard (2 hours)

12. Create FGDC metadata for all final LCM Input grids (3 hours)

Note: turn around time for installations regarding data acquisition, file transfer and SME correspondence may take additional time (~1 week total) 

Appendix E:
RSC Installation Data Request Letter or EmailThe following template serves as the foundation for contacting installation personnel by phone, letter, or email to initiate a request for installation data.  The letter can be modified as appropriate.

My name is <FirstName LastName> and I work for the Regional Support Center (RSC) at <Organization>.  The Army Environmental Center (AEC) on behalf of the Office of the Deputy Chief of Staff for Operations and Plans (ODCSOPS) has tasked the RSC to generate grid data for the purpose of completing Land Condition Module (LCM) curves for FORSCOM installations.  I am sending this email to request copies of GIS data layers that apply to the development of these grid-input layers.

I have provided an attached document entitled Data Requirements Tree that provides information regarding data and basic processing procedures.  Near the end of the document, the section entitled “Overall Data List by Land Condition Measure” provides a summarized list of data needed to create the eleven input grid layers necessary to develop LCM curves.  At this time, we are focusing our efforts on capturing basic and water erosion data only.   

Please send the most current and complete data.  To compliment the data, I am requesting that you provide a checklist of the data you are sending.  This checklist should include layer name, description, and projection information at a minimum. Also, it is crucial to verify that all training and restricted areas are updated and fully attributed.   In addition, provide metadata for each data layer when available.  

It will be up to you to identify what data on the list you do and do not have.  In some cases, some of the data on the list may not be available for your installation. 

Once the data has been compiled, transfer all data and documentation to the RSC.  The following list outlines the LCM data transfer requirements:

1. Send all coverages in EXPORT format only.  Do not send data in coverage format.

2. Include all metadata and or documentation.

3. Group data into distinct file type directories (i.e. shapes, export, image, grid, table, other).

4. Zip all directories from Step 4 into one file.

5. Post zip file on the RSC FTP site (<FTPAddress>). 

6. Send email to <FirstName> <LastName> RSC (<emailAddress>, <PhoneNumber>) notifying of the ftp transaction.

Appendix F:
National Map Unit Interpretation Records (MUIR) Database
The National Map Unit Interpretation Records (MUIR) database (http://www.statlab.iastate.edu/soils/muir/) may be used if NASIS data is not available.  For MUIR download site, use:

      http://www.statlab.iastate.edu/soils/muir/download.html.

Most MUIR data exists in the database as a range of soil properties, depicting the range for the soil survey area. Data is obtained from a combination of field observations, site descriptions and transects, and laboratory analyses.

MUIR data is a collection of soil and soil-related properties, interpretations, and performance data for a soil survey area and its map units, map unit components, and component layers. Information contained within the MUIR database have been reviewed and certified in accordance with National Cooperative Soil Survey data quality standards.

MUIR data contains about 88 estimated soil physical and chemical properties, interpretations, and performance data. These include available water capacity; soil reaction; soil erodibility factors (K, Kf, and T); hydric soil ratings; ponding, flooding, water table depth and duration; bedrock; interpretations for sanitary facilities, building site development, engineering, cropland, woodland, and recreational development; and yields for common crops, site indices of common trees, and potential production of rangeland plants.  The following table summarizes the MUIR information needed for ATTACC map layer development.  Use these table and column names when constructing queries for ATTACC.

MUIR Table and Column names for data typically used in ATTACC LCM.

	LCM Land

Measure
	LCM Input

Layer
	MUIR Table
	MUIR

Column

	Water, Wind, Dust
	T
	layer
	tfact        

	Water
	K
	layer
	kfact

	Dust
	Sieve200 (min, max)
	layer
	no200l       

no200h

	Wind
	I (group, index)
	layer
	wei 

weg

	Wind
	DryWtProd (favorable, normal, unfavorable)
	rsprod
	prodfav      

prodnorm     

produnfv     

	Water
	LS - Slope length
	not available in MUIR
	not available in MUIR

	Water
	LS – Slope (min, max)
	comp
	slopel

slopeh       


Appendix G:
LCTA Database Query Statements
The following MS Access SQL query statements can be used to access LCTA data required for ATTACC LCM input data development activities.  Several versions of each query are provided because traditional LCTA methods involve two types of data collection (short-term monitoring and long-term/inventory monitoring).  The user will need to know which year of data they are interested in accessing and the type of data collection used during that collection year.  Where possible, queries are provided that use both short and long-term data.

Each SQL query prompts the user for the desired year of data.  To use these example query statements, the user will need to modify this value to use with their data.  Each query accesses all plot data.  The user may need to delete certain plots if they are not applicable for use (i.e. special use, poor quality data, etc).  Discuss applicability of data with the LCTA coordinator to see if there are any use restrictions in place. To use only special use or core plots, the user will need to add or remove certain words like “CORE” from the query to make them applicable to your situation.  The queries have used values for plot types that are usually used for the specified application.  

These queries may not work with modified LCTAII type methodologies.  No specific queries can be provided for these methodologies since they all vary and the data storage structures have not been documented.  However knowledge of the LCTA methodologies, LCTA database format, and the following SQL queries can serve as a guide to how you should query your own database.

These queries will not handle all types of data quality errors correctly.  Versions of the LCTA data analysis software do more data checking than provided by these queries.  The user may use these software packages if they have concerns about their LCTA data quality.  These software packages provide similarly useful output for ATTACC LCM data development.  See software documentation for use of these software packages.

These queries were written and tested for MSAccess 2000.  While MSAccess 2000 is SQL compliant, there are slight variations in SQL usage between version of MSAccess and SQL databases provided by various vendors. If the user is using another database engine, they may need to modify the SQL statements for that software’s unique SQL implementation.  However the following SQL statements should provide a good start for what is required of the other software packages.

To use the following queries to access LCTA data, complete the following steps.  First, create a new query window without specifying any query items.  Second, change the query view to the SQL window format in the MSAccess main menu (“View”, “SQL View”).  Third, copy the following SQL statements into the SQL window of MSAccess and save to the appropriate name.  Some queries call other queries and the naming convention can be important.  Finally, execute the SQL statement from the MSAccess main menu (“Query”, “Run”).  The user will now see a table of results.

To save the data as a dbase file for use in ArcView complete the following steps. First, save the SQL query using the MSAccess main menu items “File” then “Save”. Then make the MSAccess database window active.  Select the “Query” objects list and then select the query that you just saved.  From the MSAccess main menu select “File” then “Export”.  In the export dialog box specify file name, dbase format, and a final directory location.  

The following SQL queries have also been provided in a sample LCTA database.  Queries can be copied from this sample database to appropriate database for analysis.  The sample database also allows you an environment to test and modify the queries as needed.  The sample database and queries are provided on the CD that came with this document.  The “ATTACC SOP 2000.mdb” file is a MS Access 2000 database.  The “ATTACC SOP 97.mdb” file is a MS Access 97 database.

The following SQL queries are arranged and listed by ATTACC LCM module (Basic, Wind, Water, Dust), and data layer (i.e. Cfactor, Kfactor, etc).  Within a data layer, queries are arranged by survey type (short vs long-term).  Within a survey type, queries are listed in call order.  Call order is the order in which one query calls a subquery.  You will execute the first query listed.  That query will then call the required subquries.  

A title associated with each query is the query name in the sample LCTA database provided with this document.  A table at the beginning of a set of queries defines the call order of the queries and subqueries.

Basic Data Input Layers

Disturbance Data Input Layer

The following table outlines the SQL query subquery structure.  Use top most query required for your data (i.e. combined, long-term or monitoring query).  The top most queries are located in the left most columns. The top most queries used will use proper subqueries.  Individual queries are listed below each table in a logical order.  Query titles match query titles in the sample database on the CD that came with this document.

	Pct Disturbance - All Inventory Types

	Pct Disturbance - Short Term Monitoring

	Pct Disturbance - Initial and Long Term Inventory


Combined Data

Title “Pct Disturbance - All Inventory Types”

SELECT

linemon.plotid, 

plotmast.dmce, 

plotmast.dmcn, 

(sum(iif(ucase([linemon.disturb]) in ('n'),1,0))/sum(iif(ucase(

[linemon.disturb]) in ('n','o','p','r','t','u'), 1, 0)) * 100) as [pctdist] 

FROM

linemon, 

plotmast, 

plotsurv 

WHERE

datepart('yyyy', linemon.recdate) =  [provide analysis year] and 

plotsurv.recdate = linemon.recdate and  

linemon.plotid=plotmast.plotid and 

plotmast.plotid=plotsurv.plotid and 

ucase(plotsurv.plottype in (CORE, 'C', 'SPECIAL', 'SPUSE', 'S')) 

GROUP BY

linemon.plotid, 

plotmast.dmce, 

plotmast.dmcn 

UNION

SELECT

gndcover.plotid, 

plotmast.dmce, 

plotmast.dmcn, 

(sum(iif(ucase([gndcover.disturb]) in ('n'),1,0))/sum(iif(ucase(

[gndcover.disturb]) in ('n','o','p','r','t','u'), 1, 0)) * 100) as [pctdist] 

FROM

gndcover, 

plotmast, 

plotsurv 

WHERE

datepart('yyyy', gndcover.recdate) =  [provide analysis year] and 

plotsurv.recdate = gndcover.recdate and  

gndcover.plotid=plotmast.plotid and 

plotmast.plotid=plotsurv.plotid and 

ucase(plotsurv.plottype in (CORE, 'C', 'SPECIAL', 'SPUSE', 'S')) 

GROUP BY

gndcover.plotid, 

plotmast.dmce, 


plotmast.dmcn 

ORDER BY

linemon.plotid; 

Short-term/Monitoring Data

Title “Pct Disturbance - Short Term Monitoring”
SELECT 

linemon.plotid, 

plotmast.dmce, 

plotmast.dmcn, 

(sum(iif(ucase([linemon.disturb])='n',1,0))/count(linemon.disturb)*100) 

       as [pctdist]

FROM 

linemon, 

plotmast, 

plotsurv

WHERE 

datepart('yyyy', linemon.recdate) = [provide analysis year] AND  

plotsurv.recdate = linemon.recdate AND  

linemon.plotid=plotmast.plotid AND  

plotmast.plotid=plotsurv.plotid AND  

ucase(plotsurv.plottype in (CORE, 'C', 'SPECIAL', 'SPUSE', 'S')) 

GROUP BY 

linemon.plotid, 

plotmast.dmce, 

plotmast.dmcn 

ORDER BY 

linemon.plotid;

Long-term/Inventory Data

Title “Pct Disturbance - Initial and Long Term Inventory”
SELECT

gndcover.plotid, 

plotmast.dmce, 

plotmast.dmcn, 

(sum(iif(ucase([gndcover.disturb])='n',1,0))/count(gndcover.disturb)*

       100) as [pctdist]

FROM

gndcover, 

plotmast,

plotsurv 

WHERE

datepart('yyyy',  gndcover.recdate) = [provide analysis year] and 

plotsurv.recdate = gndcover.recdate AND  gndcover.plotid=plotmast.plotid AND  

plotmast.plotid=plotsurv.plotid AND  

ucase(plotsurv.plottype in ('CORE', 'C', 'SPECIAL', 'SPUSE', 'S')) 

GROUP BY 

gndcover.plotid,

plotmast.dmce, 

plotmast.dmcn 

ORDER BY 

gndcover.plotid;

Water Erosion Input Layers

C Factor Data Layer

The following table outlines the SQL query subquery structure.  Use top most query required for your data (i.e. combined, long-term or monitoring query).  The top most queries are located in the left most columns. The top most queries used will use proper subqueries.  Individual queries are listed below each table in a logical order.  Query titles match query titles in the sample database on the CD that came with this document.

	C Factor Final - Combined Surveys

	
	C Factor Final - Initial and Long Term Inventory

	
	
	C Factor Inputs - Gnd Cover - Initial and Long Term Inventory

	
	
	
	C Factor Inputs - Aer Cover2 - Initial and Long Term Inventory

	
	
	
	
	C Factor Inputs - Aer Cover1 - Initial and Long Term Inventory

	
	
	C FACTOR INPUTS - AER COVER2 - INITIAL AND LONG TERM

INVENTORY

	
	C Factor Final - Short Term Monitoring

	
	
	C Factor Inputs – Short Term Monitoring


Combined Data

Title “C Factor Final – Combined Data”

SELECT 

PLOTID,

DMCE,

DMCN,

C

FROM 

[C Factor Final - Initial and Long Term Inventory]

UNION 

SELECT 

PLOTID,

DMCE,

DMCN,

C

FROM 

[C Factor Final - Short Term Monitoring]

ORDER BY 

1;

Short-term/Monitoring Data

Title “C Factor Final – Monitoring Data”

SELECT

PLOTID, 

DMCE, 

DMCN, 

PCTGND, 

PCTAER, 

MINDRPHT, 

EXP(4.574-(0.056*LOG(MINDRPHT))+(0.366*MINDRPHT))

AS HABDIV, 

(PCTAER-(PCTAER/100*PCTGND)) AS EFFCOV, 

(1-(EFFCOV/HABDIV)) AS C1, 

(0.449296-(0.015349*PCTGND)+(0.000316*(PCTGND^2))-

(0.000004019*(PCTGND^3))+(0.000000025981324*(PCTGND^4)) -(0.0000000000647784*(PCTGND^5))) AS C2, 

[C1]*[C2] AS C

FROM 

[C FACTOR INPUTS - SHORT TERM MONITORING];

Title “C Factor Inputs – Short Term Monitoring”

SELECT 

LINEMON.PLOTID, 

PLOTMAST.DMCE, 

PLOTMAST.DMCN, 

(SUM(IIF(UCASE([LINEMON.GNDCOV]) IN ( 'L', 'M', 'P', 'R', 'U'), 1, 0)) /

SUM(IIF(UCASE([LINEMON.GNDCOV]) IN ( 'B', 'L', 'M', 'P', 'R', 'U'),

1, 0)) * 100) AS PctGND, 

(SUM(IIF(UCASE([LINEMON.AERCOV]) IN ('A', 'P', 'AP', 'U'), 1, 0)) /

SUM(IIF(UCASE([LINEMON.AERCOV]) IN ('N', 'A', 'P', 'AP','U'), 1,

0)) * 100) AS PctAER, 

[Provide Minimum Drip Height (ft)] AS MinDrpHt

FROM 

LINEMON, 

PLOTMAST, 

PLOTSURV

WHERE 

DATEPART('YYYY', LINEMON.RECDATE) = 

[Provide Analysis Year] AND

PLOTSURV.RECDATE = LINEMON.RECDATE AND 

LINEMON.PLOTID=PLOTMAST.PLOTID AND

PLOTMAST.PLOTID=PLOTSURV.PLOTID AND

UCASE(PLOTSURV.PLOTTYPE IN ('CORE', 'C', 'SPECIAL', 

'SPUSE', 'S'))

GROUP BY 

LINEMON.PLOTID, 

PLOTMAST.DMCE, 

PLOTMAST.DMCN

ORDER BY 

LINEMON.PLOTID;

Long-term/Inventory Data

Title “C Factor Final – Initial and Long-Term Inventory”

SELECT 

GND.PLOTID, 

GND.DMCE, 

GND.DMCN, 

GND.PCTGND, 

AER.PCTAER, 

AER.MINDRIPHT, 

EXP(4.574-(0.056*LOG(AER.MINDRIPHT))+(0.366*AER.MINDRIPHT))

AS HABDIV, 

(AER.PCTAER-(AER.PCTAER/100*GND.PCTGND)) AS EFFCOV, 

(1-(EFFCOV/HABDIV)) AS C1, 

(0.449296-(0.015349*GND.PCTGND)+(0.000316*(GND.PCTGND^2))-

(0.000004019*(GND.PCTGND^3))+(0.000000025981324*

(GND.PCTGND^4)) -(0.0000000000647784*(GND.PCTGND^5)))

AS C2, 

[C1]*[C2] AS C

FROM 

[C FACTOR INPUTS - GND COVER - INITIAL AND LONG TERM

INVENTORY] AS GND, 

[C FACTOR INPUTS - AER COVER2 - INITIAL AND LONG TERM

INVENTORY] AS AER

WHERE 

GND.PLOTID=AER.PLOTID;

Title “C Factor Inputs - Aer Cover1 - Initial and Long Term Inventory”
SELECT 

AERCOVER.PLOTID, 

PLOTMAST.DMCE, 

PLOTMAST.DMCN, 

AERCOVER.VEGLOC, 

MIN(AERCOVER.VEGHT) AS MinHt

FROM 

AERCOVER, 

PLOTMAST, 

PLOTSURV

WHERE 

DATEPART('YYYY', AERCOVER.RECDATE) =  

[Provide Analysis Year] AND

PLOTSURV.RECDATE = AERCOVER.RECDATE AND 

AERCOVER.PLOTID=PLOTMAST.PLOTID AND

PLOTMAST.PLOTID=PLOTSURV.PLOTID AND

UCASE(PLOTSURV.PLOTTYPE IN ('CORE', 'C', 'SPECIAL', 

'SPUSE', 'S'))

GROUP BY 

AERCOVER.PLOTID, 

PLOTMAST.DMCE, 

PLOTMAST.DMCN, 

AERCOVER.VEGLOC

ORDER BY 

AERCOVER.PLOTID;

Title “C Factor Inputs - Aer Cover2 - Initial and Long Term Inventory”
SELECT 

[INPUT].PLOTID, 

[INPUT].DMCE, 

[INPUT].DMCN, 

(COUNT([INPUT].VEGLOC)/100*100) AS PctAer,

AVG(([INPUT].MinHt)*3.28084) AS MinDripHt

FROM 

[C Factor Inputs - Aer Cover1 - Initial and Long Term Inventory] 

AS [INPUT]

GROUP BY 

[INPUT].PLOTID, 

[INPUT].DMCE, 

[INPUT].DMCN

ORDER BY 

[INPUT].PLOTID;

Title “C Factor Inputs - Gnd Cover - Initial and Long Term Inventory”
SELECT 

GNDCOVER.PLOTID, 

PLOTMAST.DMCE, 

PLOTMAST.DMCN, 

(SUM(IIF(UCASE([GNDCOVER.VEGID]) NOT IN ( 'BG'), 1, 0)) /

SUM(IIF([GNDCOVER.VEGID] IS NOT NULL, 1, 0)) * 100) 

AS PctGND

FROM 

GNDCOVER, 

PLOTMAST, 

PLOTSURV

WHERE 

DATEPART('YYYY', GNDCOVER.RECDATE) =  

[Provide Analysis Year] AND

PLOTSURV.RECDATE = GNDCOVER.RECDATE AND 

GNDCOVER.PLOTID=PLOTMAST.PLOTID AND

PLOTMAST.PLOTID=PLOTSURV.PLOTID AND

UCASE(PLOTSURV.PLOTTYPE IN ('CORE', 'C', 'SPECIAL', 

'SPUSE', 'S'))

GROUP BY 

GNDCOVER.PLOTID, 

PLOTMAST.DMCE, 

PLOTMAST.DMCN

ORDER BY 

GNDCOVER.PLOTID;

LS Factor Data Layer

The following table outlines the SQL query subquery structure.  Use top most query required for your data (i.e. combined, long-term or monitoring query).  The top most queries are located in the left most columns. The top most queries used will use proper subqueries.  Individual queries are listed below each table in a logical order.  Query titles match query titles in the sample database on the CD that came with this document.

	LS Factor


All LCTA Monitoring Types

Title “LS Factor”
SELECT 


PlotMast.PlotID, 


SoilLS.TranLoc, 


DatePart('yyyy',RecDate) AS [Year],


SoilLS.Slope, 


SoilLS.SlpLen, 


(SlpLen*3.28084) AS SlpLenFt, 


(atn(Slope/100)) AS SlopeAngleDegree, 


Cos(SlopeAngleDegree)*SlpLenFt AS HSlpLenFt,


((SlopeAngleDegree*3.14159265358979)/180) AS SlopeAngleRadians, 


((Sin(SlopeAngleRadians)/0.0896)/(((3*((Sin(SlopeAngleRadians))^0.8))

+0.56))) AS B, 


(B/(1+B)) AS M, 


((HSlpLenFt/72.6)^M) AS L, 


IIF(HSlpLenFt<15,((3.0*((sin(SlopeAngleRadians))^0.8))+0.56),

IIf(Slope<9,((10.8*Sin(SlopeAngleRadians))+0.03),

((16.8*Sin(SlopeAngleRadians))-0.5))) AS S, 


(L*S) AS LS

FROM SoilLS, 


PlotMast

WHERE 


(((PlotMast.PLOTID)=[SoilLS].[PlotID]));

Impact Data Layer

The following table outlines the SQL query subquery structure.  Use top most query required for your data (i.e. combined, long-term or monitoring query).  The top most queries are located in the left most columns. The top most queries used will use proper subqueries.  Individual queries are listed below each table in a logical order.  Query titles match query titles in the sample database on the CD that came with this document.

	Impact Factor Final - Combined Surveys

	
	Impact Factor Final - Init and Long Term

	
	
	dist C Final - Init and Long term

	
	
	
	dist C Factor Inputs - Gnd Cover - Initial and Long Term

	
	
	
	dist C Factor Inputs - Aer Cover2 - Init and long term

	
	
	
	
	dist C Factor Inputs - Aer Cover 1 Init and Long term

	
	
	
	
	
	dist C Factor - Aer Cover 3 Init and Long Term

	
	
	undist C Final - Init and Long term

	
	
	
	undist C Factor Inputs - Gnd Cover - Initial and Long Term

	
	
	
	undist C Factor Inputs - Aer Cover2 - Init and long term

	
	
	
	
	undist C Factor Inputs - Aer Cover 1 Init and Long term

	
	
	
	
	
	undist C Factor - Aer Cover 3 Init and Long Term

	
	Impact Factor Final - Short Term Monitoring

	
	
	dist C Factor Final - Short Term Monitoring

	
	
	
	dist C factor Inputs - Short Term Monitoring

	
	
	undist C Factor Final - Short Term Monitoring

	
	
	
	Undist C factor Inputs - Short Term Monitoring


Combined Data

Title “Impact Factor Final - Combined Surveys”

SELECT 

[LONGDATA].PLOTID, 

[LONGDATA].DMCE, 

[LONGDATA].DMCN,

[LONGDATA].[Disturbed C],

[LONGDATA].[Undisturbed C],

[LONGDATA].[Delta C]

FROM 

[Impact Factor Final - Init and Long Term] AS [LONGDATA]

UNION 

SELECT 

[SHORTDATA].PLOTID, 

[SHORTDATA].DMCE, 

[SHORTDATA].DMCN,

[SHORTDATA].[Disturbed C],

[SHORTDATA].[Undisturbed C],

[SHORTDATA].[Delta C]

FROM 

[Impact Factor Final - Short Term Monitoring] AS [SHORTDATA]

ORDER BY 

1;

Long-term/Inventory Data

Title “Impact Factor Final - Init and Long Term”

SELECT 

[DISTDATA].PLOTID, 

[DISTDATA].DMCE, 

[DISTDATA].DMCN, 

[DISTDATA].C AS [Disturbed C], 

[UNDISTDATA].C AS [Undisturbed C], 

[DISTDATA].C - [UNDISTDATA].C AS [Delta C]

FROM 

[dist C Final - Init and Long term] AS DISTDATA, 

[undist C Final - Init and Long term] AS UNDISTDATA

WHERE 

[DISTDATA].PLOTID = [UNDISTDATA].PLOTID;

Title “undist C Final - Init and Long term”

SELECT 

GND.PLOTID, 

GND.DMCE, 

GND.DMCN, 

GND.PCTGND, 

AER.PCTAER, 

AER.MINDRIPHT, 

EXP(4.574-(0.056*LOG(AER.MINDRIPHT))+

(0.366*AER.MINDRIPHT)) AS HABDIV, 

(AER.PCTAER-(AER.PCTAER/100*GND.PCTGND)) AS EFFCOV, 

(1-(EFFCOV/HABDIV)) AS C1, 

(0.449296-(0.015349*GND.PCTGND)+(0.000316*(GND.PCTGND^2))-

(0.000004019*(GND.PCTGND^3))+(0.000000025981324*

(GND.PCTGND^4))-(0.0000000000647784*

(GND.PCTGND^5))) AS C2, 

[C1]*[C2] AS C

FROM 

[undist C FACTOR INPUTS - GND COVER - INITIAL AND LONG TERM] AS GND, 

[undist C FACTOR INPUTS - AER COVER2 - INIT AND LONG TERM] 

AS AER

WHERE 

GND.PLOTID=AER.PLOTID;

Title “undist C Factor Inputs - Gnd Cover - Initial and Long Term”

SELECT 

GNDCOVER.PLOTID, 

PLOTMAST.DMCE, 

PLOTMAST.DMCN,

(SUM(IIF(UCASE([GNDCOVER.VEGID]) NOT IN ( 'BG'), 1, 0)) /

 

SUM(IIF([GNDCOVER.VEGID] IS NOT NULL, 1, 0)) * 100) 

AS PctGND

FROM 

GNDCOVER, 

PLOTMAST, 

PLOTSURV

WHERE 

DATEPART('YYYY', GNDCOVER.RECDATE) =  

[Provide Analysis Year] AND

PLOTSURV.RECDATE = GNDCOVER.RECDATE AND 

GNDCOVER.PLOTID=PLOTMAST.PLOTID AND

PLOTMAST.PLOTID=PLOTSURV.PLOTID AND

UCASE(PLOTSURV.PLOTTYPE IN ('CORE', 'C', 'SPECIAL',

 'SPUSE', 'S')) AND

[GNDCOVER.DISTURB] IN ('N')

GROUP BY 

GNDCOVER.PLOTID, 

PLOTMAST.DMCE, 

PLOTMAST.DMCN

ORDER BY 

GNDCOVER.PLOTID;

Title “undist C Factor Inputs - Aer Cover2 - Init and long term”

SELECT 

[INPUT].PLOTID, 

[INPUT].DMCE, 

[INPUT].DMCN, 

SUM([INPUT].AerCnt)/SUM([INPUT].GndCnt)*100 AS PctAer, 

AVG(([INPUT].MinHt)*3.28084) AS MinDripHt

FROM 

[undist C Factor Inputs - Aer Cover 1 Init and Long term] AS [INPUT]

GROUP BY 

[INPUT].PLOTID, 

[INPUT].DMCE, 

[INPUT].DMCN

ORDER BY 

[INPUT].PLOTID;

Title “undist C Factor Inputs - Aer Cover 1 Init and Long term”

SELECT 

INPUT.PLOTID, 

PLOTMAST.DMCE, 

PLOTMAST.DMCN, 

INPUT.GNDCOVER.VEGLOC,

(IIF(SUM(IIF(INPUT.GNDCOVER.VEGLOC IS NULL, 0, 1))>0,1,0)) 

AS GndCnt, 

(IIF(SUM(IIF(INPUT.AERCOVER.VEGLOC IS NULL, 0, 1))>0,1,0)) 

AS AerCnt, 

MIN(INPUT.AERCOVER.VEGHT) AS MinHt

FROM 

PLOTMAST, 

PLOTSURV, 

[undist C Factor - Aer Cover 3 Init and Long Term] AS [INPUT]

WHERE 

DATEPART('YYYY', INPUT.RECDATE) =  [Provide Analysis Year] AND

PLOTSURV.RECDATE = INPUT.RECDATE AND 

INPUT.PLOTID=PLOTMAST.PLOTID AND

PLOTMAST.PLOTID=PLOTSURV.PLOTID AND

UCASE(PLOTSURV.PLOTTYPE IN ('CORE', 'C', 'SPECIAL',

 

'SPUSE', 'S')) AND

INPUT.DISTURB IN ('N')

GROUP BY 

INPUT.PLOTID, 

PLOTMAST.DMCE, 

PLOTMAST.DMCN, 

INPUT.GNDCOVER.VEGLOC

ORDER BY 

1, 

2, 

3, 

4;

Title “undist C Factor - Aer Cover 3 Init and Long Term”

SELECT 

GNDCOVER.PLOTID, 

GNDCOVER.RECDATE, 

GNDCOVER.VEGLOC, 

GNDCOVER.DISTURB, 

AERCOVER.VEGLOC, 

AERCOVER.VEGHT

FROM 

GNDCOVER 

LEFT JOIN 

AERCOVER

ON 

(GNDCOVER.VEGLOC=AERCOVER.VEGLOC) AND 

(GNDCOVER.RECDATE = AERCOVER.RECDATE) AND 

(GNDCOVER.PLOTID = AERCOVER.PLOTID)

ORDER BY 

GNDCOVER.PLOTID;

Title “dist C Final - Init and Long term”

SELECT 

GND.PLOTID, 

GND.DMCE, 

GND.DMCN, 

GND.PCTGND, 

AER.PCTAER, 

AER.MINDRIPHT, 

EXP(4.574-(0.056*LOG(AER.MINDRIPHT))+

(0.366*AER.MINDRIPHT)) AS HABDIV, 

(AER.PCTAER-(AER.PCTAER/100*GND.PCTGND)) AS EFFCOV, 

(1-(EFFCOV/HABDIV)) AS C1, 

(0.449296-(0.015349*GND.PCTGND)+(0.000316*(GND.PCTGND^2))-

(0.000004019*(GND.PCTGND^3))+(0.000000025981324*

(GND.PCTGND^4)) – (0.0000000000647784*

(GND.PCTGND^5))) AS C2, 

[C1]*[C2] AS C

FROM 

[dist C FACTOR INPUTS - GND COVER - INITIAL AND

LONG TERM] AS GND,

[dist C FACTOR INPUTS - AER COVER2 - INIT AND 

LONG TERM] AS AER

WHERE 

GND.PLOTID=AER.PLOTID;

Title “dist C Factor Inputs - Gnd Cover - Initial and Long Term”

SELECT 

GNDCOVER.PLOTID, 

PLOTMAST.DMCE, 

PLOTMAST.DMCN, 

(SUM(IIF(UCASE([GNDCOVER.VEGID]) NOT IN ( 'BG'), 1, 0)) / 

SUM(IIF([GNDCOVER.VEGID] IS NOT NULL, 1, 0)) * 100) 

AS PctGND

FROM 

GNDCOVER, 

PLOTMAST, 

PLOTSURV

WHERE 

DATEPART('YYYY', GNDCOVER.RECDATE) =  

[Provide Analysis Year] AND

PLOTSURV.RECDATE = GNDCOVER.RECDATE AND 

GNDCOVER.PLOTID=PLOTMAST.PLOTID AND

PLOTMAST.PLOTID=PLOTSURV.PLOTID AND

UCASE(PLOTSURV.PLOTTYPE IN ('CORE', 'C', 

'SPECIAL', 'SPUSE', 'S')) AND

[GNDCOVER.DISTURB] IN ('P')

GROUP BY 

GNDCOVER.PLOTID, 

PLOTMAST.DMCE, 

PLOTMAST.DMCN

ORDER BY 

GNDCOVER.PLOTID;

Title “dist C Factor Inputs - Aer Cover2 - Init and long term”

SELECT 

[INPUT].PLOTID, 

[INPUT].DMCE, 

[INPUT].DMCN, 

SUM([INPUT].AerCnt)/SUM([INPUT].GndCnt)*100 AS PctAer, 

AVG(([INPUT].MinHt)*3.28084) AS MinDripHt

FROM 

[dist C Factor Inputs - Aer Cover 1 Init and Long term] AS [INPUT]

GROUP BY 

[INPUT].PLOTID, 

[INPUT].DMCE, 

[INPUT].DMCN

ORDER BY 

[INPUT].PLOTID;

Title “dist C Factor Inputs - Aer Cover 1 Init and Long term”

SELECT 

INPUT.PLOTID, 

PLOTMAST.DMCE, 

PLOTMAST.DMCN, 

INPUT.GNDCOVER.VEGLOC, 

(IIF(SUM(IIF(INPUT.GNDCOVER.VEGLOC IS NULL, 0, 1))>0,1,0))

 

AS GndCnt, 

(IIF(SUM(IIF(INPUT.AERCOVER.VEGLOC IS NULL, 0, 1))>0,1,0))

 

AS AerCnt, 

MIN(INPUT.AERCOVER.VEGHT) AS MinHt

FROM 

PLOTMAST, 

PLOTSURV, 

[dist C Factor - Aer Cover 3 Init and Long Term] AS [INPUT]

WHERE 

DATEPART('YYYY', INPUT.RECDATE) =  

[Provide Analysis Year] AND

PLOTSURV.RECDATE = INPUT.RECDATE AND 

INPUT.PLOTID=PLOTMAST.PLOTID AND

PLOTMAST.PLOTID=PLOTSURV.PLOTID AND

UCASE(PLOTSURV.PLOTTYPE IN ('CORE', 'C', 

'SPECIAL', 'SPUSE', 'S')) AND

INPUT.DISTURB IN ('P')

GROUP BY 

INPUT.PLOTID, 

PLOTMAST.DMCE, 

PLOTMAST.DMCN, 

INPUT.GNDCOVER.VEGLOC

ORDER BY 

1, 

2, 

3, 

4;

Title “dist C Factor - Aer Cover 3 Init and Long Term”

SELECT 

GNDCOVER.PLOTID, 

GNDCOVER.RECDATE, 

GNDCOVER.VEGLOC, 

GNDCOVER.DISTURB, 

AERCOVER.VEGLOC, 

AERCOVER.VEGHT

FROM 

GNDCOVER 

LEFT JOIN 

AERCOVER 

ON 

(GNDCOVER.PLOTID = AERCOVER.PLOTID) AND 

(GNDCOVER.RECDATE = AERCOVER.RECDATE) AND 

(GNDCOVER.VEGLOC=AERCOVER.VEGLOC)

ORDER BY 

GNDCOVER.PLOTID;

Monitory Data

Title “Impact Factor Final - Short Term Monitoring”

SELECT 

[DISTDATA].PLOTID, 

[DISTDATA].DMCE, 

[DISTDATA].DMCN, 

[DISTDATA].C AS [Disturbed C], 

[UNDISTDATA].C AS [Undisturbed C], 

[DISTDATA].C - [UNDISTDATA].C AS [Delta C]

FROM 

[dist C Factor Final - Short Term Monitoring] AS DISTDATA, 

[undist C Factor Final - Short Term Monitoring] AS UNDISTDATA

WHERE 

[DISTDATA].PLOTID = [UNDISTDATA].PLOTID

ORDER BY 

1;

Title “undist C Factor Final - Short Term Monitoring”

SELECT 

PLOTID, 

DMCE, 

DMCN, 

PCTGND, 

PCTAER, 

MINDRPHT, 

EXP(4.574-(0.056*LOG(MINDRPHT))+

(0.366*MINDRPHT)) AS HABDIV, 

(PCTAER-(PCTAER/100*PCTGND)) AS EFFCOV, 

(1-(EFFCOV/HABDIV)) AS C1, 

(0.449296-(0.015349*PCTGND)+(0.000316*(PCTGND^2))-

(0.000004019*(PCTGND^3))+(0.000000025981324*

(PCTGND^4)) – (0.0000000000647784*(PCTGND^5))) AS C2, 

[C1]*[C2] AS C

FROM 

[Undist C FACTOR INPUTS - SHORT TERM MONITORING];

Title “Undist C factor Inputs - Short Term Monitoring”

SELECT 

LINEMON.PLOTID, 

PLOTMAST.DMCE, 

PLOTMAST.DMCN, 

(SUM(IIF(UCASE([LINEMON.GNDCOV]) IN ( 'L', 'M', 'P', 'R', 'U'), 

1, 0)) / SUM(IIF(UCASE([LINEMON.GNDCOV]) IN ( 'B', 

'L', 'M', 'P', 'R', 'U'), 1, 0)) * 100) AS PctGND, 

(SUM(IIF(UCASE([LINEMON.AERCOV]) IN ('A', 'P', 'AP', 'U'), 1, 0)) /

SUM(IIF(UCASE([LINEMON.AERCOV]) IN ('N', 'A', 'P',

 

'AP','U'), 1, 0)) * 100) AS PctAER, 

[Provide Minimum Drip Height (ft)] AS MinDrpHt

FROM 

LINEMON, 

PLOTMAST, 

PLOTSURV

WHERE 

DATEPART('YYYY', LINEMON.RECDATE) = 

[Provide Analysis Year] AND

PLOTSURV.RECDATE = LINEMON.RECDATE AND 

LINEMON.PLOTID=PLOTMAST.PLOTID AND

PLOTMAST.PLOTID=PLOTSURV.PLOTID AND

UCASE(PLOTSURV.PLOTTYPE IN ('CORE', 'C', 

'SPECIAL', 'SPUSE', 'S')) AND

[LINEMON.DISTURB] IN ('N')

GROUP BY 

LINEMON.PLOTID, 

PLOTMAST.DMCE, 

PLOTMAST.DMCN

ORDER BY 

LINEMON.PLOTID;

Title “dist C Factor Final - Short Term Monitoring”

SELECT 

PLOTID, 

DMCE, 

DMCN, 

PCTGND, 

PCTAER, 

MINDRPHT, 

EXP(4.574-(0.056*LOG(MINDRPHT))+(0.366*MINDRPHT))

 

AS HABDIV, 

(PCTAER-(PCTAER/100*PCTGND)) AS EFFCOV, 

(1-(EFFCOV/HABDIV)) AS C1, 

(0.449296-(0.015349*PCTGND)+(0.000316*(PCTGND^2))-

(0.000004019*(PCTGND^3))+(0.000000025981324*

(PCTGND^4)) – (0.0000000000647784*(PCTGND^5))) AS C2, 

[C1]*[C2] AS C

FROM 

[dist C FACTOR INPUTS - SHORT TERM MONITORING];

Title “dist C factor Inputs - Short Term Monitoring”

SELECT 

LINEMON.PLOTID, 

PLOTMAST.DMCE, 

PLOTMAST.DMCN, 

(SUM(IIF(UCASE([LINEMON.GNDCOV]) IN ( 'L', 'M', 'P', 'R', 'U'), 

1, 0)) / SUM(IIF(UCASE([LINEMON.GNDCOV]) IN ( 'B', 'L', 'M', 

'P', 'R', 'U'), 1, 0)) * 100) AS PctGND, 

(SUM(IIF(UCASE([LINEMON.AERCOV]) IN ('A', 'P', 'AP', 'U'), 1, 0)) /

SUM(IIF(UCASE([LINEMON.AERCOV]) IN ('N', 'A', 'P',

'AP','U'), 1, 0)) * 100) AS PctAER, 

[Provide Minimum Drip Height (ft)] AS MinDrpHt

FROM 

LINEMON, 

PLOTMAST, 

PLOTSURV

WHERE 

DATEPART('YYYY', LINEMON.RECDATE) = 

[Provide Analysis Year] AND

PLOTSURV.RECDATE = LINEMON.RECDATE AND 

LINEMON.PLOTID=PLOTMAST.PLOTID AND

PLOTMAST.PLOTID=PLOTSURV.PLOTID AND

UCASE(PLOTSURV.PLOTTYPE IN ('CORE', 'C', 

'SPECIAL', 'SPUSE', 'S')) AND

[LINEMON.DISTURB] IN ('P')

GROUP BY 

LINEMON.PLOTID, 

PLOTMAST.DMCE, 

PLOTMAST.DMCN

ORDER BY 

LINEMON.PLOTID;

Wind Erosion Input Layers

Vegetation Impact Data Layer

The following table outlines the SQL query subquery structure.  Use top most query required for your data (i.e. combined, long-term or monitoring query).  The top most queries are located in the left most columns. The top most queries used will use proper subqueries.  Individual queries are listed below each table in a logical order.  Query titles match query titles in the sample database on the CD that came with this document.

	Cover Impact Mon Final

	
	Cover Impact Mon Input Dist

	
	Cover Impact Mon Input UnDist

	Cover Impact Inv Final

	
	Cover Impact Inv 1 Dist

	
	
	Cover Impact Inv Input 2 Dist

	
	
	
	Cover Impact Inv Input 3

	
	
	
	
	
	

	
	Cover Impact Inv 1 UnDist

	
	
	Cover Impact Inv Input 2 UnDist

	
	
	
	Cover Impact Inv Input 3


Short-term/Monitoring Data

Title:  “Cover Impact Mon Final”

SELECT 

[DISTDATA].PLOTID, 

[DISTDATA].DMCE, 

[DISTDATA].DMCN, 

[UNDISTDATA].PctAer AS [Undisturbed Cover], 

[DISTDATA].PctAer AS [Disturbed Cover], 

[UNDISTDATA].PctAer - [DISTDATA].PctAer AS [Delta Cover]

FROM 

[Cover Impact Mon Input Dist] AS DISTDATA, 

[Cover Impact Mon Input UnDist] AS UNDISTDATA

WHERE 

[DISTDATA].PLOTID = [UNDISTDATA].PLOTID

ORDER BY 

1;

Title:  “Cover Impact Mon Input Dist”

SELECT 

LINEMON.PLOTID, 

PLOTMAST.DMCE, 

PLOTMAST.DMCN, 

(SUM(IIF(UCASE([LINEMON.AERCOV]) IN ('A', 'P', 'AP', 'U'), 1, 0)) /

SUM(IIF(UCASE([LINEMON.AERCOV]) IN ('N', 'A', 'P', 'AP','U'), 

1, 0)) * 100) AS PctAER

FROM 

LINEMON, 

PLOTMAST, 

PLOTSURV

WHERE 

DATEPART('YYYY', LINEMON.RECDATE) = 

[Provide Analysis Year] AND

PLOTSURV.RECDATE = LINEMON.RECDATE AND 

LINEMON.PLOTID=PLOTMAST.PLOTID AND

PLOTMAST.PLOTID=PLOTSURV.PLOTID AND

UCASE(PLOTSURV.PLOTTYPE IN ('CORE', 'C', 'SPECIAL', 

'SPUSE', 'S')) AND

[LINEMON.DISTURB] IN ('P')

GROUP BY 

LINEMON.PLOTID, 

PLOTMAST.DMCE, 

PLOTMAST.DMCN

ORDER BY 

LINEMON.PLOTID;

Title:  “Cover Impact Mon Input UnDist”

SELECT 

LINEMON.PLOTID, 

PLOTMAST.DMCE, 

PLOTMAST.DMCN, 

(SUM(IIF(UCASE([LINEMON.AERCOV]) IN ('A', 'P', 'AP', 'U'), 1, 0)) /

SUM(IIF(UCASE([LINEMON.AERCOV]) IN ('N', 'A', 'P', 'AP','U'), 

1, 0)) * 100) AS PctAER

FROM 

LINEMON, 

PLOTMAST, 

PLOTSURV

WHERE 

DATEPART('YYYY', LINEMON.RECDATE) = 

[Provide Analysis Year] AND

PLOTSURV.RECDATE = LINEMON.RECDATE AND 

LINEMON.PLOTID=PLOTMAST.PLOTID AND

PLOTMAST.PLOTID=PLOTSURV.PLOTID AND

UCASE(PLOTSURV.PLOTTYPE IN ('CORE', 'C', 'SPECIAL', 

'SPUSE', 'S')) AND

[LINEMON.DISTURB] IN ('N')

GROUP BY 

LINEMON.PLOTID, 

PLOTMAST.DMCE, 

PLOTMAST.DMCN

ORDER BY 

LINEMON.PLOTID;

Long-Term/Inventory Data

Title “Cover Impact Inv Final”

SELECT 

[DISTDATA].PLOTID, 

[DISTDATA].DMCE, 

[DISTDATA].DMCN, 

[UNDISTDATA].PctAerUD AS [Undisturbed Cover], 

[DISTDATA].PctAerD AS [Disturbed Cover], 

[UNDISTDATA].PctAerUD - [DISTDATA].PctAerD AS [Delta Cover]

FROM 

[Cover Impact Inv 1 Dist] AS DISTDATA, 

[Cover Impact Inv 1 UnDist] AS UNDISTDATA

WHERE 

[DISTDATA].PLOTID = [UNDISTDATA].PLOTID

ORDER BY 

1;

Title “Cover Impact Inv 1 Dist”

SELECT 

[INPUT].PLOTID AS PlotID, 

[INPUT].DMCE AS DMCE, 

[INPUT].DMCN AS DMCN, 

SUM([INPUT].AerCnt)/SUM([INPUT].GndCnt)*100 AS PctAerD

FROM 

[Cover Impact Inv Input 2 Dist] AS [INPUT]

GROUP BY 

[INPUT].PLOTID, 

[INPUT].DMCE, 

[INPUT].DMCN

ORDER BY 

[INPUT].PLOTID;

Title “Cover Impact Inv 1 UnDist”

SELECT 

[INPUT].PLOTID AS PlotID, 

[INPUT].DMCE AS DMCE, 

[INPUT].DMCN AS DMCN, 

SUM([INPUT].AerCnt)/SUM([INPUT].GndCnt)*100 AS PctAerUD

FROM 

[Cover Impact Inv Input 2 UnDist] AS [INPUT]

GROUP BY 

[INPUT].PLOTID, 

[INPUT].DMCE, 

[INPUT].DMCN

ORDER BY 

[INPUT].PLOTID;

Title “Cover Impact Inv Input 2 Dist”

SELECT 

INPUT.PLOTID, 

PLOTMAST.DMCE, 

PLOTMAST.DMCN, 

INPUT.GNDCOVER.VEGLOC, 

(IIF(SUM(IIF(INPUT.GNDCOVER.VEGLOC IS NULL, 0, 1))>0,1,0)) 

AS GndCnt, 

(IIF(SUM(IIF(INPUT.AERCOVER.VEGLOC IS NULL, 0, 1))>0,1,0)) 

AS AerCnt

FROM 

PLOTMAST, 

PLOTSURV, 

[Cover Impact Inv Input 3] AS [INPUT]

WHERE 

DATEPART('YYYY', INPUT.RECDATE) =  

[Provide Analysis Year] AND

PLOTSURV.RECDATE = INPUT.RECDATE AND 

INPUT.PLOTID=PLOTMAST.PLOTID AND

PLOTMAST.PLOTID=PLOTSURV.PLOTID AND

UCASE(PLOTSURV.PLOTTYPE IN ('CORE', 'C', 'SPECIAL', 

'SPUSE', 'S')) AND

INPUT.DISTURB IN ('P')

GROUP BY 

INPUT.PLOTID, 

PLOTMAST.DMCE, 

PLOTMAST.DMCN, 

INPUT.GNDCOVER.VEGLOC

ORDER BY 

1, 

2, 

3, 

4;

Title “Cover Impact Inv Input 2 UnDist”

SELECT 

INPUT.PLOTID, 

PLOTMAST.DMCE, 

PLOTMAST.DMCN, 

INPUT.GNDCOVER.VEGLOC, 

(IIF(SUM(IIF(INPUT.GNDCOVER.VEGLOC IS NULL, 0, 1))>0,1,0)) 

AS GndCnt, 

(IIF(SUM(IIF(INPUT.AERCOVER.VEGLOC IS NULL, 0, 1))>0,1,0)) 

AS AerCnt

FROM 

PLOTMAST, 

PLOTSURV, 

[Cover Impact Inv Input 3] AS [INPUT]

WHERE 

DATEPART('YYYY', INPUT.RECDATE) =  

[Provide Analysis Year] AND

PLOTSURV.RECDATE = INPUT.RECDATE AND 

INPUT.PLOTID=PLOTMAST.PLOTID AND

PLOTMAST.PLOTID=PLOTSURV.PLOTID AND

UCASE(PLOTSURV.PLOTTYPE IN ('CORE', 'C', 'SPECIAL', 

'SPUSE', 'S')) AND

INPUT.DISTURB IN ('N')

GROUP BY 

INPUT.PLOTID, 

PLOTMAST.DMCE, 

PLOTMAST.DMCN, 

INPUT.GNDCOVER.VEGLOC

ORDER BY 

1, 

2, 

3, 

4;

Title “Cover Impact Inv Input 3”

SELECT 

GNDCOVER.PLOTID, 

GNDCOVER.RECDATE, 

GNDCOVER.VEGLOC, 

GNDCOVER.DISTURB, 

AERCOVER.VEGLOC, 

AERCOVER.VEGHT

FROM 

GNDCOVER 

LEFT JOIN 

AERCOVER 

ON 

(GNDCOVER.VEGLOC=AERCOVER.VEGLOC) AND 

(GNDCOVER.RECDATE = AERCOVER.RECDATE) AND 

(GNDCOVER.PLOTID = AERCOVER.PLOTID)

WHERE

DATEPART('YYYY', GNDCOVER.RECDATE) = 

[Provide Analysis Year] 

ORDER BY 

GNDCOVER.PLOTID;

Plant Height Data Layer

The following table outlines the SQL query subquery structure.  Use top most query required for your data (i.e. combined, long-term or monitoring query).  The top most queries are located in the left most columns. The top most queries used will use proper subqueries.  Individual queries are listed below each table in a logical order.  Query titles match query titles in the sample database on the CD that came with this document.

	Avg Plant Ht Mon Final

	
	Avg Plant Ht Mon Input

	Avg Plant Ht Inv Final

	
	Avg Plant Ht Inv Input 1

	
	
	Avg Plant Ht Inv Input 2


Short-term/Monitoring Data

Title “Avg Plant Ht Mon Final”

SELECT

[Avg Plant Ht Mon Input].PlotID AS PlotID,

PlotMast.DMCE AS DMCE,

PlotMast.DMCN AS DMCN,

SUM(Temp1)/SUM(Temp2)*3.2808 AS AvgHtFt

FROM

[Avg Plant Ht Mon Input],

PlotMast

WHERE

[Avg Plant Ht Mon Input].PlotID = PlotMast.PlotID

GROUP BY

[Avg Plant Ht Mon Input].PlotID,

PlotMast.DMCE,

PlotMast.DMCN;

Title “Avg Plant Ht Mon Input”

SELECT 

Beltmon.Plotid AS PlotID, 

Beltmon.VegID AS VegID, 

MAX((Beltmon.CatMinTo1 * 0.5) + (Beltmon.Cat1To2 * 1.5) + 

(Beltmon.Cat2To3 * 2.5) + (Beltmon.Cat3To4 * 3.5) +

(Beltmon.CatGT4 *4.5)) AS Temp1, 

MAX((Beltmon.CatMinTo1 + Beltmon.Cat1To2 + Beltmon.Cat2To3 +

Beltmon.Cat3To4 + Beltmon.CatGT4) * (BeltSurv.BeltWide/6)) 

AS Temp2

FROM 

Beltmon 

LEFT JOIN 

Beltsurv 

ON 

(UCASE(Beltmon.VegCond) = UCASE(Beltsurv.VegCond) OR 

Beltsurv.VegCond is NULL) AND 

(UCASE(Beltmon.vegid) = UCASE(Beltsurv.excptnsp) OR

UCASE(BeltSurv.excptnsp) IN ('DEFAULT')) AND 

(Beltmon.recdate = Beltsurv.recdate) AND 

(Beltmon.plotid = Beltsurv.plotid)

WHERE 

DATEPART('YYYY', Beltmon.recdate) = 

[Provide Analysis Year] AND

UCASE(Beltmon.VegCond) IN ('L')

GROUP BY 

Beltmon.Plotid, 

Beltmon.VegID;

Long-term/Inventory Data

Title “Avg Plant Ht Inv Final”

SELECT

[Avg Plant Ht Inv Input 1].PlotID AS PlotID,

PlotMast.DMCE AS DMCE,

PlotMast.DMCN AS DMCN,

SUM([Avg Plant Ht Inv Input 1].Temp1)/

SUM([Avg Plant Ht Inv Input 1].Temp2) AS AvgHtFt

FROM

[Avg Plant Ht Inv Input 1],

PlotMast

WHERE

[Avg Plant Ht Inv Input 1].PlotID = PlotMast.PlotID

GROUP BY

[Avg Plant Ht Inv Input 1].PlotID,

PlotMast.DMCE,

PlotMast.DMCN;

Title “Avg Plant Ht Inv Input 1”

SELECT 

[Avg Plant Ht Inv Input 2].Plotid AS PlotID, 

[Avg Plant Ht Inv Input 2].VegID AS VegID, 

BeltSurv.Excptnsp AS Excptnsp, 

MAX(([Avg Plant Ht Inv Input 2].AvgHtFt*

[Avg Plant Ht Inv Input 2].NumPlant*(BeltSurv.BeltWide/6))) 

AS Temp1,

MAX([Avg Plant Ht Inv Input 2].NumPlant*(BeltSurv.BeltWide/6)) 

AS Temp2

FROM 

[Avg Plant Ht Inv Input 2] 

LEFT JOIN

BeltSurv 

ON 

(UCASE([Avg Plant Ht Inv Input 2].VegID) =

UCASE(BeltSurv.Excptnsp) OR

UCASE(BeltSurv.Excptnsp) IN ('DEFAULT'))

WHERE 

[Avg Plant Ht Inv Input 2].PlotID = BeltSurv.PlotID AND

[Avg Plant Ht Inv Input 2].RecDate = BeltSurv.RecDate AND

(UCASE(BeltSurv.VegCond) IN ('L') OR

BeltSurv.VegCond IS NULL)

GROUP BY 

[Avg Plant Ht Inv Input 2].Plotid, 

[Avg Plant Ht Inv Input 2].VegID, 

BeltSurv.Excptnsp;

Title “Avg Plant Ht Inv Input 2”

SELECT 

BeltTran.Plotid AS PlotID, 

BeltTran.VegID AS VegID, 

BeltTran.RecDate AS RecDate, 

AVG(BeltTran.PlantHt * 3.2808) AS AvgHtFt,

COUNT(BeltTran.PlantHt) AS NumPlant

FROM 

BeltTran

WHERE 

DATEPART('YYYY', BeltTran.recdate) = [Provide Analysis Year] AND

UCASE(BeltTran.VegCond) IN ('L')

GROUP BY 

BeltTran.Plotid, 

BeltTran.VegID, 

BeltTran.RecDate;

Plant Spacing Data Layer

The following table outlines the SQL query subquery structure.  Use top most query required for your data (i.e. combined, long-term or monitoring query).  The top most queries are located in the left most columns. The top most queries used will use proper subqueries.  Individual queries are listed below each table in a logical order.  Query titles match query titles in the sample database on the CD that came with this document.

	Stems Per Acre Mon Final

	
	Stems Per Acre Mon Input

	Stems Per Acre Inv Final

	
	Stems Per Acre Inv Input 1

	
	
	Stems Per Acre Inv Input 2

	
	
	
	Stems Per Acre Inv Input 3


Short-term/Monitoring Data

Title “Stems Per Acre Mon Final”

SELECT

[Stems Per Acre Mon Input].PlotID,

[PlotMast].DMCE,

[PlotMast].DMCN,

SUM([Stems Per Acre Mon Input].StemPerAcre) AS StemPerAcre

FROM 

[Stems Per Acre Mon Input],

PlotMast

WHERE

[Stems Per Acre Mon Input].PlotID = PlotMast.PlotID

GROUP BY

[Stems Per Acre Mon Input].PlotID,

[PlotMast].DMCE,

[PlotMast].DMCN;

Title “Stems Per Acre Mon Input”

SELECT 

Beltmon.Plotid AS PlotID, 

Beltmon.VegID AS VegID, 

MAX(((Beltmon.CatMinTo1 + Beltmon.Cat1To2 + Beltmon.Cat2To3 +

Beltmon.Cat3To4 + Beltmon.CatGT4)*(6/BeltSurv.BeltWide))*

((4046.856)/600)) AS StemPerAcre

FROM 

Beltmon 

LEFT JOIN 

Beltsurv 

ON 

(Beltmon.plotid = Beltsurv.plotid) AND 

(Beltmon.recdate = Beltsurv.recdate) AND 

(UCASE(Beltmon.vegid) = UCASE(Beltsurv.excptnsp) OR

UCASE(BeltSurv.excptnsp) IN ('DEFAULT')) AND 

(UCASE(Beltmon.VegCond) = UCASE(Beltsurv.VegCond) OR 

Beltsurv.VegCond is NULL)

WHERE 

DATEPART('YYYY', Beltmon.recdate) = [Provide Analysis Year] AND

UCASE(Beltmon.VegCond) IN ('L')

GROUP BY 

Beltmon.Plotid,

Beltmon.VegID;

Long-term/Inventory Data

Title “Stems Per Acre Inv Final”

SELECT

[Stems Per Acre Inv Input 1].PlotID, 

[PlotMast].DMCE, 

[PlotMast].DMCN, 

SUM([Stems Per Acre Inv Input 1].StemPerAcre) AS StemPerAcre

FROM 

[Stems Per Acre Inv Input 1], 

PlotMast

WHERE 

[Stems Per Acre Inv Input 1].PlotID = PlotMast.PlotID

GROUP BY 

[Stems Per Acre Inv Input 1].PlotID, 

[PlotMast].DMCE, 

[PlotMast].DMCN;

Title “Stems Per Acre Inv Input 1”

SELECT 

[Stems Per Acre Inv Input 2].Plotid AS PlotID, 

[Stems Per Acre Inv Input 2].VegID AS VegID, 

Max ([Stems Per Acre Inv Input 2].StemPerAcre) AS StemPerAcre

FROM 

[Stems Per Acre Inv Input 2]

GROUP BY

[Stems Per Acre Inv Input 2].Plotid, 

[Stems Per Acre Inv Input 2].VegID;

Title “Stems Per Acre Inv Input 2”

SELECT 

[Stems Per Acre Inv Input 3].Plotid AS PlotID, 

[Stems Per Acre Inv Input 3].VegID AS VegID, 

BeltSurv.excptnsp,

SUM((StemPerPlot * (6/BeltSurv.BeltWide)) * ((4046.856)/600)) 

AS StemPerAcre

FROM 

[Stems Per Acre Inv Input 3] 

LEFT JOIN 

Beltsurv 

ON 

(UCASE([Stems Per Acre Inv Input 3].vegid) =

UCASE(Beltsurv.excptnsp) OR

UCASE(BeltSurv.excptnsp) IN ('DEFAULT')) 

WHERE

[Stems Per Acre Inv Input 3].RecDate = BeltSurv.recdate AND

[Stems Per Acre Inv Input 3].plotid = Beltsurv.plotid AND

(UCase(BeltSurv.VegCond) IN ('L') OR


BeltSurv.VegCond IS NULL)

GROUP BY 

[Stems Per Acre Inv Input 3].Plotid, 

[Stems Per Acre Inv Input 3].VegID,

BeltSurv.excptnsp;

Title “Stems Per Acre Inv Input 3”

SELECT 

BeltTran.Plotid AS PlotID, 

BeltTran.VegID AS VegID, 

BeltTran.recdate As RecDate,

Count(BeltTran.VegID) AS StemPerPlot

FROM 

BeltTran 

WHERE 

DATEPART('YYYY', BeltTran.recdate) = [Provide Analysis Year] AND

UCASE(BeltTran.VegCond) IN ('L')

GROUP BY 

BeltTran.Plotid, 

BeltTran.VegID,

BeltTran.recdate;

Dust Erosion Input Layers

Cover Factor Data Layer 

The following table outlines the SQL query subquery structure.  Use top most query required for your data (i.e. combined, long-term or monitoring query).  The top most queries are located in the left most columns. The top most queries used will use proper subqueries.  Individual queries are listed below each table in a logical order.  Query titles match query titles in the sample database on the CD that came with this document.

	Cover Mon Final

	Cover Inv Final

	
	Cover Inv 1

	
	
	Cover Inv 2


Short-term/Monitoring Data

Title “Cover Mon Final”

SELECT

[Linemon].[PlotID],

[PlotMast].[DMCE],

[PlotMast].[DMCN],

(Sum(IIf(UCASE([Linemon].[Aercov]) IN ('A','P','AP','U'),1,0))/

SUM(IIf(UCASE([Linemon].[Aercov]) IN ('N','A','P','AP','U'),1,0))*100) AS PctCover

FROM

[Linemon],

[Plotmast],

[Plotsurv]

WHERE

((DATEPART('YYYY', [Linemon].[Recdate]))=

[Provide Analysis Year]) AND

([Plotsurv].[Recdate]=[Linemon].[Recdate]) AND

([Linemon].[Plotid]=[Plotmast].[Plotid]) AND

([Plotmast].[Plotid]=[Plotsurv].[Plotid]) AND

(UCASE([Plotsurv].[Plottype]) IN ('CORE', 'C', 'SPECIAL','S', 

'SPUSE')) 

GROUP BY

Linemon.Plotid,

Plotmast.DMCE,

Plotmast.DMCN

ORDER BY

Linemon.plotid;

Long-term/Inventory Data

Title “Cover Inv Final”

SELECT 

[INPUT].PLOTID AS PlotID, 

[INPUT].DMCE AS DMCE, 

[INPUT].DMCN AS DMCN, 

SUM([INPUT].AerCnt)/SUM([INPUT].GndCnt)*100 AS PctAerD

FROM 

[Cover Inv 1] AS [INPUT]

GROUP BY 

[INPUT].PLOTID, 

[INPUT].DMCE, 

[INPUT].DMCN

ORDER BY 

[INPUT].PLOTID;

Title “Cover Inv 1”

SELECT 

INPUT.PLOTID, 

PLOTMAST.DMCE, 

PLOTMAST.DMCN, 

INPUT.GNDCOVER.VEGLOC, 

(IIF(SUM(IIF(INPUT.GNDCOVER.VEGLOC IS NULL, 0, 1))>0,1,0)) 

AS GndCnt, 

(IIF(SUM(IIF(INPUT.AERCOVER.VEGLOC IS NULL, 0, 1))>0,1,0)) 

AS AerCnt

FROM 

PLOTMAST, 

PLOTSURV, 

[Cover Inv 2] AS [INPUT]

WHERE 

DATEPART('YYYY', INPUT.RECDATE) =  [Provide Analysis Year] AND

PLOTSURV.RECDATE = INPUT.RECDATE AND 

INPUT.PLOTID=PLOTMAST.PLOTID AND

PLOTMAST.PLOTID=PLOTSURV.PLOTID AND

UCASE(PLOTSURV.PLOTTYPE IN ('CORE', 'C', 'SPECIAL', 

'SPUSE', 'S'))

GROUP BY 

INPUT.PLOTID, 

PLOTMAST.DMCE, 

PLOTMAST.DMCN, 

INPUT.GNDCOVER.VEGLOC

ORDER BY 

1, 

2, 

3, 

4;

Title “Cover Inv 2”

SELECT 

GNDCOVER.PLOTID, 

GNDCOVER.RECDATE, 

GNDCOVER.VEGLOC, 

GNDCOVER.DISTURB, 

AERCOVER.VEGLOC, 

AERCOVER.VEGHT

FROM 

GNDCOVER LEFT JOIN AERCOVER 

ON (GNDCOVER.PLOTID = AERCOVER.PLOTID) AND 

(GNDCOVER.RECDATE = AERCOVER.RECDATE) AND 

(GNDCOVER.VEGLOC=AERCOVER.VEGLOC)

WHERE 

DATEPART('YYYY', GNDCOVER.RECDATE) = [Provide Analysis Year]

ORDER BY 

GNDCOVER.PLOTID;
Impact Factor Data Layer 

The following table outlines the SQL query subquery structure.  Use top most query required for your data (i.e. combined, long-term or monitoring query).  The top most queries are located in the left most columns. The top most queries used will use proper subqueries.  Individual queries are listed below each table in a logical order.  Query titles match query titles in the sample database on the CD that came with this document.

	Cover Impact Mon Final

	
	Cover Impact Mon Input Dist

	
	Cover Impact Mon Input UnDist

	Cover Impact Inv Final

	
	Cover Impact Inv 1 Dist

	
	
	Cover Impact Inv Input 2 Dist

	
	
	
	Cover Impact Inv Input 3

	
	Cover Impact Inv 1 UnDist

	
	
	Cover Impact Inv Input 2 UnDist

	
	
	
	Cover Impact Inv Input 3


Short-term/Monitoring Data

Title:  “Cover Impact Mon Final”

SELECT 

[DISTDATA].PLOTID, 

[DISTDATA].DMCE, 

[DISTDATA].DMCN, 

[UNDISTDATA].PctAer AS [Undisturbed Cover], 

[DISTDATA].PctAer AS [Disturbed Cover], 

[UNDISTDATA].PctAer - [DISTDATA].PctAer AS [Delta Cover]

FROM 

[Cover Impact Mon Input Dist] AS DISTDATA, 

[Cover Impact Mon Input UnDist] AS UNDISTDATA

WHERE 

[DISTDATA].PLOTID = [UNDISTDATA].PLOTID

ORDER BY 

1;

Title:  “Cover Impact Mon Input Dist”

SELECT 

LINEMON.PLOTID, 

PLOTMAST.DMCE, 

PLOTMAST.DMCN, 

(SUM(IIF(UCASE([LINEMON.AERCOV]) IN ('A', 'P', 'AP', 'U'), 1, 0)) /

SUM(IIF(UCASE([LINEMON.AERCOV]) IN ('N', 'A', 'P', 'AP','U'), 1, 0)) *

100) AS PctAER

FROM 

LINEMON, 

PLOTMAST, 

PLOTSURV

WHERE 

DATEPART('YYYY', LINEMON.RECDATE) = [Provide Analysis Year] AND

PLOTSURV.RECDATE = LINEMON.RECDATE AND 

LINEMON.PLOTID=PLOTMAST.PLOTID AND

PLOTMAST.PLOTID=PLOTSURV.PLOTID AND

UCASE(PLOTSURV.PLOTTYPE IN ('CORE', 'C', 'SPECIAL', 

'SPUSE', 'S')) AND

[LINEMON.DISTURB] IN ('P')

GROUP BY 

LINEMON.PLOTID, 

PLOTMAST.DMCE, 

PLOTMAST.DMCN

ORDER BY 

LINEMON.PLOTID;

Title:  “Cover Impact Mon Input UnDist”

SELECT 

LINEMON.PLOTID, 

PLOTMAST.DMCE, 

PLOTMAST.DMCN, 

(SUM(IIF(UCASE([LINEMON.AERCOV]) IN ('A', 'P', 'AP', 'U'), 1, 0)) /

SUM(IIF(UCASE([LINEMON.AERCOV]) IN ('N', 'A', 'P', 'AP','U'), 1, 0)) *

100) AS PctAER

FROM 

LINEMON, 

PLOTMAST, 

PLOTSURV

WHERE 

DATEPART('YYYY', LINEMON.RECDATE) = [Provide Analysis Year] AND

PLOTSURV.RECDATE = LINEMON.RECDATE AND 

LINEMON.PLOTID=PLOTMAST.PLOTID AND

PLOTMAST.PLOTID=PLOTSURV.PLOTID AND

UCASE(PLOTSURV.PLOTTYPE IN ('CORE', 'C', 'SPECIAL', 

'SPUSE', 'S')) AND

[LINEMON.DISTURB] IN ('N')

GROUP BY 

LINEMON.PLOTID, 

PLOTMAST.DMCE, 

PLOTMAST.DMCN

ORDER BY 

LINEMON.PLOTID;

Long-term/Inventory Data

Title “Cover Impact Inv Final”

SELECT 

[DISTDATA].PLOTID, 

[DISTDATA].DMCE, 

[DISTDATA].DMCN, 

[UNDISTDATA].PctAerUD AS [Undisturbed Cover], 

[DISTDATA].PctAerD AS [Disturbed Cover], 

[UNDISTDATA].PctAerUD - [DISTDATA].PctAerD AS [Delta Cover]

FROM 

[Cover Impact Inv 1 Dist] AS DISTDATA, 

[Cover Impact Inv 1 UnDist] AS UNDISTDATA

WHERE 

[DISTDATA].PLOTID = [UNDISTDATA].PLOTID

ORDER BY 

1;

Title “Cover Impact Inv 1 Dist”

SELECT 

[INPUT].PLOTID AS PlotID, 

[INPUT].DMCE AS DMCE, 

[INPUT].DMCN AS DMCN, 

SUM([INPUT].AerCnt)/SUM([INPUT].GndCnt)*100 AS PctAerD

FROM 

[Cover Impact Inv Input 2 Dist] AS [INPUT]

GROUP BY 

[INPUT].PLOTID, 

[INPUT].DMCE, 

[INPUT].DMCN

ORDER BY 

[INPUT].PLOTID;

Title “Cover Impact Inv 1 UnDist”

SELECT 

[INPUT].PLOTID AS PlotID, 

[INPUT].DMCE AS DMCE, 

[INPUT].DMCN AS DMCN, 

SUM([INPUT].AerCnt)/SUM([INPUT].GndCnt)*100 AS PctAerUD

FROM 

[Cover Impact Inv Input 2 UnDist] AS [INPUT]

GROUP BY 

[INPUT].PLOTID, 

[INPUT].DMCE, 

[INPUT].DMCN

ORDER BY 

[INPUT].PLOTID;

Title “Cover Impact Inv Input 2 Dist”

SELECT 

INPUT.PLOTID, 

PLOTMAST.DMCE, 

PLOTMAST.DMCN, 

INPUT.GNDCOVER.VEGLOC, 

(IIF(SUM(IIF(INPUT.GNDCOVER.VEGLOC IS NULL, 0, 1))>0,1,0)) 

AS GndCnt, 

(IIF(SUM(IIF(INPUT.AERCOVER.VEGLOC IS NULL, 0, 1))>0,1,0)) 

AS AerCnt

FROM 

PLOTMAST, 

PLOTSURV, 

[Cover Impact Inv Input 3] AS [INPUT]

WHERE 

DATEPART('YYYY', INPUT.RECDATE) =  [Provide Analysis Year] AND

PLOTSURV.RECDATE = INPUT.RECDATE AND 

INPUT.PLOTID=PLOTMAST.PLOTID AND

PLOTMAST.PLOTID=PLOTSURV.PLOTID AND

UCASE(PLOTSURV.PLOTTYPE IN ('CORE', 'C', 'SPECIAL', 

'SPUSE', 'S')) AND

INPUT.DISTURB IN ('P')

GROUP BY 

INPUT.PLOTID, 

PLOTMAST.DMCE, 

PLOTMAST.DMCN, 

INPUT.GNDCOVER.VEGLOC

ORDER BY 

1, 

2, 

3, 

4;

Title “Cover Impact Inv Input 2 UnDist”

SELECT 

INPUT.PLOTID, 

PLOTMAST.DMCE, 

PLOTMAST.DMCN, 

INPUT.GNDCOVER.VEGLOC, 

(IIF(SUM(IIF(INPUT.GNDCOVER.VEGLOC IS NULL, 0, 1))>0,1,0)) 

AS GndCnt, 

(IIF(SUM(IIF(INPUT.AERCOVER.VEGLOC IS NULL, 0, 1))>0,1,0)) 

AS AerCnt

FROM 

PLOTMAST, 

PLOTSURV, 

[Cover Impact Inv Input 3] AS [INPUT]

WHERE 

DATEPART('YYYY', INPUT.RECDATE) =  [Provide Analysis Year] AND

PLOTSURV.RECDATE = INPUT.RECDATE AND 

INPUT.PLOTID=PLOTMAST.PLOTID AND


PLOTMAST.PLOTID=PLOTSURV.PLOTID AND

UCASE(PLOTSURV.PLOTTYPE IN ('CORE', 'C', 'SPECIAL', 

'SPUSE', 'S')) AND

INPUT.DISTURB IN ('N')

GROUP BY 

INPUT.PLOTID, 

PLOTMAST.DMCE, 

PLOTMAST.DMCN, 

INPUT.GNDCOVER.VEGLOC

ORDER BY 

1, 

2, 

3, 

4;

Title “Cover Impact Inv Input 3”

SELECT 

GNDCOVER.PLOTID, 

GNDCOVER.RECDATE, 

GNDCOVER.VEGLOC, 

GNDCOVER.DISTURB, 

AERCOVER.VEGLOC, 

AERCOVER.VEGHT

FROM 

GNDCOVER 

LEFT JOIN 

AERCOVER 

ON 

(GNDCOVER.VEGLOC=AERCOVER.VEGLOC) AND 

(GNDCOVER.RECDATE = AERCOVER.RECDATE) AND 

(GNDCOVER.PLOTID = AERCOVER.PLOTID)

WHERE

DATEPART('YYYY', GNDCOVER.RECDATE) = [Provide Analysis Year] 

ORDER BY 

GNDCOVER.PLOTID; 
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